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1 Overview

This chapter provides a brief description of the Helios™ G4 PFIB 
Series DualBeam™ systems.

Topics include:

 Helios G4 PFIB Series List of Features

 “DualBeam System” on page 11

 “System Components” on page 12

 “Options” on page 15

The Helios G4 PFIB series DualBeam systems integrate ion and 
electron beams for FIB and SEM functionality in one machine. 
Users can switch between the two beams for quick and accurate 
navigation and milling. Convergence of the SEM and FIB at short 
working distance allows precision “slice-and-view” cross-
sectioning and analysis at high resolution. 

The Helios G4 PFIB series DualBeam systems are unique in their 
ability to deliver the fastest TEM sample preparation performance 
in addition to providing highly flexible failure analysis capability 
on advanced semiconductor devices. 

This SEM/FIB combines the most advanced scanning electron 
microscope (SEM) and focused ion beam (FIB) technologies with 
innovative gas chemistries, detectors, and manipulators. Featuring 
unsurpassed SEM resolution, image quality and stunning 
Tomahawk™ (Helios PFIB HX, CX) and Phoenix™ (Helios PFIB 
UX) FIB performance, imaging, milling, or preparing samples is 
fast and easy for semiconductor and data storage labs, research 
facilities and industrial applications. 
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Helios G4 PFIB Series List of Features 
 A separate support PC offers a connection to a local area 

network (LAN).

 1920 × 1200 screen resolution on up to three LCD monitors.

 The user interface integrates all functionality within a 
Microsoft® Windows® operating environment for full digital 
control. 

 The high accuracy five-axis (X, Y, Z, Rotation, Tilt) stage 
provides full coverage of samples with computer control and 
automation of all axes for precise sample manipulation.
There are 3 microscope models differing in the stage: 

HXe: ultra high resolution stage 
UXe: 110 mm stage 
CXe: 150 mm stage 

 Automatic vacuum system with turbo-molecular pumping. 

 The EasyLift manipulator supports higher yields for TEM 
sample lift-out through an intuitive, integrated user interface 
and attachment to a TEM grid for further analysis. It allows for 
final thinning of the sample to be accomplished after 
attachment to the TEM grid holder.

 Gas Injection System (GIS) – Advanced control of gas 
chemistries including proprietary gases for enhanced 
precision deposition or bulk material removal. 

 MultiChem (up to 6 gaseous, liquid, and solid precursors) gas 
delivery system for optimized beam assisted deposition or 
etching based on gas mixing. 

 iFast Developer’s Kit Professional software and starter 
recipes for either ex-situ lift-out or in-situ inverted samples to 
provide a solid platform for implementing customized sample 
recipes to locate and process demanding features in a routine 
manner.

 Cell Navigator™ is an integrated software application used to 
count to a target cell for processing after locating a defect 
electrically. SEM-based, damage-free, robust, and reliable, Cell 
Navigator’s stage-less navigation solves the problem of cell 
counting.

 3-point alignment for improved navigation accuracy on 
individual die and conversion to user-based coordinate 
system.
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 Navigation Alignment allows alignment of imported images 
for location of subsurface features and high-accuracy beam 
placement.

 The MUI (manual user interface) offers additional flexibility 
for controlling magnification, beam shift, focus, 
contrast & brightness, and astigmatism correction.

 Optional retractable DBS detector.

 The design of the optional retractable STEM 3+ detector 
improves the sensitivity to materials with similar atomic mass.

Figure 1-1 Helios G4 PFIB HXe  
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User Interface 

The user interface consists of a single high-level user shell 
employing applications programs with vector parameter files 
defining specific instrument settings for particular applications 
ensuring reproducibility of complex procedures. 

An intermediate software layer, acting on instructions from the 
application layer, controls the column, detector(s), stage, EDX, and 
vacuum functions. This layer also provides management of image 
capture, storage, and data output devices.

A manual user interface (MUI) offers additional flexibility for 
controlling magnification, beam shift, focus, contrast and 
brightness, correcting an astigmatism.

Localization 

If any language is localized within the UI, a user can select it from 
the drop-down menu on the right side of the menu bar. 

User Logon

All user level accounts run under the same Windows 7 account, 
and are the only types of account available to the customer under 
normal circumstances. 

Refer to the Startup chapter for startup and logon/logoff 
functions.

Online Documentation

Access this document and related documents in PDF format at any 
time by pressing F1 or by selecting Help > Online 
Documentation. Click a hypertext link in the menu that appears to 
access the desired document.
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DualBeam System
Users can switch between the two beams for quick and accurate 
navigation and milling. 
See “Principles of SEM Imaging ” on page 169.

Ion Column

The Phoenix™ and Tomahawk™ ion columns provide fast, precise 
and reliable milling, patterning, and ion imaging of the sample 
surface. The exceptional low-voltage performance is proven to 
produce the world's best quality thin samples for high resolution 
scanning TEM (S/TEM) or atom probe microscopy. It has excellent 
ion image resolution: 4.5 nm (4.0 nm) @ 30 kV at coincident working 
distance (WD). With its integrated differential pumping and time-
of-flight correction, the ion column also delivers a tighter beam and 
a more accurate scan profile for extremely precise ion milling.

Electron Column

The Elstar™ electron column with the UC+ source mode (only 
Helios G4 PFIB UX) takes advantage of Thermo Fisher Scientific 
most advanced Hexalens™ design for ultimate image resolution at 
low beam energies. It offers nondestructive imaging capability at a 
working distance optimized for ultrahigh resolution and can 
produce images magnified over 500 000× in SEM mode 1 and > 
2 500 000× in the SEM Mode 2. 

FIB/SEM Capabilities

FIB/SEM DualBeam systems provide an expanded range of 
capabilities not possible with separate FIB and SEM tools: 

 Electron beam high-resolution images of FIB cross sections 
without eroding the feature of interest.

 Real-time cross-section images with the electron beam during 
FIB milling.

 Focused electron beam charge neutralization during FIB 
milling.

 Focused ion beam charge neutralization during SEM imaging.

 High resolution elemental microanalysis of cross sections.

 Image sample surface with the electron beam during navigation 
without erosion or gallium implantation from the ion beam.

 TEM sample preparation with in situ conductive coating.



Overview    System Components

12

Thermo Fisher Scientific CONFIDENTIAL, Limited Rights Data 

Control of the Beams

DualBeam systems ideally position the point of interest for 
simultaneous ion beam cross-sectioning and electron beam 
viewing. Separate scan generators for the two beams permit 
coupled or independent scan patterns and magnifications. 
Imaging while milling aids in defining milled features. 

Immediate electron beam images of cross sections are possible 
without stage motion or sample transfer. Immediate high-
resolution SEM imaging after FIB milling also prevents exposure 
of milled cross sections to atmospheric contaminants.

System Components

Imaging

The main components used for imaging of the samples: 

 Electron / Ion source 
The beam of electrons or ions (particles) is emitted within a 
small spatial volume with a small angular spread and 
selectable energy. 

 Lens system 
The beam enters the lens system consisting of several 
electromagnetic or electrostatic lenses and exits to hit the 
specimen surface. 

 Scan unit
The scan generator signal, fed to the deflection systems, moves 
the beam in a raster pattern over the specimen area. This 
signal, modulated by the detection system signal produces the 
onscreen imaging of the specimen surface. 

 Detection unit 
Particles striking the specimen react with atoms of the sample 
surface in various manners: 

– The electron beam produces electrons and photons (X-rays). 
– The ion beam produces ions, electrons, and photons (X-rays). 

The detector system picks up the particles or photons, converts 
them into a digital signal which is then sent to the control PC 
and shown on the monitor. 



13

Overview   System Components

Thermo Fisher Scientific CONFIDENTIAL, Limited Rights Data

Computer Control 

The xT microscope Server and Microscope Control (user interface) 
software integrate SEM and FIB functionality within a 
Windows 7™ operating environment. 

These software consist of programs defining specific instrument 
settings for particular applications, ensuring reproducibility of 
complex procedures (for instance imaging, management of image 
capture, storage, and data output devices, etc.). They also control 
instrument hardware (the column, detector(s), stage, EDX, vacuum 
functions, etc.). 

Figure 1-2 Column Schematic Overview
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Vacuum System

The entire particle path from electron and ion sources through 
their respective columns to the specimen must be under vacuum 
so that the particles do not collide with air molecules. Various 
levels of vacuum are necessary, so a Turbo Molecular Pump (TMP) 
backed by a scroll pre-vacuum pump (PVP), obtains the necessary 
specimen chamber pressure. 

In operation, the electron column is always pumped to high 
vacuum. The specimen chamber is at the pressure required for the 
given state.

Stage

The Helios G4 PFIB system has a computer-controlled high-
accuracy five-axis piezo stage for small samples. It offers precision 
sample computer software controlled manipulation and 
automation of all axes for overall spatial orientation on highly 
repetitive or extremely irregular samples. 
See “Stage Movement Limits ” on page 219.

Sample exchanges take place through a chamber door that exposes 
the specimen stage when opened. An exchange through the 
chamber door takes several minutes. Optional Quick Loader could 
be used instead. 

Software and interlocks protect the system against a damage and 
users against an injury. 

Gas Injection System

Multiple gas injectors can be installed for material deposition in 
conjunction with either electron or ion beam pattern definitions. 
Electron beam-induced deposition offers the advantage of not 
sputtering the deposited material or implanting gallium 
simultaneously. 

Flexible, reliable, and safe gas injection system (GIS) also provides 
enhanced etching capability for high aspect ratio milling with 
minimal redeposition, preferential etching of cross-section surfaces 
prior to SEM imaging, and rapid milling of TEM sections. 

Up to five GIS beam chemistries can be installed on the system, 
depending on the system configuration. This self-contained 
apparatus allows the precursor material to be contained entirely 
within the vacuum system for simple, flexible, and safe operation.

See “Gas Injection module” on page 303 for more information.
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MultiChem Gas Delivery System

MultiChem is an option on the Helios G4 PFIB system. 

See “MultiChem” on page 307 for more information.

Image Viewing and Capture 

Because the amplified detector signal is shown synchronously 
with the beam scanning, there is a correspondence between 
brightness of an image point on the monitor screen and the signal 
detected at the corresponding point on the specimen. 

Magnification is the ratio of the size of the viewing monitor screen 
to the size of the area scanned on the specimen. Higher 
magnification is achieved by reducing the size of the area scanned 
on the specimen. 

Analysis Capability 

Convergence of the SEM, FIB, and X-ray detection system (e.g., 
EDX—Energy Dispersive X-ray or EDS—Energy Dispersive X-ray 
Spectroscopy) at short working distance allows precision “slice-
and-view” cross-sectioning and chemical analysis at high 
resolution of surface and subsurface features. 

Various vendor options are compatible with the instrument. 

Options
A range of hardware and software options are available for your 
system. This range will be extended when new items become 
available.

See “System Options” on page 369 for detailed information.

Contact your Thermo Fisher Scientific sales representative for detailed 
information on system options.
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2 Safety & Handling

This chapter contains safety and handling guidelines for operating 
the system.

Topics Include:

 “General Guidelines” on page 18

 “Site Requirements” on page 18

 “Handling System Crates” on page 18

 “User’s Guide Messages” on page 19

 “System Operation, Maintenance and Service” on page 20

User safety manual 
The dedicated User safety manual provides information for 
personal safety and maintenance procedures while operating this 
system. 

This manual is provided both as a PDF and hard copy print out 
and is required reading for the end user. It is accessible directly 
from the Microscope Control software (UI) from the Help menu / 
Safety Manual item. 
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General Guidelines
 Do not operate the system until you have a thorough 

understanding of this safety section. There may be additional 
limitations to safety and handling mentioned elsewhere in this 
manual.

 Do not remove or bypass any safety items or electrical circuits.

 Never operate the equipment with any guards or shields 
missing. If it is necessary for guards and shields to be removed 
for service, replace them before operating the equipment.

 Obey all WARNING and CAUTION signs mounted on the 
equipment. Do not remove any of these signs.

 Do not operate the equipment at a temperature higher than the 
maximum designed limit stated on the equipment data plate.

Site Requirements
Verify that the site safety and environmental requirements, which 
are the responsibility of the operator, are satisfied. This 
information can be found in the system specifications and/or 
preinstall documentation.

In particular, pump exhaust requirements, electrical supply and 
grounding (earthing) requirements, and floor loading (plus any 
local codes regarding earthquake safety) are important safety 
issues.

Handling System Crates
Do not open the system crates without an Thermo Fisher Scientific 
service engineer or representative present. If crates are opened 
prior to the arrival of an Thermo Fisher Scientific service engineer 
or representative, the system warranty may be invalidated. 
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TIPPING HAZARD
Crates are heavy. To avoid tipping, refer to crate markings for centers 
of gravity.
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User’s Guide Messages
The User’s Guide contains NOTE, CAUTION, WARNING, and 
DANGER messages to which you should pay close attention. 
These messages provide important information for safe operation.
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A Note emphasizes information requiring special attention.
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A yellow Caution message appears when special handling is 
required to prevent product damage.
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An orange Warning message appears when special handling is 
required to prevent personal injury or death.

D
A
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A red Danger message identifies an immediate personal risk of injury 
or death and gives appropriate precautions.

HAZARD 
DESCRIPTION
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System Operation, Maintenance and Service 
Only Thermo Fisher Scientific trained service engineers may 
perform service and maintenance. Operators and service personnel 
must be trained on potential safety hazards and safe techniques, 
and must observe all warnings and cautions encountered on the 
system and in the manuals. No person should perform any 
operation without prior training.

If conditions arise under which you do not know how to proceed, 
contact Thermo Fisher Scientific Customer Service at 1-503-726-
2800, or email cshelpdesk@fei.com. Within the United States use the 
toll free number 1-866-MYFEICO (1-866-693-3426).

Thermo Fisher Scientific electron optical equipment is perfectly 
safe when correctly installed and operated. However, when 
inexpert (unauthorized) modifications are made, the following 
hazards can occur, which can result in personal injury or 
equipment damage if recommendations and instructions are not 
followed.

 Shock hazard

 Radiation hazard

 EMC hazard

 Mechanical hazard

 Static magnetic hazard

Deviating from directions given by Thermo Fisher Scientific 
Company may void your warranty. If you have any doubt 
regarding procedures, contact safety personnel at your company, 
Thermo Fisher Scientific, or representatives of your state, territory 
or province, or federal government.

N
O

T
E Only service personnel certified by Thermo Fisher Scientific are 

authorized to service the equipment.
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3 System control 

Topics include:

 “System Layout” on page 22 

 “Hardware elements” on page 22 

 “Power off” on page 26 

 “System states” on page 27 

 “Vacuum system” on page 37  
N

O
T

E

Before starting the system, verify the presence of:
• Electrical power
• Compressed air
• Cooling water
• Nitrogen for venting
With the exception of nitrogen, interlocks prevent the vacuum system 
from operating if the others are not present.
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System Layout 
The table top includes the EMO switch, system power button, at 
least two flat panel monitors, keyboard with MUI, joystick, and 
mouse. Two computers sit on the floor beneath the tabletop. 

Other Software and Hardware

Call Customer Service for advice before installing software or 
hardware that is not required for system operation. Other 
software, such as screen savers or hardware network cards, may 
corrupt the system control software under some circumstances and 
may invalidate the warranty.

For more detailed information about Windows® 7, refer to the 
Microsoft® Windows™ User’s Guide shipped with your system.

Hardware elements 
The system is computer-controlled. As such, it has a Microscope 
Computer that must be turned on (use the power button on the PC) 
to operate the microscope by means of the software. It contains all 
system and application software plus online documentation. It 
activates the startup conditions for the system from a software 
base. 

The support computer (option) can hold some other software 
utilities. It is connected to the local area network (LAN) and acts as 
a firewall to the system. It contains the Navigator™ application 
software as well as communications with the EDS systems.

The switch box switches the keyboard and the mouse to either of 
the two computers. 

The control software facilities and data are shown graphically on 
the LCD monitor and are superimposed around and on the image. 
The other LCD monitor is used either as an extended desktop of 
the Microscope computer or as the Support computer monitor. 

To control software utilities, one can use a keyboard, a mouse, the 
joystick (option) or the Manual User Interface (option). 
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System Power button 

The console / system power is activated by pressing the power 
button located on the microscope console front panel. This 
switches the sub-systems on and allows the interface and 
communication with the Microscope computer, from which most 
of the functions are activated via the software control. 

The power button indicates several system states: 

 green lit – the Full Operation state 

 amber lit – the Standby system state 

 not lit – the Complete shutdown system state 

Figure 3-1 System Power button  
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External connectors panel 

The External connectors panel is located on the back of the 
microscope console.  

It is used to connect 3rd party equipment to the following 
connectors:

 CONTROL SIGNALS / E-BEAM SCAN INPUT / VIDEO 
OUT 
These connectors are used for the connection of EDX, WDX 
and lithography systems, provided by 3rd party suppliers. Do 
not connect anything else to these connectors! 

 SPECIMEN CURRENT 
This connector is used together with the Keithley picoamper 
meter (option) equipment. 

 Ground point 
The point is intended for a defined ground connection 
between a microscope and a 3rd party module. This 
connection is not a safe ground! 

 ELPHY SCAN & BLANKING IN
Not used.
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Mains switchboard 

The Mains switchboard is located on the back of the microscope 
console.  

Output power sockets are used for other microscope optional 
equipment.  

Breaker switches 

 PVP1 F5

 PVP2 F6 

 BAKE OUT IGP F4

 BAKE OUT EC F2

 PC&MICR F1 

 MAINS S1 

Mains input 230 VAC (the large blue plug) is placed under the 
MAINS S1 breaker switch. 
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Power sockets are used for equipment delivered and installed by 
Thermo Scientific. It is forbidden to use these sockets by a user for 
any purpose! 
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Power off 
The system has protection against power failures in the sense that 
the different components of the system are not likely to be 
damaged. However, a power failure is never good for the system. 
It might affect the ultrahigh vacuum levels of the columns and the 
overall stability of the system.

Take sufficient measures to avoid power failures. If a power failure 
occurs while the instrument is completely operational, the 
microscope enters a safe state and the following happens: 

 Electron and ion accelerating voltage is switched off. 

 Electron and ion emission is switched off. 

 The specimen chamber automatically vents gently. 
The vacuum in the instrument is no longer supported by 
running pumps. The column isolating valves close to save the 
vacuum in the source area. 

 The microscope computer and the support computer are 
switched off. The momentary adjustments of all system 
parameters (accelerating voltage, magnification, stage positions, 
etc.) are lost if they have not been saved prior to the failure.  

If the system was down less than 45 minutes, it can be recovered 
according to the returning to operation after Complete shutdown 
state procedure (see below). If the system has been off for a longer 
time, an Thermo Fisher Scientific service engineer may have to 
bring the system back into operation.

Emergency off 

This is similar to that which would happen after a mains power off 
(see above).   

N
O

T
E If the power failures occur occasionally it is recommended to use the 

microscope Uninterruptible Power Supply (UPS - option).
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The microscope console water chiller (option – separate device in the 
microscope vicinity) is powered separately via its individual power 
cord. Hazardous voltages may be present in this equipment even 
when the microscope power plug is disconnected!
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EMO buttons (optional S2 kit)

To switch off the electrical power completely in case of emergency, 
push any of the red EMO (Emergency OFF) buttons arranged in the 
vicinity of the system (see the User safety manual). 

Emergency Off without EMO buttons 

Switch off the Mains breaker labeled MAINS S1 
(see Mains switchboard above), 

or 

Disconnect the mains plug from the microscope console mains 
input socket or from the electrical connection box (see User safety 
manual). 

System states 
The systems is started at the time of installation to obtain an 
adequate high vacuum and will remain on unless there is a power 
failure or emergency. There are several system states: 

 Complete shutdown – for service and emergency reasons 
This state can be set only by a Thermo Fisher Scientific 
engineer. 

 Standby – for when the system will not be used for a longer 
period 

 Overnight – for when the system will not be used overnight 

 Full operation – when the system working 

Overnight state 

If you don’t plan to use the system overnight, follow the 
procedure: 

1. Log off an actual user. 

2. Switch off the monitor.

If you don’t plan to use the system for several next days, follow the 
procedure: 
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An Thermo Fisher Scientific service engineer or an authorized user 
must restart the system after an emergency power off.
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1. Click Sleep button on the Beam Control page. 
The ion column source switches off completely. This is seen by 
reduction in the Source progress bar in the column module 
when the ion beam is selected.  

2. Click Stop UI on the Server bar. This action also logs off the 
current user.  

3. Switch off the monitor.

Returning to operation
1. Switch on the monitor. 

2. Log on to the UI.

3. Turn on the accelerating voltage of the beam(s) and GIS / 
MultiChem heaters (if needed).

When the last session was ended by the Sleep button:
4. Click the Beam Control page or the Sample Exchange window / 

Wake Up button. The ion column source turns on. This is seen by 
an increase in the Source progress bar in the column module 
when the ion beam is selected.  

The high voltages are also switched on, the CIVs are opened, 
and the GIS heaters are turned on.

The Beam Control page then indicates that the system is ready 
and only the Sleep button is active.

N
O

T
E

Turning off the ion column source impacts its lifetime.
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The GIS heaters are also switched off, but not the MultiChem 
heaters!
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Standby Mode

Standby mode is a system shutdown process different from the 
system being completely turned off. It is used when the system 
will not be used for longer time.

In the Standby state, most of the components are turned off. The 
only things left powered are the ion column IGP, electron column 
IGPs, electron emission, roughing pumps, and turbos. The 
chamber is not vented.

The system can be left in this state if utilities (water, air, nitrogen), 
other than electrical need to be disconnected. When Standby state 
is selected to recover from a failure, it is better then to restart the 
microscope PC before restarting the microscope.

The system power button will be amber during standby.

To enter Standby state 

1. Remove your sample, if needed, and pump down. 

2. On the Beam Control page, click Sleep. The ion source and 
HT, as well as the electron HT, will be turned off.  

3. Select Stage > Tilt 0° (Ctrl + E).
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4. Click Stop UI to stop the UI.  

5. Double-click the green progress bar.  

6. Click Stop to stop the server. Wait until the xT microscope 
Server stops, then click Standby.  

7. Select Yes in the dialog box that appears and the system will 
enter the Standby mode. 
It is possible now to shut down the system and support 
computers if needed. 
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Returning to operation 

It is assumed here that all external supplies are present. The 
startup procedure is fully automatic.

1. Press the System power switch. 

2. Turn on the system and support computers.

3. Start the software by clicking on the FeiSystemControl.exe 
shortcut icon on the desktop. 

4. In the xT Microscope Server dialog box that appears, click 
Start.  

N
O

T
E

If the system is in 
Standby mode, wait at 
least 30 seconds 
before switching back 
to full power mode.
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5. Click down / up arrow. Wait until the dialog is fully functional 
(all LEDs are green) and click Show / Hide UI. This step is 
unnecessary if the Autorun UI check box is ticked in the 
Advanced section of the dialog box.  

6. Once the microscope server has started, the splash screen 
appears, followed by the dialog box. Log on with your 
microscope account (user name and password) to activate the 
UI and click Log On. 

 

7. Click Wake Up on the Beam control page to start the ion 
source, if needed.  
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8. Select Yes in the Stage Information dialog to home the stage.  

The system is now ready to use.

Complete System Shutdown  

Complete shutdown should be performed only if absolutely 
necessary and for the shortest possible time, so as to recover the 
column vacuum without the necessity of a system pump. 
Normally, one would only perform a complete shutdown for 
transportation of the system or for service actions, such as repair to 
essential electrical and air supplies. The shutdown procedure 
brings the system to a nonpowered state, where the vacuum in the 
both the ion and electron column area is no longer supported by 
running pumps and IGPs. All valves are closed and the sample 
chamber is vented. 

The emission characteristics of the source are dependent on the 
shape of the tip. When the source is turned off, it cools. Reheating 
the source during startup changes the shape and emission 
characteristics dramatically, requiring the column to be aligned. It 
also reduces the lifetime of the source.

To completely shut down the system 

1. Set the system to Standby state (see above).

2. Shut down the system and support computers. 
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The Complete shutdown and startup of the hardware from Complete 
shutdown are restricted to the Thermo Fisher Scientific service 
engineer or an authorized user.
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3. Switch off the breaker switch labeled MAINS S1 on the 
cabinet back, on the far right side of the row (see Mains 
switchboard above). 

Returning to operation 

The Startup procedure must be followed whenever the system has 
been shut down for service or due to a power failure. After startup 
has been initiated, observe the system for the first 30 minutes to 
confirm that the IGPs show sufficient vacuum to continue and 
complete the procedure: 

1. Press the system power switch. 

2. Turn on the system and support computers.

3. Start the software by clicking on the FeiSystemControl.exe 
shortcut icon on the desktop. 

4. In the xT microscope Server dialog box appears, click Start.  

5. Click down / up arrow. Wait until the dialog is fully functional 
(all LEDs are green) and click Show / Hide UI. This step is 
unnecessary if the Autorun UI check box is ticked in the 
Advanced section of the dialog box. 
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6. Once the microscope server has started, the splash screen 
appears, followed by the dialog box. Log on with your 
microscope account (user name and password) to activate the 
UI and click the Log On button.  
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7. Select Yes in the Stage Information dialog to home the stage. 

The stage must be homed before full operation of the UI is 
possible. If the stage is not homed at the first shown dialog, it 
can be homed by selecting Stage > Home Stage later (see 
“Stage Menu” on page 68). 

8. After you have logged on to the UI, you will find that the 
column IGP is turned off and the pressure is unknown. To 
turn on the IGP, go to the Alignments page and select 
E-column: Emitter Startup; click Start, and then follow the 
instructions.   
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Home the stage without rotation only if there is a possible risk of 
some in-chamber damage associated to rotation.
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When vacuum pressures are too high while following the 
instructions for starting IGPs, a bakeout is required. If this is the 
case, a trained Thermo Fisher Scientific Service Engineer or an 
Thermo Fisher Scientific trained user must restart the system.
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9. Click Wake Up on the Beam Control page to start the electron 
and ion emission. If the emission does not start, call a 
Thermo Fisher Scientific Service representative.  

When both sources are started, the system is ready to use.

Vacuum system 
The system has the these 
vacuum sections: 

 Electron source / 
column 

 Ion source / column 

 Specimen chamber

When in operation, the electron source and column section are 
always under high vacuum. The specimen chamber is at the 
pressure required for the given state (Pump / Vent) or mode 
(HiVac / LoVac / ESEM). 

Vacuum Status

The vacuum status controls are in the Vacuum module. The Pump 
button starts pumping the chamber for the operating pressure and 
the Vent button starts venting the chamber for a sample exchange. 

At the bottom right side of the status bar the actual vacuum status 
is represented by the colored icon (representing the two vacuum 
sections schematically), which may have three possible colors with 
the following meanings:  

 Green – PUMPED to a desired vacuum mode 

 Orange –transition between two vacuum statuses 
(pumping, venting, or purging)

 Gray – VENTED to atmospheric pressure 
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4 User Interface

This chapter gives an overview of the Microscope control software 
for the Helios G4 PFIB series systems. It describes the functionality 
of each part of the user interface. Graphics illustrating the choices 
help you locate specific features. 

The software interface controls most system functions, including 
imaging, milling, patterning, detection and analysis, scanning and 
magnification, image gathering, manipulation and output, stage 
and vacuum.

Topics include:

 “Software” on page 40

 “Software interface elements” on page 41

 “Microscope Server Software” on page 45

 “Microscope Control Software” on page 48

 “Beam Control Page” on page 102

 “Navigation Page” on page 110

 “Detectors Page” on page 122

 “Patterning page” on page 132

 “Sample Preparation Page” on page 137

 “Alignments Page” on page 138

 “Entering Commands” on page 152
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Software 
The software control contains graphics applications 
within the Windows 10 operating environment: 

 xT microscope Server: starts and stops basic 
microscope functions 

 Microscope Control (UI – User Interface): controls all 
system functions including imaging, image and movie 
gathering / manipulation / output, detection and analysis, 
scanning, magnification, stage navigation, chamber and 
column pressure, etc. 

 User Management: ensures users admission to both the 
operating system, Windows 7, and the Microscope Control 
software 

Password policy 

After the software installation there are two initial users / 
passwords common for the OS Windows and the Microscope 
Control software (UI): 

 User: supervisor / Password: supervisor 

 User: user / Password: user 

The users are permitted to control general operation functions, but 
not advanced technical maintenance. Most technical maintenance 
is taken care of by an Thermo Fisher Scientific service engineer 
who has the rights to enter the Service Mode. 

The first time logging into the Windows 7 operating system, a user 
is automatically forced to change his or her password. After that 
the UI accepts it and enables logging in from that point on.

Each password (either for any new user or after the 90 day period 
expiration) has to meet the following conditions:

 at least 7 characters long 

 the stem must be significantly different from a previous 
password and shouldn't contain a complete dictionary word 
or user name 

 must contain at least one character from each of these 
character groups: 
– Uppercase letter 
– Lowercase letter 
– Number 
– Symbol (/, *, –,+ etc.) 
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Software interface elements 

Tooltips

First-line help is integrated in the software as tooltips. Hover the 
cursor over an item on the user interface to see a short explanation 
of the item.

Online Documentation

Access the complete online version of this document from the Help 
menu or by clicking F1.  

Hyperlinked Help

Click the blue hyperlinks in the online document, including the 
Contents and Index, to jump to useful related subject information. 

Context Sensitive Help

Click on the question mark at the right of each section to access 
that section in the online documentation.  

Unique Interface Elements

Cursors

The two main cursor modes are: 

 Arrow cursor 

 Crosshair cursor 
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By default, the Arrow cursor or standard Windows cursor appears 
unless you choose Crosshair Cursor from the View menu.  

The Crosshair cursor is useful for aligning patterns or features. 

Two-Dimensional X-Y Controls

Two-dimensional (2D) X-Y controls are represented by a square 
with an X-Y grid. The position of the crosshair is related to the 
actual settings; the full range of the parameters is represented by 
the perimeter of the box. See the 2D X-Y controls for Stigmator and 
Beam Shift on the beam module.  

Clicking and dragging anywhere inside the box changes the active 
display cursor to the 4-ended arrow and positions it to the screen 
point corresponding to the actual control value (minimum in the 
middle of the screen and maximum at the edges). It can be dragged 
in four directions. To fix the values, release the mouse button. 

Magnification affects the sensitivity of the X-Y control. At higher 
magnification, you may have to drag and release several times to 
achieve the same adjustment as at lower magnification levels. 

In Quad Image mode, the crosshair covers the active window with 
the same range of operation as in Single Image mode. As a result, 
movements are more sensitive in Quad Image mode.

Right-clicking on the 2D box opens a context menu with choices:

 Coarse / Normal / Fine item – sets the mouse sensitivity 
necessary for the full range from a long to a short mouse path. 

 Adaptive Sensitivity item – adjusts the mouse control response 
to be the same at any magnification. 

 Zero item –brings the control value to zero and the cursor to 
the center of the box. 
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 Clear Memory item – clears condition values, that have been 
remembered automatically during the relevant 2D control use. 
These remembered values are used to estimate new values, 
that have not yet been remembered. 

The menu may contain fewer functions or some other functions 
that are available for that particular parameter. Selecting the 
corresponding menu item activates the function. 

Adjusters

Adjusters allow the user to change parameters (such as contrast, 
brightness etc.) in a continuous way. 

Right-clicking on the adjuster shows a context menu with choices. 
Ticking / clearing the Slider Mode option switches two possible 
ways of slider control. Ticking the Mode Switch option adds the 
mode switch button to the right side of the slider, which enables to 
quickly switch between these modes.  

Slider Mode 

In this mode adjusters always have a label and a readout at the 
upper right corner – double-clicking on it enables to enter a precise 
value and a unit in particular cases using the keyboard. 

Clicking on & dragging the middle adjuster button or clicking on 
the bar is used for coarse adjustments, while clicking on small end 
arrows is for fine adjustments (single step increments). 

 Slider Mode (Non-linear Slider cleared) – the adjuster button 
position always corresponds to the actual parameter value 
within an available range.  

Figure 4-1 Adjuster Controls

Figure 4-2 Adjuster Controls Linear
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 Slider Mode (Non-linear Slider ticked) – has an exponential 
response – the further from the center is the adjuster button 
pulled, the larger is the relative change. The adjuster button 
always snaps back to the center of the slider, but a dimension 
of the small bar under the slider corresponds to the actual 
parameter value.  

 It is possible to increase / decrease the Slider Mouse Speed 
(sensitivity) by dragging the context menu slider to the right / 
left. 

Not Slider Mode – Drop Down List Boxes 

This mode is used for values that have both a continuous range 
and list of presets. It also offers direct value editing to achieve total 
control.  

 Clicking on the - / + sign selects previous / next value from 
the predefined list (see appropriate Preferences) but only 
shows one value in the text area.

 Clicking on the down arrow on the right side of the adjuster or 
the value itself expands a drop down list of available values – 
if it extends further than is visible, a scroll bar appears. 
Clicking on a value from the list enters it as the actual one, the 
drop down list automatically closes and the change of the 
setting is immediate. 

 Double-clicking on a value in the text area enables to edit it. It 
is also possible to click on & drag the small bar under the 

Figure 4-3 Adjuster Controls Non-linear

Figure 4-4 Adjuster Controls Non-linear
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numerical value to continuously change the setting (where 
applicable).  

Microscope Server Software
When starting the system, progressive dialog boxes for the server 
and UI are shown. Launch the server first by clicking the Start 
button. 

Table 4-1 Adjusters Controls 

Interface Item Description

Switches between Slider and Not-slider modes

Not-slider mode 

Text Box: For user-specified values. 
• Type a value; press Enter to go to that value. 
• Or double-click on a value in the text area to edit it. 
Down Arrow: Shows the whole list of values.
• Click a value in the list to enter it as an actual value shown at the 

top right of the control and in the text area. 

Selects the next lower value in the preset list.

Selects the next higher value in the preset list.

Slider mode

Makes small decreasing adjustments.

Bar: Clicking makes largest adjustments in single steps.
Center Slider: When dragged left or right, makes adjustments over the 
full range: the further from center, the larger the change. 
Linear – the adjuster button position always corresponds to the actual 
parameter value
Exponential – the adjuster button always snaps back to the center of the 
slider, but dimension of the small blue bar corresponds to the actual 
parameter value 

Makes small increasing adjustments.
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The Startup dialog can be minimized once the UI is established by 
right-clicking in the top bar of the dialog. This opens another 
dialog box that offers the chance to minimize the Server to the top 
bar of the UI. Dopuble-clicking the xT Microscope Server header 
has the same functionality.

Figure 4-5 Startup Dialog Box

Module operation —
depending on system 
options, list varies

Stop server

Start server

Hide/Show UI

Stop/Stop UI

Show Advanced page

Administration page

Autorun UI

Server 
progress bar

UI progress 
bar

minimized bar 
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Table 4-1 xT Microscope Server Interface Overview

Interface Item Description

Server State Shows the state of the xT Microscope Server software: RUNNING or 
STOPPED. During a transition between these states, STARTING or 
STOPPING is shown. 

UI State Shows the state of the Microscope Control (UI) software: RUNNING or 
STOPPED. During a transition between these states, STARTING or 
STOPPING is shown. 

Module Operation Shows the modules operating on the system. The label and behavior on 
some module buttons change depending on the actual state. 

Microscope:

Start Starts the xT microscope Server. 

Stop Stops the xT microscope Server. If the UI is running, it closes it before 
stopping the Server. 

Enter Service Mode This mode is protected by the service password. It offers elevated rights to run 
specific Alignments and Service tools for servicing the microscope. When the 
system is in the Service mode, warning is shown in each display.

Show UI / Hide UI Toggles to show/hide the UI main window. 

Start UI / Stop UI Starts/stops the UI software.

Standby Closes the UI, stops the xT microscope Server, and brings the console to the 
Standby mode (see below).

Advanced Shows the Administration module containing information helpful when 
calling for service (specifying the software operation / hardware function 
state).

Administration module: Shows when Advanced is clicked.

Install directory Specifies where the software is installed.

Active configuration Shows the active configuration.

Autorun UI When selected (the default), the Start button automatically starts UI after 
starting the Server.

Service Tools Opens the side pane with some specific applications. 

Terminal Window Opens a logging record.

Administration page Shows the bricks in the software and some check boxes for administrative 
purposes. 
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Microscope Control Software 
Microscope Control—also called user interface (UI)—consists of 
several elements that comprise the main window, showing status 
and control features. Control of some or all of these items is made 
via the mouse, keyboard, or the MUI pad.  

The main window control interface elements consist of the 
following areas and pop-up windows:

 Menu bar: Contains all operation menus and submenus.

 Tool bar: Contains all icon button functions.

 Preferences: Presets operating conditions.

 Imaging area: Four displays or single display providing 
independent image functionality modes. Every display has its 
Image databar containing all data information entered by 
preference for storage/printout of the image.

 Status bar: Contains all data information entered by 
preference for storage/printout of the image.

 Pages: Contains all pages made up of several modules.

ToolbarMenu Bar

Pages

Microscope Server Software

Imaging Area

Preferences

Status Bar
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Workspace customization 

It is possible to change the UI layout by right-clicking any free 
toolbar or sidepane (pages) area and selecting Customize… item. 

A user can save / load layouts by selecting the Export / Import 
Workspace… item to / from the Workspace configuration 
(*.workspace) file.

Clicking the Reset to Default Workspace item restores the factory 
UI layout, which is the one described in this manual. 

Toolbar customization 

Selecting the Toolbar tab adds a red triangle to each toolbar item 
enabling to change its size. By clicking & dragging any item it can 
be moved to a new position within the toolbar area; dragging it out 
from the toolbar area to the customization window eliminates it 
from the layout. Clicking & dragging a new item from the Toolbar 
tab to the toolbar area adds it to the layout. 

Figure 4-6 Toolbar customization  
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Sidepane (Pages) customization 

Selecting the Sidepane tab adds a red border to the pages area. By 
clicking & dragging any module it can be moved to a new position 
within the pages area; dragging it out from the pages area to the 
customization window eliminates it from the layout. Clicking & 
dragging a new item from the Sidepane tab to the page area adds it 
to the layout. 

By clicking the + page button calls the dialogue requiring a New 
page name input; by clicking the OK button a custom page is 
created. 

Figure 4-7 Pages customization  
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Keyboard (Shortcuts) customization 

It is possible to customize factory shortcuts within the Kayboard 
tab. To change the factory setting search a desired functionality, 
enter a New Shortcut to the edit field and click the Assign button. 
To revert to the factory setting click the Default button. 

Figure 4-8 Shortcuts customization  
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Menu Bar

Select pull-down menus from the menu bar.  

 using Mouse
Click the menu name to show that menu and then click on the 
desired selection.

 using Keyboard
Press Alt + the underlined letter to show that menu; press the 
up or down arrow keys to step through the choices in that 
menu; press Enter to make the selection. Or press the left or 
right arrow keys to navigate between menus.

Thermofisher menu MD- check 

Standalone applications for particular use are listed here. It is also 
possible to start them.  

 Movie creator 

 Working folder 

 If there are more applications installed with the system, they 
are listed here just as in the Windows start menu: 
all programs /  company / Applications / for instance: 
VolumeScope, Auto Slice and View, iFast, AutoTEM, …
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File Menu

Use the File menu (Alt + F) for opening, saving, importing, 
exporting, and printing files, and for recording movies, logging 
off, and quitting the software application.   

Table 4-1 File Menu Overview (1 of 5)

Menu Item
(Shortcut Keys) Description

Open Shows a standard dialog box for opening previously stored images in 
*.tif (8, 16, or 24 bit), *.jpg, or *.bmp file format. The dialog box opens to 
the last path used.

Save (Ctrl + S) Saves the image with an incremental label at a predetermined location 
to ensure that every image is saved as a new file. This is also used when 
a restored image has been updated in any way, such as a LUT change, 
and it is necessary to overwrite the original. 
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Save As... Shows a standard dialog box for saving images with a new file name 
and location.  

By default, the dialog shows the location and the name last used to 
save/open a file in the current display. You can choose:
• A different location, name, or suffix.
• A different image format: Supported file formats are TIF 8/16/24 

bit, JPG and BMP, but only files saved from UI in TIF format 
contain the active processing information that could be used later 
for an image databar setting 
(see the “Databar Configuration” on page 98). 

• To save the image with or without the databar. 
• To save the image with or without overlaid graphics. 
The settings are remembered per display and used for the subsequent Save 
actions. 

Table 4-1 File Menu Overview (2 of 5)

Menu Item
(Shortcut Keys) Description
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Save All...
(Ctrl + Shift + S)

Shows the Multiple Photo Save as dialog box.  

This allows you to individually save images in all four displays at the 
same time and select the name, location, and file format for each image.

Record Movie Starts the recording of videos, one for each of the image displays at the 
same time. If a display is paused when starting the video, only the first 
image with a time stamp is stored. 
Creates digital video files (*.avi) for dynamic experiments. The tick next 
to this menu item and the change of the corresponding toolbar icon 
indicate the movie is recording. When Record Movie is active, the icon 
changes to a red square. When clicked, it stops the movie function. 
See “Recording Movies (Multiple Image Capture)” on page 211.

Print... (Ctrl+P) Opens the standard Print dialog box for selecting a choice of printer 
and settings suitable to print an image. See “Printing an Image” on 
page 211.

Import / Export When selected, shows a list of file types for importing:
• Stage Positions: *.stg files
• Patterns: *.ptf files, see “Patterning presets” on page 91
• End-Point Monitor Graphs: *.epm files 
• Scanning Presets: *.scp files, see “Scanning Presets” on page 92
• Display Presets: *.qps files, see below. 
• System Parameters: *.par files (see below) 
• System Presets: *.syp files 
After you select a type, the Open dialog box shows. When opening the 
file, parameters or data saved with it are restored.
Note
The Intensity Profile Data are not possible to import. 

Table 4-1 File Menu Overview (3 of 5)

Menu Item
(Shortcut Keys) Description

Start Stop 
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Export System Parameters When selected, shows a list of file types for exporting (see Import, 
above). Clicking the System Parameters item causes the Export System 
Parameters dialog box to appear:  

Click the down arrow on the left for expanded details about each 
selection.
This functionality allows you to export a comprehensive system setup 
and then later quickly reload for different sample types. You can easily 
export the complete system configuration or select only the specific 
parameter(s) in which you are interested (.par files).

Log Off Factory (User Name) Logs off the current user and provides the Log On dialog box for the 
next system user. When the user logs off, the system goes to a safe state; 
the accelerating and detector voltages are switched off automatically. 

Lock Locks the microscope to prevent undesirable operation of another user. 

Table 4-1 File Menu Overview (4 of 5)

Menu Item
(Shortcut Keys) Description
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Display Presets 

It is possible to import and export settings for all displays (beam 
type, detector type & mode & settings, enhanced image settings). 
The parameters can be reviewed on the Import / Export System 
Parameters dialog box. 

Edit Menu

Use the Edit menu (Alt+E) for standard Windows editing 
functions: Copy, Cut, Paste, Delete, and Select All.  

Exit Closes the user interface, but leaves you in the operating system 
environment with the server still running (accelerating and detectors 
voltages are switched off for security reasons). To activate the UI again, 
click Start UI on the server bar.

Table 4-1 File Menu Overview (5 of 5)

Menu Item
(Shortcut Keys) Description
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Detectors Menu 

Use the Detectors menu (Alt + D) to select a detector or to mix 
signals from multiple detectors. The selected detector for the active 
display has a tick mark next to its label and its operating mode in 
brackets (if applicable). See “Detectors Page” on page 122 and 
“Working with Detectors” on page 171.   

Table 4-2 Detectors Menu Overview (1 of 2)

Menu Item Description

ETD (SE) Selects the Everhart Thornley detector (ETD), a scintillator 
photomultiplier type detector monitoring electrons generated by the 
primary beam interaction with the sample surface. 
See “Everhart Thornley Detector” on page 173.

TLD (SE) Selects the through-the-lens detector (TLD). 
See “Through Lens Detector” on page 174.

ICE (SE) Selects the ICE detector. 
See “ICE Detector” on page 175.

ICD Selects the ICD detector. See “In-Column Detector (ICD)” on page 176.

STEM 3+ Selects the STEM detector. See “STEM Detector” on page 179.

MD Selects the MD detector. See “Mirror Detector (MD)” on page 176.

External Selects a third party video signal. 

CCD Selects the charge-coupled detector (CCD camera) showing the inner 
space of the sample chamber.

Nav-Cam Selects the in-chamber navigation camera. 
See “Nav-Cam (In-Chamber Navigation Camera)” on page 232.

N
O

T
E

Only the detectors 
installed on your 
system will appear in 
the Detectors menu.
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Scan Menu

Use the Scan menu (Alt + C) to control scanning functions.  

Mix Allows mixing of signals from 2 or 3 detectors. You can mix 1st and 2nd 
display detector signals in the 3rd display. Also activates the function 
of the Mix 3 or Mix 4 on the Processing page, Enhanced Image module 
(see “Mix 3 and Mix 4 Tabs” on page 128). 

Table 4-2 Detectors Menu Overview (2 of 2)

Menu Item Description
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Table 4-3 Scan Menu Overview (1 of 4)

Menu Item
(Shortcut Keys) Description

Pause (F6) Pauses the image. Click once and the scan stops immediately without 
finishing the frame. When Pause is active, clicking again releases the 
pause function and returns the scanning to the original condition prior 
to pause. Also available on the “Toolbar” on page 84.

Snapshot 
(F4 / Ctrl + F4)

Activates a preset scan that is useful for quick frame grabs. See the 
Preferences “Scanning Section” on page 144. The second button press 
stops image acquiring at active line and pauses an imaging. 
• Press F4 to activate Snapshot for the electron beam from a preset 

display.
• Press Crtl + F4 to activate Snapshot for the ion beam from a preset 

display.
Also available on the “Toolbar” on page 84.

Photo (F2) Activates a preset higher resolution slow scan. The second icon click 
stops image acquiring at active line and pauses an imaging. The result 
can be stored on the hard drive with the Save command in the File 
menu by using the next available label/number in a predetermined 
folder. Save As can be used if the folder and label need to be changed 
prior to saving. See the Preferences “Scanning Section” on page 144.

Active Preset Snapshot (Ctrl + 
F2)

Starts image acquisition of the activated snapshot preset. See the 
Preferences “General Section” on page 147.
Note: Holding the Shift key while clicking the Photo icon / Active Preset 
button or when pressing Shift + F2 / Ctrl + Shift + F2 takes an electron beam 
Snapshot / Active Preset Snapshot from all displays with the same beam at 
once.

Videoscope (F3) Toggles the show of the videoscope on or off, showing the video 
intensity along the currently scanned horizontal line for correcting the 
contrast and brightness. Also available on the “Toolbar” on page 84.
See “Using Videoscope (F3)” on page 189.
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Reduced Area (F7) When selected, the reduced area appears with the same dimensions 
and at the last known place on the screen. On activation, it restores the 
last used scan condition. 
You can also adjust scan parameters independently on the full-frame 
setting: 
• Moving: Place the mouse cursor over the selected area. The cursor 

changes to a 4-ended arrow. Click and drag the selected area to the 
desired position and release the mouse button.

• Changing the size: Place the mouse cursor over the edge of the 
selected area. The cursor changes to a 2-ended arrow, either 
horizontal or vertical. A corner can also be used to move two sides.  
Click and drag the side out or in to obtain the desired size and 
release the mouse button.

When the Reduced Area frame is being manipulated, it turns yellow 
until released, then it reverts to green.
See also the behavior when iSPI mode is ON and patterning is running 
“Fast iSPI Mode” on page 264. 
Also available on the “Toolbar” on page 84.

Full Frame (Ctrl + M) Default scanning mode; this is the normal scanning mode, typical for 
general navigation and imaging.

Spot (Ctrl + K) Selects Spot mode and allows you to move the beam around the screen 
by the mouse click. The spot position is represented by a green cross.

Line When selected, the image freezes and a green horizontal line shows on 
the imaging display. The beam scans along this line, using the line time 
defined for the selected scan speed. When you choose Line, the cursor 
changes to an arrow. Move the cursor to the desired vertical position 
and click the left mouse button.

External Activates external control of the scanning system, such as beam control 
from an EDX X-ray system. The external scanning mode is indicated by 
the External label in the image databar. 

Beam Blank
(Ctrl + B)

Activates deflection of the beam. This can be used to reduce beam 
exposure on the sample.

Slow Scan
(Crtl + Shift + ,)

Brings the scanning condition to the preset value held on the Scan 
section of the Preferences dialog box. Also available on the “Toolbar” on 
page 84.

Fast Scan
(Crtl + Shift + .)

Brings the scanning condition to the preset value held on the Scan 
section of the Preferences dialog box. Also available on the “Toolbar” on 
page 84.

Slower Scan
(Crtl + ,)

Brings the scanning condition to the next slower scan value held on the 
Scan section of the Preferences dialog box.

Table 4-3 Scan Menu Overview (2 of 4)

Menu Item
(Shortcut Keys) Description
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Faster Scan
(Crtl + .)

Brings the scanning condition to the next faster scan value held on the 
Scan section of the Preferences dialog box.

Mains Lock Synchronizes the mains frequency to the scan system.

Line 
Integration  

Repeats each line scan several times (from 2 to 255) before proceeding 
to the next line. 
Signal data collected from these passes are integrated and shown as an 
actual image line.
This imaging method reduces sample charging (in comparison with 
single pass with longer dwell time) and improves overall image 
quality.
Note: When Line Integration or Scan Interlacing is active, it is represented in 
the toolbar scan speed spinner with the letters LI / SI. 

Scan 
Interlacing  

Splits an imaging area into blocks defined by the number of lines (from 
2 to 8). 
In the first instance, the first line of each block is scanned, then the 
second one, etc. This imaging method significantly reduces sample 
charging.
Note: When Line Integration or Scan Interlacing is active, it is represented in 
the toolbar scan speed spinner with the letters LI / SI. 
Note: Scan Interlacing can be effectively applied only for certain combinations 
of dwell time vs. scanning resolution. The overall frame time should not exceed 
300 ms. 

Live This default mode causes the image to remain unfiltered for collecting 
raw direct images—one frame follows another, mostly in Live/Slow 
scan. Also available on the “Toolbar” on page 84.

Average Continuously averages a specified number of frames (2 or more), 
selected from the list, resulting in a better signal-to-noise ratio. This 
process continues until stopped by changing the scanning condition or 
by pausing the display.
This is used mostly in a fast scan mode to reduce noise in fast scanned 
images. During averaging, the image is updated continuously, and 
actions such as focusing, moving the stage, etc., can still be performed. 
The number of frames can be selected as a preset from the toolbar 
dropdown list associated with the Average function. Also available on 
the “Toolbar” on page 84.
Note: The Average is also set independently for the optical display (option), 
but using averaging with more than 4 frames is not recommended, especially 
when moving the stage.

Table 4-3 Scan Menu Overview (3 of 4)

Menu Item
(Shortcut Keys) Description
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Integrate Allows accumulative noise reduction by true integration over a number 
of frames (1 or more), selected from the list. This process continues until 
the selected number of frames is reached and then pauses the display 
automatically, freezing the final image.
During and after image accumulation, you cannot change the focus or 
perform other image-influencing actions. 
This can be used as an alternative to slow scanning to obtain high 
quality images of slightly charging specimens.
The number of frames can be selected as a preset from the submenu or 
from the toolbar dropdown list associated with the Integrate function. 
Also available on the “Toolbar” on page 84.
Note: As the scanning could take a significantly long time period, press Ctrl + 
R (Restart Scan) to restart it from the beginning.

Alternate Electron / Ion 
Scanning
(Ctrl + Shift + A)

Alternates between electron and ion imaging in two separate displays. 
A message shows in the affected displays. All scanning parameters are 
changed during switching of the displays, so under some settings, it 
may take a significantly long time to complete.

Scan Rotation 
(Shift + F12)  

Activates the onscreen tool to rotate the scan and align the image. It has 
no effect on the stage movements and is solely a scan coil function, but 
is used to orient the image relative to mechanical rotation and detector 
direction.
A non-zero scan rotation is indicated by an icon in the Status bar for the 
electron and ion beam independently, and its value can be shown as a 
tooltip.  

Preferences...
(Ctrl + O)

Opens the Preferences dialog box. See “Preferences” on page 139.

Table 4-3 Scan Menu Overview (4 of 4)

Menu Item
(Shortcut Keys) Description
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Beam Menu

Click Beam (or Alt + B) to open the Beam menu.   

Table 4-4  Beam Menu Overview (1 of 2)

Menu Item 
(Shortcut Keys) Description

Home SEM Apertures Runs the SEM aperture home procedure.

Home FIB Apertures Runs the FIB aperture home procedure. 

Show FIB Heat Alert Enables/disables auto heat. We recommend leaving this enabled.
FIB auto heating controls the level of ion emission. When the emission 
does not meet the required conditions and Show FIB Heat Alert is 
selected, you are notified via the Heat Alert message and asked for 
corrective action to heat the LMIS back to working conditions.  

• Click Cancel to stop the auto heating.
• Click Heat Now to heat immediately. 
• If neither button is clicked, auto heating will begin in 60 seconds. A 

countdown timer appears above the buttons.
Auto heat will not activate if the system is taking a snapshot or milling.
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SEM Mode (Electron column only.) Shows a submenu for selecting three modes of 
imaging available for use with the electron beam with the TLD 
detector:
• Mode 1: Field Free
• Mode 2: Immersion (UHR)
• Mode 3: EDX 
Each mode has its own electron beam and magnification presets that 
are editable on the Detector page for Mode 2 TLD. Also available from 
the “Toolbar” on page 84. See “Detectors Page” on page 122 and “SEM 
Imaging Modes” on page 200.

Do Not Degauss Disables the automated Immersion lens degauss procedure to 
accelerate some operations, such as switching from SEM Mode 2 
Immersion (UHR) to ion beam imaging. For patterning it is 
recommended to allow the Degauss functionality. 
See “Milling” on page 288.

Lens Alignment 
(Shift + F4)  

(Electron column only.) Toggles lens alignment mode on the Beam page 
for the objective lens fine alignment. The scanning condition changes to 
a fast scan, the lens modulator turns on, and a green target cross 
appears in the center of all SEM image displays. 
Clicking & holding the left mouse button activates a 4-ended arrow 
cursor. Dragging the mouse aligns the beam with respect to the 
objective lens to reduce the movement swing. This in turn eliminates or 
reduces the movement during focusing. 
Also available from the “Toolbar” on page 84.

Magnification Correction  Applies the E-column: Magnification Correction alignment influences 
on imaging. The letter “c” is added to the appropriate databar fields 
(Mag, HFW) and the “Magnification Correction” text is added to the 
imaging display. 

UC On
Only available for the 
Helios G4 PFIB UX 

Starts UC mode for the electron beam. 
See “Electron Source Modes” on page 201. 

UC Auto
Only available for the 
Helios G4 PFIB UX 

Automatically starts the UC-mode when particular conditions are 
satisfied. 

Toggle E-I Beam
(Ctrl + T)

Quickly toggles electron and ion beams to be used in the selected 
display for imaging.

Table 4-4  Beam Menu Overview (2 of 2)

Menu Item 
(Shortcut Keys) Description
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Patterning Menu

Use the Patterning menu to control the patterning processes. For 
detailed process description see the “Patterning & Milling” on 
page 247.   

Table 4-5 Patterning Menu Overview (1 of 2)

Menu Item 
(Shortcut Keys) Description

Start Patterning in Display # Draw a pattern to enable this selection. Begins patterning with the 
pattern selected on the Patterning page. Shows the display number in 
which the patterning will occur and a Pause command. Click Pause to 
temporarily stop patterning; click Pause again to unpause and continue 
patterning. Also available from the “Toolbar” on page 84.

Reset Patterning in Display #
(Ctrl + Pause)

Resets patterning to the beginning of the pattern procedure.

Next Pattern
(Shift + P)

If multiple patterns have been drawn, stops milling the current pattern 
and continues with the next pattern. Also available on the “Patterning 
page” on page 132.

Next Line
(Shift + N)

Enabled when the cleaning cross-section is used. Stops milling the 
current line and continues with the next line. Also available on the 
“Patterning page” on page 132.

Previous Line
(Ctrl + Shift + N)

Enabled when the cleaning cross-section is used. Stops milling the 
current line and continues with the previous line. Also available on the 
“Patterning page” on page 132.

Autostart Real Time Monitor Releases the Pause function for the display with patterns to enable an 
automatic start of the RTM when patterning starts. 
See “Real Time Monitor” on page 270.

Auto-Start/Stop Electron 
Acquisition for iSPI

When iSPI (intermittent switching between patterning and imaging) 
mode is enabled (“Patterning page” on page 132), the electron beam and 
image acquisition automatically starts /stops when patterning process 
starts / is paused or stopped. 
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Live RTM after Snapshot RTM feature continues automatically after taking a snapshot.

Blackout Pattern Area for 
RTM

Blacks out the pattern background where the RTM is shown. The 
visibility of the individual patterning pixels is greatly enhanced (this is 
especially important for patterns with extremely large pitch or very 
thin lines).  

See “Blackout Pattern Area for RTM” on page 273.

Table 4-5 Patterning Menu Overview (2 of 2)

Menu Item 
(Shortcut Keys) Description
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Stage Menu

Click Stage (Alt + S) to open the Stage menu.   

Table 4-6 Stage Menu Overview (1 of 5)

Menu Item
(Shortcut keys) Description

Align Feature… Starts a procedure using stage rotation that helps orient a linear feature 
to either of the stage movement directions, X or Y. 
See “Align Feature” on page 223.
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Compucentric Rotation (F12) Places a green circle in the active display. By rotating the circle, a 
different viewing orientation of the sample area can be achieved. This is 
compucentric stage rotation. 
Stage rotation keeps the observed feature in the center of the field of 
view. If this does not occur, perform the alignment to locate the stage 
center and calibrate the stage.

Define User Units... Activates a series of dialogs that guide you in determining the User 
Unit values for X and Y movements of the stage. These are used in 
relative movements associated with stage mapping of regular features. 
See “Defining User Units” on page 226.

User Units Organizes the stage software to recognize the defined user units rather 
than the default metric measurements. The X and Y coordinates now 
operate in User Units and are shown in the Location module by the UU 
symbol. See “User Units” on page 229.

Beam Shift Reset Begins the Beam Shift Reset procedure to zero beam shift. A feature 
observed with a non-zero Beam Shift is automatically moved back to 
the imaging center using the stage. 
See “Electron Beam Shift Reset” on page 222.

Auto Beam Shift Zero Automatically resets the beam shift each time it reaches the maximum 
value during the Get moves and corrects the image position with a 
stage movement.

Table 4-6 Stage Menu Overview (2 of 5)

Menu Item
(Shortcut keys) Description
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Home Stage 
(Shift + F3)

Starts a procedure that moves all motorized axes to their hardware 
limits and ensures that the physical stage position agrees with the 
coordinates readout. During the procedure the Stage Information 
dialog box shows its progress.  

The stage axes are moved to their end-switches in the following order:
1. Z (lowest position), 2. T (tilt), 3. X, Y and R (rotation) at the same 
time.
When the stage is homed correctly it ends up in the following position:
• X / Y position is set to the factory pre-set stage rotation center of 0, 

0
• R = 0°
• T = 0°
• Z = preset long working distance (depends on the stage type)

Home Stage Without 
Rotation

Performs a Home Stage function without rotating the stage. When the 
stage is homed without rotation, the stage reference for Rotation is 
grayed out. This is useful when a large sample is inserted and stage 
rotation could cause a collision with equipment inside the chamber. By 
default, the function is enabled and automatically reverts back to the 
enabled status after every venting/pumping cycle.

Center Position (Ctrl + 0) Moves the stage to coordinates X = 0, Y = 0, the center position.

Recovery to Safe Position If the stage position is out of a safe zone, the dialog warns and refers to 
run this functionality. 

Unlink Z to FWD Shows Z-coordinate as a value corresponding with the distance from 
the home position.

Link Z to FWD Sets the Z coordinate value to the actual free working distance (FWD) 
value. This allows accurate movement between the top surface height 
of the sample and the end of the immersion lens. 
The related toolbar icon image changes according to the Z-coordinate 
status. See “Toolbar” on page 84.

Table 4-6 Stage Menu Overview (3 of 5)

Menu Item
(Shortcut keys) Description
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Enable Z-Tilt Safety Map Some movements of the tilted stage are not safe because of a possible 
collision with the final lens. The table (not user editable) with a pair of 
values indicates the maximum safe Tilt angle for a certain Z value when 
coupled. It can be used to guarantee safe usage of the stage (tilt 
restriction) for flat samples only and when a proper Link Z to FWD is 
established.

Enable Safe Stage Moves Some movements of the stage are illegal because of possible collision 
with the end lens. A legal movement of the axes depends on the 
position of the Z axis. The relation between the extreme positions of the 
other axes and Z indicate the extreme allowed positions. This relation 
can be used to guarantee safe usage of the stage only when a flat 
sample is used, and a proper link between Z and the FWD is 
established. 
When enabled, Safe Stage Moves will make legal movement with all 
axes on irregular surfaces and at high angles of tilt.

Tilt 0° (Ctrl + E) Sets stage tilt to 0°, perpendicular to the electron beam.

Tilt 52° (Ctrl + I) Sets stage tilt to 52°, perpendicular to the ion beam.

Sample Navigation (Ctrl + N)  Toggles the on/off function that enables you to navigate live FIB or 
SEM images (scan field) to desired places on a sample using either a 
paused or loaded image of that sample (usually taken at much lower 
magnification).
Sample Navigation can be selected independently for any display, 
regardless of its current content and status. A tick mark next to the 
menu item indicates that the function is selected for the active display. 
As soon as this display is paused, the Sample Navigation indicator 
appears in the upper right corner of the display. 
The indicator is green as long as the paused image can be used to 
navigate the live images; otherwise, it turns red (e.g., when the stage 
rotation or tilt changes).
Note: To make sure this function works properly, the stage rotation value for 
the captured image and the corresponding live images must be the same.

Table 4-6 Stage Menu Overview (4 of 5)

Menu Item
(Shortcut keys) Description
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Navigation Montage... Opens the Navigation Montage dialog box, which is used to take the 
image of the sample to be used in sample navigation (see above).  

• Target HFW: Sets the horizontal field width target range (in mm).
• Map Size: Indicates the number of tiles.
• Estimated Time: Shows the estimated time of the procedure.
• Single Image HFW: Indicates the HFW of each tiles.
• Use actual HFW: When selected, uses the actual image HFW.
• Start: Begins taking the image.
• Close: Closes the dialog box.
See also “Sample Navigation / Navigation Montage” on page 231

Navigation Alignment... Opens the Navigation Alignment wizard. See below.

Move Stage to Nav-Cam Moves the stage to the Nav-Cam position. See “Nav-Cam (In-Chamber 
Navigation Camera)” on page 232.

Take Nav-Cam Photo Automatically runs the Nav-Cam image procedure. 

Restore Last Nav-Cam Photo Restores the last photo taken with the Nav-Cam.

Table 4-6 Stage Menu Overview (5 of 5)

Menu Item
(Shortcut keys) Description
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Navigation Alignment

This procedure in comparison to the Navigation montage or Nav-
Cam (option) enables to use any loaded or paused Navigation 
image, which is calibrated according to the live Reference image. 

Follow the instructions given within the process (6 dialogs) and 
calibrate 4 image points. If 2 points are sufficient for desired 
purposes, click on the Compute 2pt alignment button to finish the 
process after setting 2 align points. 

The Navigation Alignment wizard aligns the Navigation image 
according to the Reference image.  

When any point setting does not satisfy system requirements an 
Warning message informs a user. 

Figure 4-9 Navigation Alignment Wizard



User Interface    Microscope Control Software

74

Thermo Fisher Scientific CONFIDENTIAL, Limited Rights Data 

Tools Menu

Click Tools (Alt + O) to open the Tools menu.   

Table 4-1 Tools Menu Overview (1 of 2)

Menu Item Description

Image Registration This functionality is used to interconnect images of the same area of 
interest acquired from different sources or at different conditions (for 
instance images acquired from optical and SEM microscopes, images 
acquired at various depth of focus etc.) (see below).

Auto Contrast Brightness 
(F9 / Shift + F9)

Enabled during live imaging. Activates the automatic contrast and 
brightness (ACB) routine. The system attempts to set the Contrast and 
Brightness of the selected detector in the active display to suit the actual 
sample and conditions so that the majority of gray levels is shown. This 
functionality is available for both beams and for paused imaging. 
Also available from the “Toolbar” on page 84. 
Note: When ACB is activated, a progress dialog box appears. The function can 
be interrupted by clicking Stop Now, leaving the imaging at the actual stage 
of progress. Clicking Cancel before the function ends returns the imaging back 
to its original status.  
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Image Registration

Click the Tools menu / Image Registration and follow the 
prompts at the top of the window:

1. Select the display with the Reference image.

2. Select the display with the Target image (the one that will be 
transformed).

Auto Focus (F11) Activates the automatic focus (AF) routine. The system attempts to 
correct the focus independently of the working distance or set Z-
coordinate. This functionality is available for both beams.
Also available from the “Toolbar” on page 84.
Note: When AF is activated, a progress dialog box appears. The function can 
be interrupted by clicking Stop Now, leaving the focus (WD) at the actual 
stage of progress. Clicking Cancel before the function ends returns the 
imaging back to its original WD value.

Auto Stigmator (Ctrl +F11) Activates the automatic procedure to correct an astigmatism. 

Sample Cleaning Starts the sample cleaning procedure according to the Plasma Cleaning 
alignment (see below). 

Set HFW (Ctrl + H) Enables to set the desired Horizontal Field Width, i.e. the width of the 
scanned area. This is an alternative to the setting of magnification.  

Display Saturation
(Shift + F11)

Shows the saturation status of the image for the selected display. 
Oversaturated areas of the image (white areas) are shown in blue and 
undersaturated areas (black areas) are shown in yellow. 

Image Post Processing 
(Ctrl + F7)

Changes image properties according to the Image Enhancement 
module > Process tab setting. See “Process Tab” on page 131.

Application Status... Opens a window above the display 4 that shows a continuously 
updating status of the system. See “Application Status” on page 79.

Preferences... (Ctrl + O) Opens the Preferences dialog box. See “Preferences” on page 139.

Table 4-1 Tools Menu Overview (2 of 2)

Menu Item Description
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3. Select 1, 2 or 3 corresponding pairs of points in both the 
reference and target images.  

4. Click the Register button to apply the transformation.

Click the Close button to close the Image Registration window.  

Click the Start Again button to repeat the procedure in the same 
way with the changed (or another) target and reference images 
placed in the same or different displays. Clicking the Undo button 
restores the image to the situation before the last transformation.

Clicking the Overlay check box shows a copy of a registered target 
image (in selected Color) over the reference image which reveals a 
quality of the registration and enables to compare information 
from both images. The Threshold value (0 to 255) determines 
which gray levels of the target image are shown in the overlay and 
the Edges Only check box ensures to display only the edge 
outlines. 

After registration the micron bar and magnification of the target 
image take on the same values of the reference image. Any 
operation that is applicable to an acquired SEM image can be 
applied to a transformed image, including saving a file.

N
O

T
E When selecting 1 point, image is shifted only, 2 points shifts and 

rotates it and by selecting 3 points it is skewed furthermore.
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Sample Cleaning

Select Tools > Sample Cleaning to start the Sample Cleaning 
procedure, which is an efficient process for removing very thin 
contamination layers that are typically formed by hydrocarbon 
residues remaining on vacuum parts after conventional cleaning or 
could be transferred into the microscope chamber with a sample. 

The plasma cleaner generates free oxygen radicals that react with 
hydrocarbon molecules on the surfaces to form CO, CO2, and H2O 
molecules that can be pumped away. It is operated at vacuum 
conditions similar to the low vacuum operation (~50 Pa).  

The Sample Cleaning procedure uses cleaning times up to 
5 minutes. The time is set in the Plasma Cleaning Alignment 
(see “External Plasma Cleaning / Plasma Cleaning” on page 347). 

Figure 4-10 Plasma Cleaner
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For avoiding typical “weak” contamination artefacts during high 
resolution imaging (image darkening), 1-2 minutes plasma 
cleaning duration in combination with cryo cleaning (see 
“CryoCleanerEC” on page 380) should be sufficient. When bulky 
deposition is visible (mostly on image corners), 5 minutes duration 
is recommended. 

Sample Cleaning Procedure 
1. Move the stage to the lowest Z-axis position.

2. Select Tools > Sample Cleaning to start the procedure, or click 
the toolbar button. 
It is possible to start the procedure from the vented state by 
ticking the Vacuum module / Sample Cleaning check box. 

A dialog box or tooltip will appear onscreen if there any 
conditions that will not allow it to begin. 

3. Move the stage back to the observation position. 

N
O

T
E

Porous, biological or hydrocarbon based samples cannot typically be 
viewed without the presence of contamination artefacts even after 
plasma cleaning. This is caused by the presence of contamination 
source in the sample itself. Sometimes, poor image quality could be 
caused by e-beam etching and re-deposition of etched material also. 
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When the procedure is finished or aborted by a user, the system 
remains evacuated. During the procedure run, stage moves are 
disabled temporarily. 

Application Status

Opens a window above display 4 that shows a continuously 
updating status of the system.   

Figure 4-11 Application Status

C
A

U
T

IO
N

Always retract EDS / WDS / EBDS detector before plasma cleaning! 
Avoid leaving sensitive carbon containing samples (e.g., photo resist) 
inside the chamber during Plasma Cleaning procedure, as they may 
be etched by the cleaning process. Any material that can create or 
release oxide easily (e.g., silver) should not be plasma cleaned (Au-C 
resolution test samples could be left inside the chamber during the 
Sample Cleaning procedure).
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Table 4-1 Application Status Window Overview

Interface Item Description

Messages Tab Shows the message area with severity icon, time, description, source, 
and sort function.
Severity icon key:
• = warning
• = error
• = information

Popup on Message Severity Choices are: 
• None: Will not appear. 
• Error: Appears only for the most sever errors when the system 

cannot continue without intervention.
• Warning: Appears only for upcoming events, such as when the FIB 

needs to be heated.
• All: Appears only for upcoming events, such as when the FIB needs 

to be heated.

Clear Clears the messages list.

Hide Hides the dialog box.

System Status Tab Shows the status of the various system components at any given time.  
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View Menu

Click Window (Alt + W) to open the View menu.   

Table 4-2 View Menu Overview (1 of 3)

Menu Item
(Shortcut keys) Description

Center Cross 
(Shift + F5)  

Places a cross in the center of each display. This function is 
automatically used in Alignment procedures to aid the centering of 
features and can be used to align a sample against a stored image in 
another display.

Alignment Rectangle
(Shift + F6)

Places a dashed rectangle in the center of all electron displays. This 
function is used to aid in controlling illumination for some Alignment 
procedures automatically.

CCD Axis 
Marker  

Shows X, Y, and Z axes in the CCD display to help the user with 3D 
orientation. 

CCD 4 mm 
Marker  

Places a short horizontal line with 4 mm label in all optical displays to 
help with sample positioning to a correct working distance and with 
the first focusing. 

Crosshair Cursor Changes the mouse cursor into a crosshair cursor. The crosshair cursor 
is useful in aligning patterns or features.
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Measurements and 
Annotations 

Ticking this items makes measurements and annotations toolbar icons 
active, otherwise they are not accessible (greyed out). 

Zoom Application  This functionality enables to enlarge / reduce the Microscope Control 
application controls size (labelling texts, icons etc.). 

Undo / Redo Zoom #x Toggles the digital zoom to redo or undo. Digital zoom can be set from 
the Measurement and Annotation page by increasing or decreasing the 
magnification for the active display. 
Redo Digital Zoom retains the last magnification factor set by digital 
zoom and, when selected, sets the magnification factor in the active 
display to that stored.
When the Redo Digital Zoom has been activated, the menu item reverts 
to Undo Digital Zoom. Selecting this brings the image back to normal 
magnification by negating the factor created by digital zoom.
Note: To revert the last step use the Edit menu / Undo (Ctrl + Z) 
functionality, which is also available at the toolbar. 

Large Image Window 
(Ctrl + F5)

Activates/deactivates full screen imaging on the secondary monitor.

Large Image Window 
Configuration

Allows a selection of any display to be shown as Large Image Window. 
These options are also available in the bottom right corner of the large 
image window. 

Remote Mode  Enables a correct UI image at the remote site. It is also used for remote 
servicing.
Use of this function slightly decelerates the UI performance and it is 
shown in the bottom left display corner.

Full Screen Ticking this item extends the UI to maximal size with respect to the 
screen. 

Table 4-2 View Menu Overview (2 of 3)

Menu Item
(Shortcut keys) Description
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Help Menu

Click Help (Alt + H) to open the Help menu.   

Single / Quad Image Mode 
(F5)

Toggles the imaging from 1 display to 4 displays and vice-versa. In 
Single Image mode the display list is selectable to be shown 
individually in the single image mode. When you switch from 
Quad Image mode to Single Image mode, the active display is the one 
that becomes full screen.
Quad Image mode is useful for comparing images of the same sample 
area setup with different beams, detectors, or scan properties.

Table 4-3 Help Menu Overview

Menu Item Description

Documentation… (F1) Shows this complete user guide in PDF format using an embedded 
Acrobat Reader with its useful navigation, search, and selection tools.

Safety Manual… Opens the User safety manual. 

Keyboard Shortcuts… Shows a list of keyboard shortcuts, as shown in Table 4-4 on page 154 
and Table 4-5 on page 155.

About Microscope Control... Shows the software version and date of release.

Table 4-2 View Menu Overview (3 of 3)

Menu Item
(Shortcut keys) Description
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Toolbar 

The toolbar shows functional buttons linked to the most frequently 
used system controls. Rest the cursor on the button without 
clicking on it to see its highlighted caption or tooltip.

Select system functions with the buttons in the toolbar. Whenever 
you select a function, the corresponding button is highlighted to 
indicate that a function is active (except autofunctions, that show a 
progress dialog box).   

Table 4-4 Toolbar Overview (1 of 8)

Icon Description

Undo / Redo  The undo / redo buttons assist to return / re-run the last actions. 
Actions used in history are accessible by clicking the down arrow and 
they can be re-used separately or any continuous sequence of actions 
can be selected and re-used as a group. 
Note: Some particular actions (alignments etc.) cannot be returned and 
sometimes the system clears the history. 

Magnification Beam Current / 
Spot size 

Link Z to 
FWD

High 
Voltage

Reduced 
Area

Auto Contrast 
Brightness

Beam 
Selection

Auto 
Focus

Lens 
Alignment

Videoscope

Preset Scan 
Speeds

Photo/
Snapshot

Toolbar Left Side

Toolbar Right Side
Select Filter 

Mode

Start / Pause / 
Resume Patterning

SEM 
modes

System 
Parameters

Patterning 
Presets

Scanning 
Presets

Pattern / 
Measurement / 

Annotation Tools

PausePixel 
Resolution

Undo / 
Redo

Sample 
exchange

Reset 
Patterning

Spot 
mode

Sample 
Cleaning
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Sample Exchange  The window containing complete instructions for sample exchange and 
information about the system vacuum status. In addition it is possible 
to set various working environment and start-up actions:  

• Working folder for images storing with subfolders for each display 
• Automatic Sample cleaning when pumping the chamber down 
• Take Nav-Cam Photo automatically 
• Holder and other accessories selection 
• Set System Wake Up and Sleep states 

Sample Cleaning  Starts the Sample Cleaning Procedure. 

Beam Selection: Only one beam is active at any time, but can be operated independently for each 
display image area. The beam can also be selected on the “Beam Menu” on page 64 or press Ctrl + T to 
toggle between electron beam and ion beam.

Electron Beam  Selects the electron beam as the primary beam for control.

Table 4-4 Toolbar Overview (2 of 8)

Icon Description
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Ion Beam  Selects the ion beam as the primary beam for control.

Optical Beam  Selects the CCD camera as the primary beam for control. 

Nav-Cam  Selects the Nav-Cam as the primary beam for control. 

Column Settings: The value ranges for these presets are specific for the electron and ion beams and can 
be changed on the Preferences, see “Presets Section” on page 140.

Magnification/HFW  Selects the magnification or horizontal field width for the selected 
column. 
Click to show a list of the preset values. The selected value is shown in 
the text box and applied immediately. 

High Voltage  Selects the high voltage (HV) for the selected column. The value is then 
shown in the list and the column condition changes to that value.

Beam Current  Selects the beam current for the selected column. The value is then 
shown in the list and the column condition changes to that value.
The maximum E-beam current for the UC mode is 100 pA. 
The aperture holes for the FIB wear out with regular use so multiple 
apertures are available for commonly used beam currents, which is 
noticeable by doubling the beam current value. Thermo Fisher 
Scientific service engineers can mark certain apertures unavailable for 
use. Unavailable apertures are marked in the beam current list with -..- 
so they cannot be selected. 
If you do try to select one of the unavailable apertures, the following 
Application Status message appears.  

Lens 
Alignment  

Electron beam only: activates/deactivates the final lens alignment 
mode for the fine alignment. The scanning changes to the fastest scan 
value, the lens modulator turns on, and the green target cross appears 
in the center of all electron beam imaging displays. 
Clicking and holding the left mouse button activates a 4-ended arrow 
cursor. The mouse motion starts the final lens alignment.
Also available from the “Beam Menu” on page 64.

Table 4-4 Toolbar Overview (3 of 8)

Icon Description
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Reduced Area  Allows selection of a reduced scanning area within the current image 
resolution. This is useful when focusing and correcting an astigmatism 
as the scan speed is faster in the smaller area. The reduced area appears 
in the middle of the screen. The surrounding image is the actual image 
in the framestore. Pressing F7 again returns you to full frame.
Also available from the “Scan Menu” on page 59.

Spot mode  Sets Spot mode scanning conditions. 

Link Z to FWD Sets the Z coordinate value to the actual free working distance (FWD) 
value.  

The toolbar icon changes to reflect the Z-coordinate status:
• Grayed icon: The function is disabled because either the stage has 

not been homed, the HV is switched off, the ion beam is selected, or 
all displays are paused.

• Red question mark: The function is enabled and the link between 
Z and FWD is unknown. Use the function as soon as possible, after 
properly focusing the image.

• Red circle: The function is enabled. Z is roughly linked to FWD, but 
it needs correction. This could happen after changing the sample, 
focusing and linking Z to FWD at a long working distance (WD), 
and then moving the stage to a short WD. Focus the image carefully 
at a WD around 4 mm and use this function again.

• Green 2-ended arrow: The function is enabled to allow further 
corrections of the Z-coordinate, Z is properly linked to FWD. It is 
now safe to change the WD by setting a Z coordinate in the Stage 
module.

Also available on the “Stage Menu” on page 68.

Auto Contrast 
Brightness  

Activates the automatic contrast and brightness routine. Autofunctions 
are only enabled during live imaging.
Also available on the “Tools Menu” on page 74.

Table 4-4 Toolbar Overview (4 of 8)

Icon Description
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Auto Focus  Activates the automatic focus routine for either beam. Autofunctions are 
only enabled during live imaging. 
Also available on the “Tools Menu” on page 74.

Videoscope  Shows the video signal intensity along the currently scanned horizontal 
line for correcting the contrast and brightness. 
Also available on the “Scan Menu” on page 59.

Scan Speeds: These controls provide slow or fast scanning capabilities. When either of the two presets is 
active, its respective icon is highlighted. Clicking any of these items changes the scan speed. The presets 
are defined on the “Scanning Section” on page 144. These controls are also available on the “Scan Menu” on 
page 59.

Preset Scan 
Speeds + / -  

Shows the selected scan speed preset: 
• +: Increases the scan speed in predefined increments.
• -: Decreases the scan speed in predefined increments. 

Pixel 
Resolution  

Shows the predefined image size (screen pixel resolution) for viewing 
or capturing an image. These presets are not editable from the dropdown list, 
but they can be changed on the “Scanning Section” on page 144. 

Photo / 
Snapshot  

For a quick image, activates a single scan at a preset scan setting that 
pauses at the end of the frame. The result can be automatically saved on 
the hard drive to a predetermined file location using the next available 
label/number if set on the “Scanning Section” on page 144.

Pause  Pauses the image. The behavior is set on the Preferences “General 
Section” on page 147:
• Click once and the scan will stop immediately without finishing the 

frame, or 
• Click once to stop scanning at the end of the frame.
• Click twice to pause the scan immediately at the present position.
When Pause is active, clicking again releases the pause function and 
returns the scanning to the original condition prior to pause. 
When Pause is clicked again, two vertical green bars surrounded by a 
green box appear in the top left corner of the full screen or active 
display.
Depending on the selected beam, a tooltip states “Not allowed to start 
image acquisition. Sample is not under this beam.” 
• When the stage is under the optical beam, you cannot scan or 

pattern with the FIB or SEM.
• When the stage is under the FIB or SEM, you cannot scan with the 

optical beam.

Table 4-4 Toolbar Overview (5 of 8)

Icon Description
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Select Filter Mode: This section contains four items related by conditions of filtering of the raw scanned 
image. Clicking the icon itself changes the Live/Average/ Integrate mode in cycle. Click the down 
arrow to access the preset list for number of frames.
If you select one of these three options from a frozen (paused) image state, the imaging will start 
automatically without the need to unpause it, using the selected filter mode. 
These selections are also available on the “Scan Menu” on page 59.

Live  Starts Live imaging with one frame following the other. The image 
remains unfiltered for collecting direct images, mostly in Live/Slow 
scan. This is the raw scanned image with no filtering.

Average  Starts Average imaging. Continuously averages a specified number of 
frames (2 or more), resulting in a better signal-to-noise ratio. Select the 
number of frames to be averaged in the dropdown list box.
During averaging, the image is updated continuously and actions such 
as focusing and moving the stage can still be performed. This process 
will continue until stopped by change of scanning condition or by 
freezing the result.

Integrate  Starts Integrated imaging. Allows accumulative noise reduction by true 
integration over a number of frames and freezes the final image. Select 
the number of frames to be averaged in the dropdown list box. This 
process continues until the predefined number of frames is reached, 
and then stops and freezes automatically.
A progress bar shows in the active display as the frames are integrated.  

Preset number 
of frames  

Selects the number of frames for Average and Integrated imaging. Click 
the arrow to the right of the button to show the dropdown list showing 
the number of frames for each value of Average or Integrate. Live is 
always 1 frame.
Select one of these values to update to that condition. Frame values for 
Average and Integrate are independent of each other and of scan 
speeds, so values can be preset for particular scan, beam, and display 
conditions. Set a filter per display, per beam so that live and filtered 
images of a beam can be seen at the same time; if a new beam is 
selected, it reverts to the preferred setting for that beam.

Table 4-4 Toolbar Overview (6 of 8)

Icon Description
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Select SEM Mode  Only active for the electron beam. Shows one of three SEM (final lens) 
modes:
• Mode 1: Field-Free – For low magnification searching of the 

samples or sample area.
• Mode 2: Immersion – A higher resolution mode for viewing the 

sample at a higher magnification.
• Mode 3: EDX – Used for EDX operation where the lens is used as a 

magnetic trap for backscattered electrons (BSEs) during EDX 
analysis.

Also available on the “Beam Menu” on page 64. See “SEM Imaging 
Modes” on page 200.

Patterning  Starts, resets, pauses, and resumes patterning. The icons change 
according to an actual process status. The system response could delay 
a little until transitions finish. 
• Click the Start button to start the patterning. The button changes to 

pause button.
• Click the Pause button to pause the patterning. The button changes 

to resume button.
• Click the Resume button to resume the patterning. The button 

changes to pause button. 
• Click the Stop button during patterning or when patterning is 

paused to reset the patterning. The button changes to inactive state 
(gray).

• Clicking the Stop button during an image acquisition finishes it 
and subsequently pauses the patterning. The button changes to 
active state (black). 

Scanning conditions: 
• When the stage is under the optical beam, you cannot scan or 

pattern with the FIB or SEM.
• When the stage is under the FIB or SEM, you cannot scan with the 

optical beam.
Also available on the “Patterning Menu” on page 66.

Import / Export 
System Parameters  

Shows a submenu with selections of importable / exportable items.  

Selecting an item opens a standard Open/Save As dialog box for 
choosing a location and file name (see File menu / Import / Export 
item).

Table 4-4 Toolbar Overview (7 of 8)

Icon Description
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Patterning presets 

By default there are 6 empty toolbar Pattern presets (labelled p#) 
for each (electron / ion) beam. Clicking on any one imports 
predefined set of patterns into the active display.

Right-clicking on any Pattern preset button calls up the context 
menu: 

 Clicking on the Apply item (the same as clicking the button 
directly) loads parameters from this file and corresponding 
patterns are drawn in the active display. To start patterning 
under loaded conditions follow the patterning process.

 Clicking on the Update with Current Selection item assigns 
patterns directly from the active display, saves the setting to 

Patterns / Measurements / 
Annotations  

Intensity Profile tool 

The toolbar set of 6 graphic tools (2 cursors and 4 shapes) last time used 
and the drop-down arrow for selection of more ones enables to quickly 
access the Patterns / Measurements / Annotations tool. Clicking on the 
icon activates (orange background) / deactivates (grey background) the 
appropriate functionality. 
The numerical values of linear distances, diameters, angles, or areas of 
the image are updated while drawing and shown alongside or within 
the finished measured item. The Measurement tool dimensions scale 
with the image; when changing magnification, the shown tools change 
their size accordingly. On the contrary, the Annotation shapes and texts 
have their sizes fixed relatively to the display. 
Intensity Profile delineates the imaging profile across a freely selected 
line with a set of properties. 
• Dynamic Y Range: Normalizes the line profile and shows 

information across the full Y axis range.
If the line profile only has gray scale information from bin 100–200, 
selecting Yes for Dynamic Y Range stretches the profile to show the 
low bin (100) at the zero point of the graph and the high point (200) 
at the 255 point of the graph. This allows you to better analyze the 
profile if it does not have data in the full range of 0–255.

• Integration Width: Integrates the profile over a user-selected pixel 
width, to minimize signal noise and smooth the profile. 

Table 4-4 Toolbar Overview (8 of 8)

Icon Description
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the file and automatically applies it to the selected preset 
button. Tooltip shows the location and a file name.  

 Any toolbar Pattern preset button can be assigned to an 
individual .ptf file (with all patterning parameters exported 
via the File menu / Export / Patterns or System Parameters 
item) by selecting Import from File… item. 

 To rename the pattern preset button click the Rename… item.  

 Clicking on the Reset to Default item brings all settings to the 
factory presets. 

Scanning Presets 

By default there are 6 factory toolbar Scanning presets (labelled 
s#) for each (electron / ion) beam. Clicking on any one sets 
scanning conditions for active beam (dwell, resolution etc), display 
(filter) and starts image acquiring with corresponding parameters. 
Right-clicking on any Scanning preset button calls up the context 
menu:  

 Clicking on the Activate item highlights the button (orange 
background) and starts image acquiring or just activates the 
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preset according to the Scanning presets property editor / 
Shared Settings section / Start scan on left click item setting 
(Yes / No). The Multiple Activate item has the same 
functionality in all compatible displays (same beam). 

 To start image acquiring is possible also using the Scan menu / 
Active Preset Snapshot (Ctrl + F2) item. 

 Clicking on the Snapshot / Multiple Snapshot item starts 
snapshot acquiring from selected / all compatible displays. 

 Clicking on the Update with Current Settings item updates 
selected Scanning preset with actual scanning settings.

 Clicking on the Edit item opens selected Scanning preset 
property editor. It is also possible to use the toolbar expand / 
hide arrow with the same effect.  

Click the Apply button to store edits and close the Property 
editor. 

 It is possible to Import / Export Scanning Presets from / to a 
file (.scp).

 Clicking on the Reset to Default item brings all settings to the 
factory presets. 
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Select any of six presets to activate image acquisition according to 
preset parameters.  

Imaging Area 

The Microscope Control software shows images via four 
independent image windows called displays. All displays can 
contain a live image from any detector (including External and 
CCD), paused images, or images loaded from a file. Additionally, 
display 3 can show a mix of imaging from displays 1 and 2, and 
display 4 can show a mix of imaging from displays 1, 2 and 3.

The image window includes the image area plus the databar, and 
it shows the scanned area image and any defined patterns. You can 
interact with the images or draw patterns on them. 

The four displays can be shown either all at the same time in 
Quad Image mode or one zoomed display at a time in 
Single Image mode. 

N
O

T
E

Shift + clicking the Photo icon (or Shift + F2) takes an electron beam 
Snapshot from all displays at once.
Ctrl + clicking the Scanning preset button takes an electron beam 
Snapshot of the active display only.
Ctrl + Shift + clicking the Scanning preset button takes a snapshot 
from all available electron or ion beam displays (depending on the 
active beam) at once.
The same keystrokes will interrupt the acquisition process.
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To choose the image display mode, select the appropriate View 
menu item or press the F5 toggle key. Click in a display to select it. 
Pressing Ctrl + Tab selects each display in turn.  

In Quad Image mode, display 1 is top left and display 4 is bottom 
right.

Quad Image mode is useful for comparing images of the same 
sample area taken with different beams or scan properties. 
See “Setup for Imaging with Either Beam” on page 169.

When you select a display, you give it the input focus—that is, you 
designate it as the part of the user interface that receives mouse 
and keyboard input. The display with input focus has a blue 
databar. The other displays have gray databars. 
See “Databar Color Coding Status” on page 97. 

Note that you can continue live imaging in one display even when 
you have given focus to another.

When you switch from Quad Image mode to Single Image mode, 
the display with input focus is shown on the full screen. If a non-
imaging part of the user interface (such as a page or dialog box) 
has the input focus when you switch to Single Image mode, that 
last display to have input focus is shown on the full screen and 
recovers the input focus.

Depending on the display content and the status, some mouse 
functions are available over its area:

 Electron imaging (including External and Mix): Focus, 
astigmatism correction, Beam Shift, magnification change 

1 2

3 4
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(coarse, fine), zoom (in/out), Contrast and Brightness, lens 
alignment, Scan/Compucentric Rotation, XY-move (Get or 
Track moves) 

 Ion imaging (including External and Mix): Focus, astigmatism 
correction, Beam Shift, magnification change (coarse, fine), 
zoom (in/out), Contrast and Brightness, Scan/Compucentric 
Rotation, XY-move (Get or Track moves) 

 Optical imaging: 4 mm Marker placement, Compucentric 
Rotation, Z-move (Track moves), Tilt 

N
O

T
E

Due to a hardware limitations, some detectors cannot be used 
simultaneously. They can still be selected for different displays at the 
same time, but if one of them is started, the other displays with 
incompatible detectors are automatically paused. The optical imaging 
is automatically activated (if it is paused), when the venting procedure 
starts. When it is paused and any stage movement takes place, the 
pause icon turns red and a list of changed axes is shown. 
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Image Databar

Optional instrument, imaging and labelling information are shown 
at the base of all displays. The configuration and available items 
differ for the beam selected (Electron / Ion / Optical / Nav-Cam) 
for the selected display. 

Databar Color Coding Status

In Quad Image mode, the active image area has a blue databar. 
Other image windows have databars in different colors (see 
following table).  

Figure 4-12 Image databar examples  

Table 4-5 Databar Color Coding Status

Display 
Status

Scan 
Condition

Background 
Color Text Color

Selected Live Blue White text

Not selected Live Gray White text

Selected Pause Blue White text

Not selected Pause Gray Black text

Selected Patterning Light green White text

Not selected Patterning Dark green White text

N
O

T
E The Databar information are always related to the live imaging. If the 

imaging is paused or an image is loaded from a file, they could differ 
from actual system conditions. 

Active display

Inactive display

Active Patterning display

Inactive Patterning display
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Menu Access

Click on some of the image databar fields to access an active menu 
with appropriate choices related to that field. 

Databar Configuration 

To set information included in the databar right-click on any 
display databar and click on & drag desired Available Item to the 
Visible Items field. Items can be placed in any order (by dragging 
the item up / down within the list) and expand or contract 
automatically to fit the display width as long as there is enough 
room, which influences all displays with the same beam. 

The Micronbar area scales to the magnification.

Clicking on the Choose Bitmap item opens a dialog to select a 
bitmap to be loaded into the databar (if the Bitmap item is ticked). 

To label databar, double-click on the Label field and fill in the 
dialog. It can be set independently for each display. 

Figure 4-13 Databar Configuration / Label Editing  
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Image Properties

Double-click the micron bar to access the Image Properties dialog 
box to view the full set of properties relating to the image in the 
display. If you leave the dialog box open and click in the databar of 
another display, the property data changes accordingly for the 
image in the new display.  
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Status Bar

The Status bar can be found at the base of the UI screen and it 
contains several user selectable items and information about 
running system processes (patterning for instance). These 
parameters may change due to the application being monitored at 
any time.

Figure 4-14 Status Bar (divided to left / right part)  

Right-click on the Status bar and tick items to be shown: 

 Chamber Pressure – the specimen chamber pressure 

 Ion Beam Current – correct ion beam current value in case the 
beam is blanked 
When it reverts into operation (unblanked), the value has no 
point. 

 Specimen Current – the electron current reaching the 
specimen

 Emission Current – the electron / ion current reaching the 
specimen 

 Electron Source Pressure – pressure in the corresponding 
vacuum system section 

 Clock – can be shown at the bottom right window corner 

 Messages – Application Status incoming notice can be shown 

The vacuum status is also indicated by the color of the chamber 
icon: 

Green = pumped to the desired vacuum mode 
Orange = transition between two vacuum states
Gray = vented 

When you hover the mouse over any icon, a corresponding tooltip 
appears with actual status for the parameter(s) or just an 
information.   
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Pages 

The system software controls are organized into control pages and 
are placed on the top right side of the UI screen. Rest the cursor on 
the icon to read its tool-tip. The selected page has an orange 
background. These pages are divided into smaller modules for 
specific functions. The most frequently used controls appear as 
modules on more than one page. 

Table 4-1 Status Icon Overview

Icon Function

Dual column and chamber vacuum: Green columns and dark chamber 
= operating vacuum in columns but chamber is to atmosphere.

Dual column and chamber vacuum: Green columns and orange 
chamber = operating vacuum in columns and chamber pumping down, 
venting or purging.

Dual column and chamber vacuum: Green columns and chamber = 
operating vacuum reached in all sections.

Stage axes lock/unlock: Closed lock indicates any or all axes locked.

Dynamic Focus: Shows when Dynamic focus is on.

Scan rotation: Shows independently for electron and ion beam when 
Scan Rotation is not zero.

External: Shows when the External scan mode is operating.

Degauss: Shows when Do Not Degauss is ticked on the Beam Menu.

Beam Control

Navigation

Detector 

Patterning

Rocking Polish 

EasyLift

Direct Adjustments

Sample Preparation

Alignments
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Beam Control Page

Use the Beam Control page for vacuum control to pump and vent 
the system and to control the electron and ion columns. For 
operational details, see Chapter “Getting Started” on page 159.  

Figure 4-15 Beam Control Page

Click the ? to access 
online help for that 
module.

See “Vacuum Module” on 
page 103

See “System Module” on 
page 103

See “Column Module” on 
page 104

See “Beam Deceleration 
Module” on page 109

See “Magnification Module” on 
page 107

See “Beam Module” on 
page 107

See “Scan Rotation Module” 
on page 109

See “Detectors Module” on 
page 110

This symbol represents 
the selected column 
type: electron or ion.

Use the toolbar buttons 
to switch the column 
type as necessary for 
operating in individual 
displays.
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Vacuum Module

Use the controls in this module to control the pressure in the 
specimen chamber.  

System Module

Use the controls in this module to start and stop the system. 
See “Beginning Your Session” on page 162.  

Table 4-1 Vacuum Module Overview

Interface Item Description

Pump Starts the pump down procedure for the sample chamber and column. 
For turbomolecular pump (TMP) systems, evacuating the sample 
chamber is immediately through this pump. When the chamber is 
evacuated, the system allows high voltage to be switched on when the 
pressure in the chamber and the column are ready for operation. 

Sample Cleaning Starts to pump out the system, performs the Sample Cleaning 
procedure, and keeps the chamber evacuated. 
See “Sample Cleaning” on page 77.
Preset adjuster enables to set sample cleaning procedure duration. 

Vent Initiates the following sequences for the respective columns and GIS 
system after a user confirmation:
• Electron column: Switches high voltage (HV) off and closes the 

column isolation valve (CIV).
• Ion column: Blanks the beam and closes the CIV. HV is brought 

back to 5 kV.
• GIS system: Closes the GIS, retracts the GIS needles, and turns off 

the GIS heaters.

Table 4-2 System Module Overview

Interface Item Description

Wake Up Turns on the electron and ion beam accelerating (high) voltage, starts 
the ion source, starts the electron source (if it is switched off) and starts 
GIS heating (under some conditions).
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Column Module

Use the controls in this module to set the electron and ion beam 
conditions.  

Sleep Turns off the electron and ion beam accelerating (high) voltage, stops 
the ion source, and turns off GIS heating.
Note: Stopping the ion source impacts the life time of the source.

Table 4-3 Column Module Overview

Interface Item Description

Beam On Initiates the following sequences for the respective columns:
• Electron column: Switches high voltage on/off and opens/closes 

the column isolation valve (CIV).
• Ion column: Opens/closes the CIV, selects the last-used aperture, 

selects the preselected high voltage, and turns the ion source on if it 
is not already running.

Color Key: Orange = activated / Gray = deactivated.

Beam Current Preset adjuster used to change the overall beam current using preset 
values (see “Presets Section” on page 140).

High Voltage This preset/continuous adjuster is used to change the overall high 
voltage either continuously or using preset values (see “Presets Section” 
on page 140). 
• The electron column range is from 350 V to 30 kV in regular mode 

and down to 50 V with beam deceleration mode
• The ion column range is from 500 V to 30 kV. 
• The current high voltage value is shown in the text area of the 

adjuster, toolbar, and in the image databar 
(if selected in “Image Databar” on page 97). 

Table 4-2 System Module Overview

Interface Item Description
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Column Presets

Column presets simplifies microscope operation to users. 
Microscope software comes with 6 pre-defined sets of various 
column parameters separately for electron and ion beams 
(depending on the active display) represented by the Column 
Presets buttons labelled c#. A user can change these settings to 
easily choose the operating conditions according to his needs. 

The column preset is applied with a click, a progress dialog is 
shown. The button becomes highlighted (orange background) when 
all actual microscope settings match the preset parameters (column 
conditions for active beam and detector settings for active display). 
The bold labeled button indicates the last applied column preset. 

Note the behavior that is not obvious: 

 The sequence of parameters being applied with the Column 
preset button click may change depending on imaging mode 
(SEM modes or Beam deceleration mode). 

 SEM imaging modes are also covered in column presets. 

 Beam is not switched on automatically when a column preset 
is applied. 

 It can happen that a column preset cannot be completely 
applied because it is not possible to set some parameter 
(particular detector not available, stage bias value out of the 
range or incompatible SEM imaging parameters - range of 
accelerating voltage at given working distance). In such a case 
an application status error message is shown.

 Mix detector cannot be used for a column preset. 

A tooltip is shown when leaving mouse cursor over any preset 
button giving parameters overview divided into 3 areas (Preset 
name / Key parameters / Other parameters). There are different 
tooltips depending on the beam selected for the active display. 

Tooltip dialog / Detector settings line contains information in 
format <detector>, <detector mode>. Particular settings of a 
detector custom mode is not supported in column presets.  
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Parameters are colored, which indicates:

 Green – actual microscope setting matches the column preset

 Brown – actual microscope setting differs from the column 
preset

 Grey – Value is not relevant when respective component is 
switched off

Right-clicking on any preset button calls up the context menu:  

 Clicking on the Update with Current Settings item updates 
selected preset button with actual settings.

 Clicking on the Rename item enables to rename the selected 
preset button.  

 It is possible to Import / Export Column Presets from / to a file 
(.clp). 

 Reset to Default button – restores the default settings for all 
column presets (for both beams).
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Magnification Module

Use the controls in this module to set the imaging magnification. 
See also “Magnification” on page 194.  

Beam Module

Use the controls in this module for correcting of beam astigmatism 
and beam shift for both beams.

Table 4-4 Magnification Module Overview

Interface Item Description

Couple Magnification Couples (locks) the magnification of both beams.

Magnification Adjusts the magnification.
• Clicking the end arrow increases/decreases magnification by 5%.
• Clicking between the end arrow and the middle button 

increases/decreases magnification by 20%.

Table 4-5 Beam Module Overview (1 of 2)

Interface Item Description

Stigmator 2D control Used to correct image astigmatism. The crosshair cursor indicates the 
actual stigmator setting. 
Click in the 2D X-Y control. The hand cursor appears onscreen. 
• Move the mouse left to right to modify the X-stigmator. 
• Move the mouse up and down to change the Y-stigmator. 
The stigmator range is coupled with the magnification. When the 
stigmator has been adjusted correctly, release the left mouse button. 
The position of the cross in the reserved adjustment area updates. You 
can also use the Shift + right mouse button for stigmation.
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Beam Module Right-Click Menu

Right-click over the 2D X-Y control to access a context menu. The 
menu may contain less or some other functions that are actually 
available for the particular parameter. Selecting the corresponding 
menu item activates the function.   

Beam Shift 2D control Allows you to change the beam shift setting. It is useful for fine imaging 
shifts without stage movement.
The crosshair indicates the actual setting of the beam shift. Click in the 
2D X-Y control. The hand-cursor appears onscreen. 
• Move the mouse left to right to modify the X-direction. 
• Move the mouse up and down to change the Y-direction. 

Table 4-6 Beam Module Right-Click Menu overview

Menu Selection Description

Coarse Sets the mouse sensitivity to coarse, where a long mouse path is 
necessary for the full range.

Normal Sets the mouse sensitivity to normal, where a normal mouse path is 
necessary for the full range.

Fine Sets the mouse sensitivity to fine, where a short mouse path is 
necessary for the full range.

Adaptive Sensitivity Sets the mouse control response to be the same at any magnification.

Zero Returns the control value to zero and the cursor to the center of the box.

Clear Memory Clears condition values that have been remembered automatically 
during the considered 2D control use. These remembered values are 
used to estimate new values that have not been remembered yet.

Auto Stigmator Starts automatic correction of an astigmatism. 

Reset Resets any mouse control setting to default. 

Table 4-5 Beam Module Overview (2 of 2)

Interface Item Description
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Beam Deceleration Module

Beam Deceleration applies a negative potential (stage bias) to the 
stage, which influences both primary and secondary electrons. It 
allows the deceleration of the primary beam to between 50 to 
4000 V landing energy. See “Beam Deceleration Mode” on page 202.  

  

Scan Rotation Module

Use the adjuster to set scan rotation. See also “Scan Rotation” on 
page 230.

Table 4-7 Beam Deceleration Module Overview

Interface Item Description

Stage Bias Applies the selected voltage to the stage. 
At stage tilt greater than 0°, do not go above 300 V.
Use the presets to simplify the use of beam deceleration. 
You can also select the predefined or custom stage bias presets directly 
using the databar. The databar selection only becomes active when the 
Beam Deceleration mode has been activated by clicking On.

On Turns stage bias on/off. 
• FIB imaging/patterning cannot be done when stage bias is active 

(On).
• The quick databar selection only becomes active when stage bias is 

active (On).
• EasyLift can not be inserted when stage bias is active (On).
• Stage Bias can not be enabled if EasyLift is inserted.

C
A

U
T

IO
N

Because of the proximity of the stage and column, electrical 
breakdown can occur, resulting in damage to the system and/or 
sample.
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This preset/continuous control adjuster gives access to set rotation 
angles as well as a variable angle values.

Detectors Module

Use the continuous adjusters in this module to change contrast and 
brightness. The values are remembered for each detector and 
display. The adjusters are disabled if the detector is not available 
or cannot be controlled, such as the CCD camera or an External 
detector.  

Regardless of the detector actual gain range, the contrast and 
brightness range is always 0 - 100 (%) and the small/large step size 
is 0.1/1 (the brightness step size may differ for some detectors in 
order to achieve a sufficient sensitivity). 

You can also double-click on the value shown within the adjuster 
to manually enter a value. 

See also “Working with Detectors” on page 171.

Navigation Page

The Navigation page contains the essential elements for stage 
navigation. The Stage module content varies with the different 
system types. 

Figure 4-16 Detectors Module

Table 4-1 Detectors Module Overview

Interface Item Description

Contrast Controls the contrast (electronic gain) of the active detector.
You can also Ctrl + click & drag the mouse from left to right to adjust 
contrast.

Brightness Control the brightness (voltage offset) of the active detector.
You can also Ctrl + click & drag the mouse up and down to adjust 
Brightness.
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Figure 4-17 Navigation page  

Stage Positions 
List +

See “Stage Z 
module” on 
page 119

See “Dynamic 
Focus module” 
on page 119

See below

Map Area

Stage Coordinates 
Edit Boxes

Coordinate Mode 
List Box
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Stage Module 

The module shows numerical values of a particular stage position 
and a list of saved positions for selection. In addition it shows the 
location of positions on the stage in a visual map form.   

Figure 4-18 Stage Module

Stage Positions List

Map Area
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Table 4-1 Stage Interface Items Overview (1 of 3)

Interface Item Description

Coordinate Mode 
drop down list 

• Actual mode (default): Shows actual position coordinates in the 
edit boxes. It is used by the Last Position. The Add, Update, and 
Remove buttons are active. The Go To button is inactive.

• Target mode: Activates when clicking a stored position or when 
editing a coordinate value. The Go To button becomes active; click 
it and the stage will drive to that location. The Add, Update, and 
Remove and buttons are active.

• Relative mode: Moves the stage by a given value and repeats it 
several times, if needed. It is used to make repetitive or equal 
movements in relation to a key point or points. The Add, Update, 
Remove, and Go To buttons are active.

Go To 
button 

Clicking the button causes the stage to go to the currently shown 
position (in Actual mode) or to move relative to the current position (in 
Relative mode). 
Shortcuts:
• Press Enter after editing any coordinate value. 
• Double-click a stored location to move the stage to the desired 

position immediately. 
During the stage motion, the Go To button changes to Stop, which 
stops the stage immediately.
Go To is disabled if the Last Position is selected in the location list; 
it is enabled in all other cases.

Compucentric Rotation 
check box

When the check box is ticked, the R coordinate operates as the 
Compucentric Rotation function and does not physical rotate the stage. 

Z-Y Link 
check box

When the check box is ticked and the stage is tilted, the system 
compensates for the observed point of interest shifting during stage 
move, which allows to make a Z-axis move with a tilted stage while 
keeping the point of interest in the field of view. This makes it much 
easier when imaging with electron beam at shorter working distances 
to accurately reach the eucentric position / beams coincidence (milling 
position). 
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Stage Coordinates Select a stage position from the stage position list. The numerical 
information of X / Y / Z / T / R axes are shown in the separately 
editable Edit boxes for the selected position. Enter target position values 
to drive the stage to; a tick in the box to the left of the axe indicates axe(s) 
to be moved. This functions irrespective of coordinate mode.
Use caution when setting the Z value:  

Editing a Coordinate
• Actual Mode: With the Last Position selected, deselecting the 

current position (so no position is selected at all) changes the mode 
to Target and disables the Update button. The Go To button is 
active. Check boxes become ticked.
To update any other position, enter new values in any of the edit 
boxes. This changes the mode to Target and enables the Update 
button (the position remains selected). Check boxes become ticked.
If no position is selected, the edit boxes can be filled and the mode 
changes to Target. The Go To button is active. Check boxes become 
ticked.

• Relative Mode: Editing a coordinate changes the mode to Target. 
The Go To button is active. Check boxes become ticked.

The units of measure follow the Preferences > Units setting, unless the 
Stage > User Units function is active, in which case UU is shown for X 
and Y. See “Defining User Units” on page 226.
By default all axes are unlocked. Any and all movements can be locked 
by clicking on the appropriate pushpin button. This is also graphically 
shown in the Status area as an closed lock. 
The software locks prevent 
inadvertent stage movement 
of selected axes during 
particular applications. The 
edit boxes for locked axes are 
disabled (grayed) and the 
stage does not move in these 
directions. Axes that are locked do not move when the Go To button is 
activated. When the stage movement is required in locked direction 
(trying to move to the stored position), a warning dialog appears. 

Table 4-1 Stage Interface Items Overview (2 of 3)

Interface Item Description

C
A
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There is a danger of hitting the pole piece! 
If the Link Z to FWD procedure did not pass, a red arrow next to the 
Z axis alerts the positive Z-axis stage moving direction is up. It 
means raising a value in the Z axis edit box causes moving the stage 
up towards the pole piece. 
After running the Link Z to FWD procedure, the symbol and the stage 
moving direction changes. The black arrow next to the Z axis 
indicates the positive Z-axis stage moving direction is down.
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Stage Location List Shows the list of stage locations and the Last Position, which is the 
stage position before any movement. 
• Double-click anywhere in the circle area to mark a new location 

and move the stage to it. The selected position becomes the current 
active position and it is highlighted in the list and also on the map.

• Clicking a nonselected item will select it, which causes the 
corresponding position to be shown in the edit boxes.

• Clicking a position when it is already selected will start inline 
editing of the item’s name (renaming it). Pressing Enter or clicking 
a different item confirms the new name. If the new name is already 
in the list, a warning is given and the editing is resumed (with the 
incorrect name). Pressing Escape restores the old name, cancelling 
the renaming.

• Double-clicking an item is the same as clicking it and then clicking 
Go To; it immediately moves the stage to that position.

• The list always contains the Last Position. Selecting Last Position 
shows the last stage position moved to and changes to this position 
can be updated as long as the Last Position item is selected.

• When the stage coordinates are edited manually, the selected 
position will be deselected if it is the Last Position, while for any 
other position Update will become enabled (and the item will 
remain selected).

Add Creates a new entry in the stage position list using the currently shown 
position. The new entry is called Position X, where X is 1, 2, 3, etc. If an 
item with the new X already exists, the value is incremental until a 
unique name is obtained. You can rename the new entry. Press Enter to 
rename the new entry.
Add is disabled in Relative mode (you cannot store a relative position), 
and enabled in Actual mode.

Update Stores the edited position under the currently selected name and 
position (overwriting the old position), without asking for 
confirmation.
Update is disabled in Relative mode. In Actual mode it is enabled only 
when a position is selected in the location list. 

Remove Deletes the currently selected item in the Location list. It is enabled 
when a position is selected in the Location list, but only if this position 
is not Last Position.

Remove All Removes all user created stage positions from the list.

Touch Alarm Enabled 
check box

When this check box is ticked, stage movement is stopped, and the 
Touch Alarm warning dialog appears whenever the stage or a 
conductive specimen touches the objective lens or any other equipment 
conductively connected to the chamber. This functionality is also used 
when the stage engines rise their power above a determined level. 

Table 4-1 Stage Interface Items Overview (3 of 3)

Interface Item Description
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Map Area

The map area represents the total range of the stage in X & Y axes. 
It shows the location of positions on the stage in a visual map. 
Click within the stage map area to drive the stage to the selected 
position. Positions can be stored in a file and contribute to a map of 
locations that can be reintroduced at a later date for re-
investigation of the same sample. 

Figure 4-19 Map Area Elements   

Table 4-1 Map Area Elements 

Number Function

1. Light gray rim (dashed line): physical limit of the stage movement 
along the X and Y axes

2. Dark rim (continuous line): the sample holder outline 

3. X / Y scroll bar: to move the map area at different magnification factors 

4. Magnification factor of the map area (1× – 100×) 

5. Stage rotation overlay: Chamber door / ETD / ICE / CCD camera 

6. Notch (black triangle): rotation marking (active control within the 
Radar view)

7. Radar view X / Y / Z (perpendicular lines): stage axes 

8.  Gray +: mechanical stage center: X = 0, Y = 0 

10

12

9

8

1

7

11

3

2

3

6

6

10

5

5

5

4

11

5
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Map Area Right-Click Menu 

Right-click in the map area to access the drop-down menu.   

9.  Blue +: map area center 

10.  Red + in a red circle / Red + (Radar view): actual stage position

11.  White × on a red background: a stored location (rotation noted by the 
black triangle) 

12.  Black  on a green background: a stored position selected 
(highlighted) in the location list) 

Table 4-2 Map Area Right-click Menu Overview (1 of 3)

Menu Selection Description

Add current stage position Adds the new stage position at the blue cross to the location list. In this 
way, the list can be compiled for particular applications. The blue cross 
turns black and receives a black circle around it. 
The Add button has the same functionality. 

Update to current stage 
position

Stores the (edited) coordinate values under the currently selected name 
(after confirmation in the overwriting dialog that appears). 
The Update button has the same functionality. 

Remove selected position Deletes the selected location(s) from the map and from the location list. 
The Remove button has the same functionality. 

Table 4-1 Map Area Elements 

Number Function
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Magnification Provides a submenu for selecting the map area magnification factor (8 
on the Map Area Elements illustration). The resulting multiple value is 
seen in the bottom right-hand corner of the map area. Scroll bars 
appear, if necessary, to move over the whole map area. 

Center view Brings the selected location to the center of view rather than the stage axial 
center. 

Auto center on target When selected and the Magnification factor is used, the active location 
remains in the center of view.

Show Radar View Shows The small circle in the top right of the stage area.  

It relates to the true rotational condition of the stage at any time.
By holding down the left mouse button on the black triangle on the 
perimeter of the circle and moving it around to another angle position, 
the stage will follow the action promoted on release of the mouse 
button. The large circle remains in the same state to represent true X 
and Y directions.
All positions that incurred rotation of the stage in their stored location 
maps will show rotation condition in the radar view when restored to 
the current position. Orientation is seen by the update of the small 
triangle and the clock hand lines in the radar view circle.

Zero Radar View Resets the stage rotation to 0°, that is represented by the black triangle 
12 o'clock position.

Stage location overlay Toggles the detector and chamber door position show in relationship to 
a sample. 

Show Notch on Map Shows the sample notch as a blue triangle on the perimeter of the stage 
map.

Table 4-2 Map Area Right-click Menu Overview (2 of 3)

Menu Selection Description
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Stage Z module

Moves the stage up and down with a speed based on the slider 
motion. Enabled when Z is linked to FWD.  

Dynamic Focus module 

The module contains controls to correct the tilted image. This 
functionality is different for the electron and ion beams. 

Figure 4-20 Dynamic Focus module (electron beam)   

Show Nav-Cam Image on 
Map

Switches the Nav-Cam image show in the map area. 

Show Stored Positions in 
Navigation Displays

Switches the stored positions show in navigation images. 

Table 4-1 Dynamic Focus module overview (1 of 2)

Interface Item Description

Dynamic Focus Tick the check box to switch Dynamic Focus on or off. 
When it is on, the scan slowly proceeds from top to bottom and the 
focus point is automatically changed according to the positive tilt of the 
specimen. The focus should be sharpest in the middle of the image, 
then the image should be sharp all the way from top to bottom.
Dynamic Focus can only be used with scan rotation at zero. You must 
enter Specimen Pre-Tilt for the calculations to be accurate. 
Dynamic Focus can be used for a strongly tilted specimen (either by the 
specimen surface itself or by stage tilt), when the depth of focus is not 
sufficient. It results in an image with overall sharpness. Dynamic Focus 
is usually used at low magnification and it works only in Mode 1. 

Table 4-2 Map Area Right-click Menu Overview (3 of 3)

Menu Selection Description
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Tilt Correction Tick the check box to switch Tilt Correction on or off. 
Because the image is a 2D representation of a 3D object, certain projection 
distortions occur. The more highly tilted the specimen is, the more 
foreshortened its image will be. Applying a tilt correction compensates 
for foreshortening in one direction on a flat specimen at a known tilt 
angle (80° range) and when the tilt axis is parallel to the scan line.
Tilt Correction can only be used with scan rotation at zero. You must 
enter Specimen Pre-Tilt for the calculations to be accurate. For example, 
a square grid image will appear rectangular when you tilt the 
specimen. Applying Tilt Correction will correct the aspect ratio and 
restore the square appearance.

Tilt Angle

Automatic Dropdown box for selecting tilt angle:
• Automatic: Applies an automatic operation of the Dynamic Focus 

and/or Tilt Correction. Use Automatic if the correction angle to be 
used is the same as the stage tilt angle (including Specimen Pre-Tilt, 
see below). When cleared, the Manual check box is enabled.

• Automatic (Cross Section): Sets to cross section.
• Manual: Enables the Manual linear adjuster (below).
All selections stretch the image based on the tilt angle.

Manual When selected, allows you to manually set the tilt angle from –90° to 
+90°. This is useful when the Dynamic Focus with Automatic Tilt Angle 
does not give satisfactory results (or cannot be used at all because the 
specimen is tilted in a direction different from the stage tilt. This check 
box is only enabled when the Automatic check box is cleared.

Specimen Pre-tilt Specifies a specimen pre-tilt for the Dynamic Focus and/or Tilt 
Correction calculations to be accurate. Enter the specimen tilt angle on 
the slider and then select an appropriate check box. If Tilt mode is 
Manual, the slider value indicates the absolute angle that should be 
used for the compensations (regardless of the actual stage tilt angle or 
specimen pre-tilt).

Table 4-1 Dynamic Focus module overview (2 of 2)

Interface Item Description
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Figure 4-21 Dynamic Focus module (ion beam)  

Table 4-1 Dynamic Focus module (ion beam) overview

Interface Item Description

Dynamic Focus Tick the check box to switch Dynamic Focus on or off. 

Surface Tick the radio button to 

Cut face 

Tilt Offet 
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Detectors Page

The Detector Settings page shows the available detectors and 
activates the mode selection and controls for imaging with the 
active detector. See “Working with Detectors” on page 171.  

Figure 4-22 Detector Settings Page

See “Detector Settings 
Module” on page 123

See “Enhanced Image 
tab Modules” on 
page 125

See “Digital Zoom 
Module” on page 124

See “Detectors Module” 
on page 110
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Detector Settings Module  

Use the controls in this module to choose the selected display 
detector and adjust its parameters.

The Detector list box contains list of detectors actually available for 
the selected display (the same as enabled items in the Detectors 
menu). The list box always shows the detector actually selected in 
the selected display.

The rest of the module dynamically changes according to the 
selected detector and its parameters, which may change from 
display to display.

See “Working with Detectors” on page 171 for information on specific 
detectors and procedural information.  

Table 4-1 Detector Settings Module Overview (1 of 2)

Menu Item Description

Detector Shows a menu of the detectors installed on the system and their 
associated modes. 
The active detector in a display can also be selected from the Detectors 
menu. See “Detectors Menu” on page 58.
When a retractable detector is selected, additional buttons appear for 
Insert/Retract, or it can be inserted if the CCD camera display is 
selected while on the Detectors page.  
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Digital Zoom Module

The procedure takes place in the computer memory only and helps 
to navigate across the enlarged view. It can be used on live images, 
still images for the electron beam, ion beam as well as the CCD 
Image. 

Mode Shows the available modes for the selected detector. Depending on the 
beam mode in operation, only the relevant detectors and mode will 
appear in the list. Mode options are:
• ETD, Electron Beam Mode 1: Secondary Electrons, Backscatter 

Electrons, Custom
• ETD, Ion Beam: Secondary Electrons, Secondary Ions, Custom 

See “ETD Settings” on page 173.
• TLD, Modes 1 & 3: Secondary Electrons, Backscatter Electrons, 

Custom
• TLD, Mode 2: Secondary Electrons, Backscatter Electrons, Charge 

Reduction, Down-hole Visibility, Custom. 
See “TLD Settings” on page 174.

• ICE, Ion Beam: Secondary Electrons, Secondary Ions, Custom. 
• ICE, Electron Beam: Secondary Electrons, Back-scattered Electrons, 

Custom. See “ICE Detector Settings” on page 175.
• STEM: Bright Field (BF), Dark Field (DF), High Angle Annular 

Dark Field (HAADF), Custom Annular, and Custom Angular. 
See “STEM segmentation” on page 183.

Custom Settings Moving the sliders while in any defaulted mode will switch the Custom 
mode into operation and the default condition will be overridden.
• Custom settings for ICE are Grid, Scintillator, and Converter. 
• Custom settings for TLD are Suction Tube Voltage and Mirror. 

Table 4-1 Detector Settings Module Overview (2 of 2)

Menu Item Description
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Enhanced Image tab Modules  

Consists of a series of tabbed sections offering various digital 
image enhancements.

Digital processing does not influence the original (raw) image 
stored in the image memory, and therefore can be modified or 
switched off (undone) completely at any time. Digital image 
enhancement can be applied to any detector image, including 
CCD, and also to paused or loaded images. In contrast to detector 
contrast and brightness functions, image enhancement functions 
are applied only the active display, independently from other 
displays’ settings. 

Table 4-2 Digital Zoom Module Overview

Interface Item Description

+ Enlarges the view in the selected display.

- Reduces the view in the selected display.

Green Bordered Area  Click and drag the green bordered area or click inside the green 
rectangle and move it by Ctrl + keyboard arrows to change an 
observed area in the selected display. 
Press the Ctrl + + / - keyboard button to enlarge / reduce imaging in the 
selected display. When the digital zoom is applied, the icon appears in 
the appropriate display.
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LUT Tab

The LUT (look up table) tab contains tools for monitoring and 
modifying graylevel distribution (histogram) of a grayscale image. 
The digital image processing defined in this section is the first one 
applied to the image (possibly after integration or averaging).  

Table 4-3 Enhanced Image Module Overview

Interface Item Description

LUT tab Contains tools for monitoring and modifying graylevel distribution 
(histogram) of a grayscale image. The digital image processing defined 
in this section is the first one applied to the image (possibly after 
integration or averaging). 

Mix 3, Mix 4 tabs In Mix detectors mode, display 3 can show a mixed image from 
displays 1 and 2 images and display 4 can show a mixed image from 
displays 1, 2 and 3 images. 

Color tab Use the Color tab to colorize a grayscale image. 

Process tab Use the Process tab to set parameters that adapt the image when 
clicking the Apply button, or when selecting the Tools > Image Post 
Processing (Ctrl + F7). 

Figure 4-23 LUT Tab Overview

Presets list box

Digital contrast

Gamma

Digital brightness

Graph window
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Table 4-1 LUT Tab Overview

Interface Item Description

Presets List Box Dropdown menu selects the digital contrast/brightness/gamma values 
at once using a predefined or custom preset.

Digital Contrast Continuous 
Adjuster

Sets contrast in a range from –10 to +10 (negative values lead to an 
inverse imaging). 

Digital Brightness 
Continuous Adjuster

Sets brightness in a range from –2.0 to 2.0. 

Gamma Continuous Adjuster Corrects image brightness nonlinearly in a range from –10 to +10.

Graph Window Shows (blue line) an applied modification. Original/modified values 
are on the horizontal/vertical axis. 

Histogram  Shows the gray-level histogram corresponding to the active display 
image. The left and right sides of the histogram correspond to 
black/white pixels in the original image, and the height of each red line 
is proportional to the number of pixels with the corresponding gray 
value. The LUT line on top of the histogram represents the combined 
user and system LUT.

Auto levels  Sets the digital contrast, brightness, and gamma parameters 
automatically according to the imaging/image quality.

Save  Saves the actual settings as the custom preset.

Default  Restores the default values.
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Mix 3 and Mix 4 Tabs

The Mix feature operates in displays 3 and 4 and are enabled only 
if Detector > Mix is selected for display 3 or 4. It uses the processed 
images (Average/Integrate, Digital Contrast, Digital Brightness, 
Digital Zoom), not the raw detector signals.  

Any combination of live and paused images can be mixed 
together, providing all mixed images have the same pixel 
resolution. However, there are some logical limitations and 
behaviors:

 The Average and Integrate filters are disabled. 

 Pause/Resume influences the mixed image only, not its 
sources. The Mix display is always paused immediately 
regardless of the actual scanning status. 

 The CCD image is not mixed.  

Figure 4-24 Mix 4 Tab Overview

Save

Presets list

Source adjusters

Invert check 
boxes

N
O

T
E In the Mix 3 tab the Source 3 controls and the Select 1+2+3 button are 

disabled. 
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Table 4-1 Mix 4 Tab Overview

Interface Item Description

Mix buttons
Select (1+2) / (1+2+3) 

Selects between displays 1+2 or displays 1+2+3 mixing modes.

Presets List Allows you to select the mixing ratios and colors using pre-defined or 
custom presets.

Source 1 - 3 Linear 
Continuous Adjusters

Tunes the mixing ratio of display 1–3 images. The value of each 
adjuster (0–100%) says how big a part of the resulting image composes 
the corresponding source image. Changing one source value 
automatically changes the other two values so that the sum of all source 
values is always 100%.

Color selection boxes Allows color selection, replacing the source image black (left)/white 
(right). The image grayscale is linearly transformed to a new color 
spectrum before it is mixed with other image(s).
Note: Color images (see Color tab) are converted to grayscale ones before 
mixing.

Invert check boxes Inverts the corresponding source image spectra. It has the same effect 
as exchanging the left and right colors selection.

Save Saves the actual setting as the custom preset.
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Color Tab

Use the Color tab to colorize a grayscale image. The tab will be 
disabled if an image is already colored with the use of the 
Mix 3/Mix 4 tab. It cannot be colored again.   

Figure 4-25 Color Tab Overview

Table 4-1 Color Tab Overview

Interface Item Description

Presets List Allows you to select the color profile using pre-defined or custom 
presets.

Coloring Control area Shows the active display image histogram and allows you to create a 
color profile. 
• Right-click in the histogram area to add the vertical borderline with 

a divided triangle on top.
• Right-click onto an existing borderline to remove it.
• Click and drag a borderline to change its position along the 

histogram. 
• Click on the left/right part of the triangle to select the left/right 

border color. The imaging grayscale between two borderlines is 
linearly transformed to a new color spectrum. 

Reset button Switches on/off the actual color settings for the active display image.

Save button Saves the actual setting as the custom preset.

Presets list

Coloring control 
area
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Process Tab

Use the Process tab to set parameters that adapt the image when 
clicking the Apply button, or when selecting the Tools > Image 
Post Processing (Ctrl + F7).    

Figure 4-26 Process Tab Overview

Table 4-1 Process Tab Overview

Interface Item Description

Presets List Selects how much denoising and sharpening you want to use. 
Selections are: None, Standard, Custom 1, Custom 2, and Custom 3.
The defined presets can be recalled later to process an image.

Denoising Strength Removes dust and scratches from the image. 
Choices are 0, 1, 2, 3, or 4.

Sharpening Strength Influences the image sharpness. Choices are 0, 1, 2, 3, or 4.

Apply Applies the changes.

N
O

T
E This functionality works only with grayscale images (not colored via the 

Color tab) that are paused or with loaded saved ones.

Presets list
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Patterning page

Use the Patterning page for milling, depositing, and etching a 
pattern onto the sample surface with the beam and for controlling 
the gas injection systems (GISs). The similar Rocking Polish page 
offers additionally controls for polishing of milled areas. 

For operational details, see “Patterning” on page 248. 

Figure 4-27 Patterning page / Rocking Polish module  
See below 

See “Gas Injection 
module” on page 303

See “Fast iSPI Mode” 
on page 264 

See “Properties Tabbed 
Module” on page 256 / 
“Selective Mill tabbed 
module” on page 263
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EasyLift Page 

The EasyLift module is only present with the EasyLift 
NanoManipulator (option). 

See chapter EasyLift for more detailed information.  

Figure 4-28 EasyLift Module 
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Direct adjustments page 

The Direct Adjustments page shows separate control modules for 
electron and ion beams settings. Ion beam control is available only 
for accelerating voltages below 8.06 kV. 

Ion Beam Settings   

Figure 4-29 Ion Beam Settings

Table 4-1 Ion Beam Settings Overview

Interface Item Description

Beam tab 

Quad 2D control Minimizes the objective imaging shift during focusing.

L2 Modulator Starts automatic L2 voltage oscillation (periodically under- and over-
focuses imaging in a narrow range) to facilitate the process. Try to bring 
the rotation center to the screen center (if the magnification is too high, 
the rotation could seem like a linear motion instead of a rotation).

Amplitude Slider sets the modulation amplitude.

Stigmator Balance tab 

Stigmator Sin/Cos 
2D controls

Sets the astigmatism lenses to bring the beam into the center. The 
crosshair indicates the actual stigmator setting, which minimizes 
imaging shift during astigmatism correction.
Clicking anywhere inside the 2D control changes the cursor to 4-ended 
arrow and moves it to the screen position corresponding to the actual 
stigmator value (minimum in the middle of the screen and maximum at 
the edges).

Modulator Sin/Cos Starts modulation of stigmator lenses in X/Y axis.

Amplitude Slider sets the modulation amplitude.
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Electron Beam Settings 

Figure 4-30 Electron Beam Settings   

Table 4-1 Electron Beam Settings Overview (1 of 2)

Interface Item Description

Beam tab 

Source Tilt Corrects an imaging illumination drop by changing an effective angle 
of the beam coming from the gun area into the electron column.

Crossover The imaging shows the electron source tip instead of the sample 
surface.

Crossover Zoom Slider sets the crossover image magnification.

Lens Alignment Minimizes the objective imaging shift during focusing. The 2D control 
indicates an actual beam position setting relative to the final lens 
aperture.

Lens Modulator  Dropdown list includes:
• Lens Modulator: Starts automatic objective current oscillation 

(periodically under and over-focuses imaging in a narrow range) to 
facilitate the process. Automatically selected when the accelerating 
voltage is > 3 kV.

• HV Modulator: Starts automatic accelerating voltage oscillation 
(periodically under and over-focuses imaging in a narrow range) to 
facilitate the process. Automatically selected when the accelerating 
voltage is < 3 kV.

Try to bring the rotation center to the screen center (if the magnification 
is too high, the rotation could seem like a linear motion instead of a 
rotation). 

Amplitude Slider sets the modulation amplitude.
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UC Centering 
Only available for the 
Helios G4 PFIB UX 

Centers the UC beam through the U-mode aperture.

Stigmator Centering tab 

Stigmator Center X / Y Sets the astigmatism lenses to bring the beam into the center. The 
crosshair indicates the actual stigmator setting, which minimizes 
imaging shift during astigmatism correction.
Try to bring the rotation center to the screen center (if the magnification 
is too high, the rotation could seem like a linear motion instead of a 
rotation). 

Modulator X / Y Starts modulation of astigmatism lenses in X/Y axis to enable stigmator 
center procedure.

Amplitude Slider sets the modulation amplitude.

Table 4-1 Electron Beam Settings Overview (2 of 2)

Interface Item Description
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Sample Preparation Page

The Sample Preparation page is a combination of parts of the 
Patterning page, Beam Control page, and Navigation page. Use it 
for sample preparation, especially TEM sample preparations, to 
reduce the number of mouse clicks.  

Figure 4-31 Sample Preparation Page
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Alignments Page

The Alignments page is used to align the columns and determine 
fine tuning for the system. 

Figure 4-32

The software stores column parameters such as Gun Tilt X, Y, Gun 
Shift X, Y, and other data that ensures minimum image shift when 
focusing and stigmating images. 

See the Chapter Alignments for information on the complete list of 
alignment procedures.
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Preferences 

Select Preferences from the Scan or Tools menu or press Ctrl + O 
to access the Preferences pop-up window. The Preferences dialog 
consists of sections listed at the left side of the window, the menu 
from which it is chosen dictates the section opened on entry.

Clicking the required section opens it and allows changing and 
presetting conditions for a group of the related functions. Only one 
section can be opened at any time. The items chosen and changed 
remain valid (for a specific user) until changed again. 

Some of the preference controls are beam dependent. In this case, 
an active beam type is indicated by the corresponding icon and 
items change accordingly. 

Movie section

This section provides two groups of controls: 

 Timer to set up the movie frame rate 

 File to set up the path name and format of the resulting movie.

For procedural information, see “Recording Movies (Multiple Image 
Capture)” on page 211 

Figure 4-33 Movie Preferences  
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Presets Section 

Use this section to change the preset values in the High Voltage, 
Magnification, EasyLift (option) and Stage dropdown lists. The 
electron and ion beams have separate preset lists.

Click the Add button, add new value and confirm the entry; the 
new value is sorted into the list. Click the Delete button to delete 
selected value. 

The Default button on each tab sets the factory presets values.   

Figure 4-34 Presets Preferences 
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Alignments section 

Use this section to select frequently used alignments from the lists. 

Figure 4-35 Alignments Preferences  

Table 4-1 Presets Settings overview

Interface Item Description

High Voltage High voltage values must be entered in kilovolts (0.2 kV = 200 V). 

Magnification The Magnification list can be changed to hold frequently used 
magnifications. Magnification values that are in the list but do not 
apply because of the working distance condition will be grayed out in 
the Magnification menu. 

EasyLift Sets the EasyLift operation preset values: 
Jog Speed – the constant velocity to use in Jog moves 
Step Size – the relative step size to use in Step moves 
Rotation Step – the rotation step size in degrees for Step moves 

Stage Sets the Tilt and Rotation presets in Absolute or Relative values. 

Alignments selection lists
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Magnification section

Use this section to choose setup conditions for screen 
magnification and for file output and printing. Tick the check box 
to synchronize the screen (viewing) format with the file/print 
(output) format. 

Figure 4-36 Magnification Preferences   

Table 4-1 Magnification Settings overview (1 of 2)

Interface Item Description

Screen Preferences Sets the imaging databar magnification show behavior.

File/Print Preferences Sets the storage/printing databar magnification show behavior

Real screens size: Handles the imaging pixel width. 

Active view Shows the magnification value for the active imaging mode: either 
Single or Quad Image mode. It is shown in the databar and 
stored/printed with an image with an icon representing the Single or 
Quad Image mode.

Single image mode / 
Single display mode 

Shows the Single image mode magnification value in the databar and is 
stored/printed with an image.

Quad image mode / 
4 display mode

Shows the 4-display image mode magnification value in the databar 
and is stored/printed with an image.
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Sensitivity Section

Set the sensitivity of the manual user interface (MUI) knobs 
separately for the electron and ion beams. 

Figure 4-37 Sensitivity Preferences  

Polaroid 5'' Handles the Polaroid 5'' film width. A recalculated magnification value 
is shown in the databar and stored/printed with an image. 

User device width Handles the User device width (set via the edit box). A recalculated 
magnification value is shown in the databar and stored / printed with 
an image. 

Keep Screen and File/Print 
settings synchronized

Keeps both settings identical.

Table 4-1 Magnification Settings overview (2 of 2)

Interface Item Description
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Scanning Section 

Use this section to change the dwell times (scanning speeds) table 
and to set up the Slow scan / Fast scan / Snapshot / Photo 
function for the ion and electron beams separately. 

Selections can also be made from the Snapshot Grid accessed from 
the dropdown arrow next to the Snapshot toolbar button. See 
“Photo / Snapshot” on page 88.   

Figure 4-38 Scanning Preferences 

Table 4-1 Scanning Settings overview (1 of 2)

Interface Item Description

Dwell time preset list Contains a fixed number of dwell time entries. Change selected preset 
values in the property editor on the right side of the module.
Slow scan, Fast scan, Snapshot, and Photo (different cameras) preset 
icons indicate the matching dwell time value. To change their values, 
move the icon up or down by clicking and dragging it to a new preset. 

Presets  Shows a list of selectable scan functions that can be edited in their 
unique property editor. 

Property 
editor

Presets

Dwell time 
preset list

Fast scan 

Slow scan 

Snapshot
scan
Photo 
scan
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Property editor: For different presets not all of following fields are present. 

Dwell Time The period of time during which the beam remains at the scanned 
point. The full range of dwell times indicated in the scan selection 
module (editable field).

Line Integration Number of line scanning repetitions. 

Resolution Sets the screen resolution. 

Line Time The line scan duration time. Indicates the full range of line times 
(informative and noneditable).

Frame Time Indicates the frame time (display scan duration time) as a result of 
dwell and line time (informative and noneditable).

Refresh Rate Shows imaging refresh frequency (informative and noneditable).

Integrate Shows a list of frames from 1 to 512 in steps: 1, 2, 4, 8, 16, 32, 64, 128, 
256, 512. This field is only editable for Snapshot and Photo.

Bit Depth Enables to sets the captured image bit depth (8 bits / 16 bits). 

Drift Correction Enables to correct imaging drifting when integration filter is active. 
When activated, the text below the blinking pause icon notifies a user. 

Continuous Scan When set to yes and the Snapshot / Photo function is started during a 
scanning, this scanning finishes and resulting image is acquired 
according to the preset. 
This functionality requires the same scanning conditions for the scan in 
progress and the Snapshot / Photo preset (Dwell time, Line integration, 
Resolution, Bit depth…). If they are not, the Application status warning 
message is shown. The functionality is convenient for charging samples. 

Action Shows a choice of Save, Save As, and None. The selection determines 
the result of either Snapshot or Photo, and whether the image is saved 
with a known label to a prelocation (Save) or if the user is prompted for 
a name and location (Save As). When None is selected, the image just 
remains onscreen. This field is only editable for Snapshot and Photo.

Display Enables to sets the display (1, 2, 3, 4) from which the image should be 
captured. 

Default Restores the default dwell time list and scan functions settings. 

OK Updates the system with any changes to the settings.

Cancel Returns to the original settings.

Apply Makes the chosen settings work immediately without updating the old 
conditions. They will work until the scan is changed or switched off.

Table 4-1 Scanning Settings overview (2 of 2)

Interface Item Description



User Interface    Microscope Control Software

146

Thermo Fisher Scientific CONFIDENTIAL, Limited Rights Data 

Pattern Applications section 

Use this section to change the visibility and order of patterning 
Application Files within the Properties module.  

Units section 

Use the Units section to change the units of measure, pressure and 
temperature. The choices affect the Stage module input boxes, 
display databar, and status module.  

Figure 4-39 Pattern Applications Preferences

Figure 4-40 Units Preferences
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Sounds section 

Use the Sounds section to set system sound notices for selected 
tasks.  

General Section 

This section contains a variety of user settings for both UI behavior 
and microscope operation. 

Figure 4-42 General Preferences    

Figure 4-41 Units Preferences
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Table 4-1 General Settings overview (1 of 4)

Interface Item Description

Category To make navigation among the number of preferences easier, they are 
divided into three groups: UI Appearance, Image and Graphics and 
Microscope Operation. 
Each item of the selected group is represented by a single line in the 
property editor. Click on the corresponding Value column to show a 
drop-down list with the settings available for that item.

UI Appearance • Image dimension controls: Choices are Magnification and HFW.
• Frame active display (Yes/No): 

Specifies that the active display have a blue outline.
• Enable zooming on mouse click-and-drag (Yes/No): 

Set an option of mouse zooming. 
• Switch sample tracking on mouse wheel click (Yes/No): 

Switches the tracking movement control linked to the mouse wheel 
between click-and-move and click-and-drag modes. 

• Pause stops immediately (Yes/No): 
Causes the Pause function to act instantly or wait for the scan to 
complete.

• Request confirmation when unpausing navigation (Yes / No): 
When releasing (unpausing) navigation imaging, confirmation 
could be switched on / off. 

• Automatic EasyLift display control (Yes/No): 
When inserted, causes the overlay to show automatically.

• Show status message pop-ups (Yes / No): 
Switches the status messages pop-up on / off. 

• Open patterning page after pattern is drawn: When a pattern 
shape was created with the use of a toolbar icon and Yes is set, the 
patterning page activates automatically.

N
O

T
E

Some changes become visible after the next UI start.
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Image and Graphics • Restart average filter when magnification changes / scan rotation 
changes / beam shift changes / stage moves (Yes/No):
Yes is advised. If not, the image can remain with ghost impressions 
for some time. Restarting the average filter causes the imaging to 
blink and get noisier; on the other hand, the averaging slows down 
the imaging response to the changed parameter. 

• Blinking pause icon during image integration (Yes/No): 
Causes the Pause button to blink when scanning is paused. If Yes is 
selected, the blinking Pause symbol is shown in displays that are 
being stopped. Otherwise, the Pause symbol appears only after the 
image acquisition has actually stopped. 

• Show Recording Movie message (No, 1, 2, 5, or 30 seconds):
At the beginning of the movie recording, this message could be 
shown in the recorded displays for a selected time period. 

• Hide Rotation controls when not used (Yes/No): 
Hides rotation controls if rotation is not to be used in the 
application. Specifies if and when the on-image 
Scan/Compucentric Rotation control should be automatically 
switched off. 

• Show scan rotation in Camera displays (Yes/No):  
Shows the saved positions in any navigation image (Nav-Cam, 
Navigation Montage, Navigation Alignment).

• Show Stage Map in Navigation displays (Yes/No):  
Shows the saved positions in any navigation image (Nav-Cam, 
Navigation Montage, Navigation Alignment).

• Apply AutoLUT after ACB (Yes/No): 
• Apply AutoLUT after grab frame (Yes/No): 

These two preferences apply automatically image optimization 
after said functionality. 

• Save digitally zoomed image as (Entire image / Zoomed area):
Saves the digitally zoomed image as the zoomed area or the entire 
scanned area. 

• Show legacy scanning resolution (Yes/No): 
Shows old format screen resolutions in the toolbar drop-down list.

• Post Processing (None / Standard / Custom #): 
Select an image post processing preset to be applied. 

Table 4-1 General Settings overview (2 of 4)

Interface Item Description
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Microscope Operation • Interactive Databar (On/Off): 
Makes the image databar fields active when possible. 

• Scan Rotation Sensitivity (0.1/0.01): 
Sets the scan rotation value accuracy. 

• E-Beam Working Distance databar precision 
(0.1 millimeters / 0.1 micrometers) 
It is possible to set the precision of the WD setting. 

• Lower stage when venting the chamber (Yes / No): 
Specifies if the stage should automatically go to a low Z values 
when venting the chamber. This is a recommended (not default) 
setting, because it greatly diminishes the chance of hitting the pole 
piece when closing the chamber doors after mounting a higher 
specimen.

• Change magnification when pumping 
(No /Set to 100× /Set to 200×): 
Specifies whether the magnification for electron imaging should be 
automatically set to a low value when the chamber is being 
pumped (presumably after replacing the specimen). 

• Switch off CCD automatically (No/1 minute/10 minutes/
30 minutes /1 hour/2 hours/6 hours): 
Specifies if and when the CCD camera and infrared LED’s should 
be automatically switched off. The countdown starts when 
resuming the optical display and continues regardless of the 
operator activity. 

• Pause beam display when switching off HV (Yes/No): 
Pauses scanning when the beam high voltage is switched off.

• Use measured I-beam current for patterning (Yes/No): 
If yes, calculates the total patterning process time based on the 
actual measured ion beam current no matter what the nominal 
beam current value is for a selected aperture. This feature should 
prevent patterning inaccuracies caused by aperture wear. If the 
measured beam current differs from the nominal value by more 
than 20%, a dialog box appears to ask if you want to recalculate.

• Allow beam shift in Get mode (Yes/No):  
Enables/disables automatic use of Beam shift when a user requires 
very small point-to-point movements (Get moves at high 
magnifications). 

• Blank E / I -beam during long stage moves (Yes/No): 
Blanks the electron / ion beam during long stage moves to prevent 
sensitive areas of the stage or sample from coming into contact with 
the beam.

Table 4-1 General Settings overview (3 of 4)

Interface Item Description
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Microscope Operation (cont.) • Delete image data when user logs off (Yes/No): 
If Yes, any live and/or paused imaging in all displays is deleted 
when user logs off. 

• Reverse joystick movement (Yes/No):  
Normally the joystick movement direction corresponds to the stage 
movement, so the imaging moves in the opposite direction. This 
setting changes the stage response to the joystick movement 
direction. 

• Auto switch stage measurement system (Yes/No): Automatically 
switches the stage measurement systems off when they are not 
used. This prevents light from “leaking” out of the optical 
measurement system that may interfere with third party options 
such as EDS detectors.

• Optimized collection efficiency (Yes/No): 
If yes, the inactive (paused) SE detector is prevent from taking the 
SE signal from the active one. This is not recommended to use 
while patterning, because it can cause image quality decrease in SPI 
and iSPI mode.

• Retracted detector will be replaced with a standard detector 
(Yes/No): 
If Yes, retracted detector will be replaced with system standard 
one, if No, imaging will be replaced with the system message 
“Detector retracted”. 

• Chamber illumination (Yes / No) 
If Yes and the in-chamber Nav-Cam is installed, inner chamber 
illumination is on when the chamber is vented. 

• Show sample exchange window on pump/vent (Yes / No) 
When starting to pump or vent the chamber, the Sample exchange 
window opens automatically. 

• Venting valve opening time (value): 
Prolongs the venting time (default value is 300 sec) to eliminate 
residual vacuum that makes it impossible to open the chamber 
door or shortens the venting time. 

• Default display for Nav-Cam Image 
(Display 1/Display 2/Display 3/ Display 4/Active): 
Sets the default Nav-Cam imaging display. 

• EasyLift coordinates depends on bulk stage tilt (Yes/No): 
Coordinates of the corresponding stage depends on stage tilting 
towards the electron / ion beam. 

Table 4-1 General Settings overview (4 of 4)

Interface Item Description
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Entering Commands 
Enter commands by using the mouse or keyboard. It is possible to 
configure the shortcuts for the active user account (see “Keyboard 
(Shortcuts) customization” on page 51). 

Mouse Button Functions

The mouse buttons control imaging correction, selecting functions, 
scrolling magnification up/down, and moving the stage in X and 
Y with Track moves. Mouse buttons are activated by a click, right-
click or double-click or in conjunction with a key on the keyboard.  

Table 4-2 Mouse Button Functions (1 of 2)

Button Function

Click Makes a selection (arrow cursor).

Ctrl + click Selects a graphical item within an imaging area (adds another one to 
the selection)

Shift + click Pauses / releases all displays when clicking the toolbar Pause button.

Double-click • Activates the Get moves to move the selected stage position to the 
middle of the display (arrow cursor).

• Places the 4 mm marker.

Click & drag • Zoom In: Click and drag a selected area from upper left to lower 
right to zoom in magnification to fill the imaging area with the 
selection (selectable in Preferences).

• Zoom Out: Click and drag a selected area from lower right to 
upper left to zoom out magnification to fill the imaging area with 
the selection (selectable in Preferences).

Ctrl + click & drag left / right Adjusts contrast.

Ctrl + click & drag up / down Adjusts brightness.

Shift + click & drag Activates Beam Shift (hand cursor) while in active display.

Right-click & drag Focuses image (2-ended arrow cursor). Right-click and move the mouse 
to the left or right. Release the button to set the focus. 

Ctrl + right-click & drag Activates Lens Alignment (4-ended arrow cursor).

Shift + right-click & drag Activates stigmator control (4-ended arrow cursor). Shift + right-click & 
drag the mouse to the left or right (X stigmator), or up or down (Y 
stigmator) to correct. Release the buttons to finish.

Crtl + wheel-roll up / down Coarse Control. Moving the wheel up increases the magnification; 
moving it down decreases magnification. 

Shift + wheel-roll up / down Fine Control. Moving the wheel up increases the magnification; 
moving it down decreases magnification. 
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Dedicated Windows Keys  

Crtl + Shift + wheel-roll 
up / down 

Moving the wheel up increases the digital zoom magnification; moving 
it down decreases digital zoom magnification. 

Wheel-click & drag Electron/Ion imaging: activates the Track moves for joystick-like 
movement over the sample surface.
Optical Imaging in CCD display: activates the stage Z movement 
(stage tilt). Moving the mouse up or down moves the stage up or down. 
This can be seen live in display 4.

Ctrl + wheel-click & drag Optical Imaging in CCD display: activates the stage Z movement 
(stage tilt). Moving the mouse left increases stage tilt, moving the 
mouse right decreases stage tilt. This can be seen live in display 4.

Table 4-3 Dedicated Windows Keys (1 of 2)

Key Function

Enter Equivalent of OK in a dialog box.

Esc • Equivalent for the Cancel button.
• Stops the stage motion at that point.
• Cancels the drawing mode on Patterning, Measurement & 

Annotation or Text cursor. This is especially useful when working 
with EasyLift in control overlay mode. 

Note: During some procedures (e.g., Home Stage) use the software Cancel or 
Stop button.

Tab Steps between entry fields within a dialog box.

(Shift +) Arrows • In a list box, selects between items in a group.
• In an active display, activates Shift moves of the stage 

approximately 40% (80% without Shift) of the field of view (FOV) 
in the direction of the keyboard Arrow key.

Ctrl + Arrows Pan (shift digital zoom area) 80% of view in direction of arrow.

Ctrl + Alt + Arrows Moves Measurements, Annotations, or Pattern shapes by one screen 
pixel in the corresponding direction.

Alt (or F10) Use Alt in combination with a character (underlined characters in the 
menu items) to open the pulldown menu in the active application. For 
example, pressing Alt + M at the same time brings up the 
Magnification pulldown menu. 

Alt + Tab (Simultaneously) Use these keys to show the last used program. Continue to press the 
Tab key (while holding down the Alt key) and applications that are 
resident are shown one by one. When the application you want is 
shown, release the Alt key and it becomes active again.

Table 4-2 Mouse Button Functions (2 of 2)

Button Function
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Function Key Shortcuts

Function keys are located at the top of the keyboard and work 
either on their own or with Shift or Ctrl keys.  

Alt + F4 (Simultaneously) Exits the active application software or Windows operating system.

Del Deletes the selected text or items.

Keypad +/- Changes the magnification of the active display.

Ctrl Keypad +/- Digital zoom in /zoom out

Table 4-4 Function Key Shortcuts

Key Function

F1 Shows online documentation.

Shift + F1 Opens the Image Properties window.

F2 Starts (first press) /stops (second press) the Photo scan with the active 
beam.

Shift + F2 Starts (first press) /stops (second press) the Photo scan with the active 
beam from all displays with the same beam at once.

Ctrl + F2 Takes an Active Preset Snapshot from all displays with the same beam 
at once.

F3 Toggles the Videoscope on/off in the selected display.

Ctrl + F3 Toggles the Videoscope on/off in all displays.

Shift + F3 Starts the Home Stage procedure.

F4 Starts (first press) /stops (second press) the electron imaging Snapshot 
scan from a preset display. 

Ctrl + F4 Starts (first press) /stops (second press) the ion imaging Snapshot scan 
from a preset display. 

Shift + F4 Starts/stops the lens alignment procedure.

F5 Toggles between Quad Image or Single Image modes.

Shift + F5 Toggles the Center Cross show on/off.

Ctrl + F5 Toggles Large Image Window mode.

F6 Pauses/activates scanning.

Shift + F6 Toggles the alignment rectangle show on/off.

F7 Toggles between Reduced Area/Full Frame mode.

Table 4-3 Dedicated Windows Keys (2 of 2)

Key Function
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Specific Keyboard Shortcuts

Shift + F7 When iSPI is On during patterning, electron image is grabbed from the 
reduced area only. 

Ctrl + F7 Applies preset image post processing.

F9 Starts the Auto Contrast and Brightness procedure.

Shift + F9 Starts the Auto Contrast and Brightness procedure in all displays.

F11 Starts the Auto Focus procedure.

Shift + F11 Toggles the Display Saturation function on/off.

F12 Toggles the Compucentric Rotation tool on/off.

Shift + F12 Toggles the Scan Rotation tool on/off.

Table 4-5 Specific Keyboard Shortcuts (1 of 2)

Key Function

Ctrl + 0 (number) Moves the stage to X=0, Y=0.

Ctrl + A Selects all items.

Ctrl + B Toggles Beam Blank function on/off.

Ctrl + C or Ctrl + Insert Copies the selected item to the clipboard.

Ctrl + D Sets Default Parameters.

Ctrl + E Tilts the stage to 0° (E is for electron beam).

Ctrl + F Sets FWD to the aligned eucentric point.

Ctrl + G Resets the Z height based on the Cap-Probe training.

Ctrl + I Tilts the stage to 52o (I is for ion beam).

Ctrl + J Shows the EasyLift control in display overlay.

Ctrl + K Sets Spot mode scanning conditions.

Ctrl + L starts Link Z to FWD procedure

Ctrl + M Sets Full Frame scanning conditions.

Ctrl + Shift + M Shows the movie recording dialog box.

Ctrl + N Toggles Sample Navigation on/off.

Shift + N Starts to mill the next pattern line.

Ctrl + Shift + N Starts to mill the previous pattern line.

Ctrl + O (letter) Opens the Preferences dialog box.

Table 4-4 Function Key Shortcuts

Key Function
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Ctrl + P Opens the standard Print dialog box.

Shift + P Moves to the next pattern.

Ctrl + R Restarts the scan.

Ctrl + S Saves the image in the active display.

Ctrl + Shift + S Saves the images from all displays.

Ctrl + T Toggles between electron and ion beam imaging.

Ctrl + V or Shift + Insert Pastes the copied content from the clipboard at the cursor position.

Ctrl + X or Shift + Delete Cuts the selected content to the clipboard (copies and deletes it).

Ctrl + Y Redoes the last action.

Ctrl + Z Undoes the last action.

Ctrl + Shift + Z Starts the Take Nav-Cam Photo procedure.

Tab Steps among controls.

Ctrl + (Shift +) Tab Steps (backwards) among displays.

Ctrl + , Selects one step slower scan preset.

Ctrl + Shift + , Selects the preset slow scan.

Ctrl + . Selects one step faster scan preset.

Ctrl + Shift + . Selects the preset fast scan.

Ctrl + Shift + A Alternates between electron/ion scanning.

Ctrl + Page Up / Down Steps up / down through the control pages buttons for selection.

Ctrl + 1 / 2 / 3... Selects the control page by the button number sequence.

Ctrl + +/- Scales up/down the digital zoom imaging 2×.

+ Increases magnification 2×.

- Decreases magnification 2×.

* Rounds off magnification to the nearest whole number.

Ctrl + Arrows Moves the digital zoom area one screen pixel in the respective 
direction.

Ctrl + Alt + Arrows Moves the selected measurements, annotations, or patterns by one 
screen pixel in the respective direction.

Ctrl + Scanning Preset Button Takes an electron beam Snapshot of the active display only.
Note: The same keystrokes will interrupt the acquisition process.

Ctrl + Shift + Scanning Preset 
Button

Takes a snapshot from all available electron or ion beam displays 
(depending on the active beam) at once.
Note: The same keystrokes will interrupt the acquisition process.

Table 4-5 Specific Keyboard Shortcuts (2 of 2)

Key Function



157

User Interface   Entering Commands

Thermo Fisher Scientific CONFIDENTIAL, Limited Rights Data

Patterning Keyboard Shortcuts  

Table 4-6 Patterning Keyboard Shortcuts

Key Function

Ctrl + C Copies the selected pattern.

Ctrl + X Cuts the selected pattern.

Ctrl + V Pastes the pattern from the clipboard into the active display.

Ctrl + Alt + any Arrow key Moves the selected pattern 1 pixel in the direction of the selected arrow 
(left, right, up, or down). Used for its accurate positioning.

Esc Deselects the currently selected patterns.

Shift + N Starts milling the next line.

Shift + P Selects the next pattern for milling.

Ctrl + Shift + N Starts to mill the previous line.

(Shift +) any Arrow key • When in a list box, selects between items in a group. 
• When in an active display, activates Shift moves of the stage about 

40% (80% without Shift) of the FOV in the selected arrow direction.

Pause Starts/pauses/resumes patterning.

Ctrl + Pause Resets patterning.
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5 Getting Started

This chapter describes the essential parts of the system from an 
operational point of view. These procedures assume you have read 
and are familiar with the User Interface chapter, but provide ample 
cross-references and illustrations for the operator who likes to 
jump right in.

Be sure to take advantage of the cross-references throughout this 
chapter.

Topics include:

 “Starting the UI” on page 160
 “Guide to System Settings” on page 161
 “Beginning Your Session” on page 162
 “Preparing the Sample” on page 167
 “Obtaining an Image” on page 169
 “Working with Detectors” on page 171
 “Optimizing the Image” on page 187
 “Selecting Beam Conditions” on page 197
 “SEM Imaging Modes” on page 200
 “Capturing and Handling a Single Image” on page 206
 “Recording Movies (Multiple Image Capture)” on page 211
 “Importing and Exporting Files” on page 219
 “Stage Movement Limits ” on page 219
 “Moving the Stage” on page 221
 “Nav-Cam (In-Chamber Navigation Camera)” on page 232
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Starting the UI
Click Start UI in the Server dialog box to start the user interface. 
The splash screen shows while the software is loading.  

After the UI has loaded, log on as a designated user account name. 
A dialog box for loading your conditions appears and then you can 
proceed to start the sources and operate the system.

N
O

T
E Normally this login will be the same as the Windows login. And, If you 

are using the optional software on the support PC, the logins must 
match.
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Guide to System Settings

Operations Checklist

To ensure correct operation check the following list before 
continuing. After obtaining a preliminary imaging, you can then 
experiment with your own settings.

Table 5-1 Setup Conditions

Adjustment Electron Beam Setting Ion Beam Setting
Accelerating Voltage Select voltage relative to specimen type: 

• Low kV for surface imaging, beam-
sensitive samples and slightly charging 
samples

• High voltage for conductors, high 
resolution, compositional info 
(BSE, X-ray)

For example:
• Biological sample HV = (1 – 10) kV 

Metal sample HV = (10 – 30) kV 

• 30 kV for imaging, 
milling, depositing 

• 5 kV for cleaning 
• 5 – 10 kV for large 

field of view 

Beam Current around 100 pA at 30 kV around 100 pA at 30 kV 
Scan rate Fast scan (dwell time 0.1 – 0.3 μs) Fast scan 
Working Distance (FWD) Set the highest specimen point to 

approximately 4 mm, tilt to 0° (yellow mark 
in an optical display) and press Ctrl + F 
(set FWD to 4 mm function). 

Set the stage to the 
eucentric position and 
tilt to 52º.

Eucentric Position 4 mm 13 mm 
Magnification Set to lowest: from 50× to 200× Set to lowest: 

from 50× to 200×
Standard Detector ETD (SE) ETD (SE) 
Filtering Live Live 
Contrast and Brightness With contrast at minimum value, adjust 

brightness to just show a change in intensity 
to the screen. Increase the contrast to 
produce a reasonable imaging. 
Increasing brightness and decreasing 
contrast produces softer imaging and vice 
versa. 

See Electron beam 
setting 
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Beginning Your Session
Usually, the system remains on (with the electron column emitter 
on) but with the ion column LMIS off. High voltage (HV) is 
typically off for both columns.

Follow the steps below when beginning the first work session of 
the day. Throughout the day, the system stays on from session to 
session.

To begin your session:

1. Enter your name and password in the Login dialog box for 
Windows 7 accessed at startup. Start the application.

2. Open the Beam Control page. Make sure the conditions are set 
to those recommended above.

3. If a sample is not already in the sample chamber, insert one 
according to the directions for loading samples.

4. Click Wake Up if the System module indicates it is in Sleep 
mode. This takes up to 10 minutes depending on the previous 
state of the system.
This process will start the ion source and high voltages on both 
columns and open both column isolation valves.

5. The active beam is indicated by the icon in the Column 
module (in this case electron). Adjust the High Voltage slider 
to that required for the primary electron beam. By switching 
beams with the toolbar buttons, the Beam Control page will 
revert to the other beam (in this case ion) for adjustment to be 
made.

6. Focus the cursor in the active display and click Unpause on the 
toolbar and begin scanning with the electron beam.

7. Focus and stigmate the image using the mouse or MUI. Click 
the Link Z-FWD toolbar button to calibrate the physical 
position of the sample.

8. Set the eucentric position 
(see “About Eucentric Position” on page 164). 
Go to the Navigation page and set the Z value to 4 mm and 
click Go To. The illuminated area of the sample should now be 
close to the coincident height. To set the eucentric position 
correctly, locate a recognizable feature under the center cross 

N
O
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E

Link Z to FWD is very important. 
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of the electron beam in display 1. (Select Window > Center 
Cross to make it visible.)

Tilt the stage to 7° if the feature moves away from the screen 
center after tilting, adjust the stage Z-height to bring the 
feature back to the center of the screen. Using Ctrl + I to tilt the 
stage to 52°, again bring the feature to the center of the screen 
if it has moved after tilting. This will set the sample at the 
eucentric position.

9. Set the coincident point of the electron beam and ion beam. 
Focus the cursor in another display and click the Unpause 
toolbar button to release that display and begin scanning with 
the ion beam. Control the contrast and brightness from the 
Detector module found on most pages. Focus and stigmate the 
image via the mouse or the MUI. Use the ion beam Beam Shift 
control to bring the same feature to the center of another 
display. Now the electron beam and ion beam meet in the 
same point; this is the coincident point. 

At this point you will be able to image with the electron beam in 
one display and the ion beam in another display at the eucentric 
position, 52o tilt. Use the electron beam for searching the area of 
interest and the ion beam for milling and deposition.
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About Eucentric Position

Establishing the eucentric position is an important part of setting 
up a sample for observation or modification. Eucentric position 
should be adjusted after loading any new samples as the load 
procedure clears all height information. 

The coincident point is where the stage tilt axis and the ion and 
electron beam axes intersect. At this point, no matter which 
direction the stage is tilted or rotated, the feature of interest 
remains focused and almost no image displacement occurs.

When you have a feature of interest at the coincident point, you 
will be able to use the different system components, such as the 
GIS and EDX, in a safe and optimal way.

Finding eucentric position on the system is the process of 
positioning the sample so it is at the coincident point.  

Figure 5-1 Understanding Eucentric Position  

N
O

T
E The eucentric position adjustment is not necessary for electron 

imaging of non-tilted samples. However, you still must run the Link Z to 
FWD procedure.
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Sample Top Surface Positioning 

The distance between the observed sample and the stage rotation 
head surfaces must be properly set to bring the stage to the 
eucentric position. This procedure also prevents the specimen to 
touch the final lens when moving the stage in the Z-axis direction.

With the standard specimen holder it is possible to move the 
sample (its top surface) along the Z-axis up / down if required 
(holder movement). This allows a flexibility to load large height 
specimens onto the stage. 

1. Load a specimen onto the specimen holder. 

2. Adjust the Z so that the highest specimen point is 
approximately 4 mm below the lens. 

3. Close the chamber and pump it down.

4. Switch on the beam, focus the specimen top surface and run 
the Link Z to FWD function. The FWD is now recognized by 
the system as the Stage module, Coordinates tab Z value. 

The Z coordinate can now be changed via the software Z control 
around the eucentric position and further, but not less than 1 mm 
from the lens for safety reasons. 

Setting the Eucentric Position
1. Apply the Stage > Auto Beam Shift Zero function.

2. Show the Window > Center Cross (Shift + F5). 

3. Focus an image. Link Z to FWD and go to 4 mm WD. 

4. Set stage tilt to 0°. 

5. Using the Z-control, coarsely focus the image. 

6. Set the magnification to 1 000×, find a recognizable feature, 
and center it under the yellow cross by moving the stage.

7. Watching the feature, change the stage tilt to 10°. Using the Z-
control, bring the feature back under the cross.

8. Change the stage tilt to –10°, and bring the same feature back 
under the cross using the Z-control.

9. Change the tilt to 0°. The feature should not shift significantly. 
If the shift is > 5 μm, repeat steps from 6 to 9. 
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Beams coincidence setting procedure 

The electron and ion columns are mounted as illustrated in the 
following figure, which shows the stage tilted to 52°. Beams 
coincidence occurs ideally at the eucentric position, but in fact it is 
shifted in the order of tens of μm. 

Figure 5-2 Relationship of the Electron vs. Ion columns  

The following procedure brings your stage to the beams 
coincidence; it is assumed that your stage is at eucentric position 
and that both beams are on:

1. Select the Electron Beam from the toolbar Beam selection 
menu.

2. Tilt the stage to 52°.

3. While imaging with the electron beam, and at 1 000× 
magnification, find a distinct feature and move it under the 
center cross by moving the stage.

4. Select the Ion Beam from the toolbar Beam selection menu.

5. Using image shift, bring the same feature back under the 
center cross.
If you cannot align the two images, recheck the eucentric 
position with the manual procedure.

Making a Test Pattern

Make a test pattern with a simple pattern using the ion beam and 
then observing it with the electron beam to see that it has correct 
beams coincidence.

N
O

T
E

After aligning the two 
beams, avoid using 
beam shift with the ion 
and electron beams.
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Ending Your Session

When you are done with your session, log out, leaving the system 
ready for the next operator (see “System states” on page 27) 

Preparing the Sample
The sample material must be able to withstand a high vacuum 
environment without outgassing. It must be clean and conductive. 
Oil, dust, or other materials may cause sample charging or 
contaminate the chamber, which could hinder or even prevent 
evacuation.

Needed Tools and Supplies
 Tweezers
 1.5 mm hex wrench
 Prepared sample
 Specimen stubs and conductive adhesive material
 Class 100 clean room gloves  

Coated Specimen 

If the specimen is nonconductive (plastic, fibre, polymer or other 
substance with an electrical resistance greater than 1010 ohms) the 
specimen can be coated with a thin conductive layer. This 
conductive layer reduces beam stir due to sample charging and 
improves imaging quality. 

For successful imaging, rough surfaced specimens must be evenly 
coated from every direction. Biological, cloth and powder 
specimens may require carbon or other conductive painting on 
portions of the specimen that are hard to coat.

C
A

U
T

IO
N Store samples and sample holders in a dry nitrogen storage cabinet. 

Dust on samples can get drawn into the electron column, degrading 
imaging and requiring an Thermo Fisher Scientific customer service 
call to correct the problem. 

C
A

U
T

IO
N

Always wear lint-free clean room gloves when reaching into the 
specimen chamber to prevent leaving oils, dust, or other contaminants 
inside.
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Coating reduces beam penetration and makes the imaging sharper. 
It may mask elements of interest for X-ray analysis (thus the use of 
carbon for geological and biological specimens). 

For more information on specific preparation techniques, see 
Scanning Electron Microscopy and X-Ray Microanalysis, 2nd ed. by 
Joseph Goldstein et al., Plenum Press, New York, 1992.

Mounting a Specimen on a Holder 

Wafers and PGA devices have individual sample-mounting 
procedures. If you are using a wafer piece or other sample, attach 
the specimen to the specimen holder using any suitable SEM 
vacuum-quality adhesive, preferably carbon or silver paint. The 
specimen must be electrically grounded to the sample holder to 
minimize specimen charging. If you are using another way to 
mount a specimen, make sure the specimen is consecutively 
attached to the holder. 

N
O

T
E The sample holder is not directly grounded to the chamber ground 

because it is connected to the BNC feed allowing to measure the 
specimen current. 
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Obtaining an Image

Principles of SEM Imaging 

All scanning microscopes show with the same fundamental 
technique. The primary beam is scanned across the specimen 
surface in a regular pattern called a raster. Normally, this raster 
consists of a series of lines in the horizontal (X) axis, shifted slightly 
from one another in the vertical (Y) axis. The lines are made up of 
many dwell points and the time of each dwell point can be 
shortened or prolonged (dwell time). The number of points per line 
can be increased or decreased as well as the number of effective 
lines (resolution). The result is a picture point (pixel) array. Low or 
high resolution imaging can be obtained by changing these factors. 
The larger the pixel array, the higher the imaging resolution. The 
image is created pixel-by-pixel in the computer memory and 
shown on a monitor screen. 

The signal emitted by the specimen surface as it is illuminated with 
the primary beam is collected by the detector, amplified and used to 
adjust the intensity of the corresponding pixel. Because of this 
direct correspondence, the pixels shown on the monitor are 
directly related to the specimen surface properties. 

The raster consists of many (typically one million) individual 
locations (pixels) that the beam visits. As the beam is scanned, the 
signal emitted by the sample at each beam position is measured 
and stored in the appropriate digital memory location. At any time 
after the beam scan, the computer can access the data and process 
it to change its properties, or use it to generate an image.

Setup for Imaging with Either Beam

The following procedure assumes that the source is already on, the 
sample is at eucentric position, and the two beams are at the 
coincident point. 

1. On the Beam Control page for the active beam, click Beam On 
in the Column module to ramp up the high voltage.  
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2. Focus the cursor in any display, select Electron Beam from the 
toolbar, and click Unpause to begin scanning with the electron 
beam. An image will appear in the activated display. Focus the 
image with the mouse or MUI.

3. Click the Link Z TO FWD toolbar button.

4. Adjust the contrast and brightness with any of the following 
ways: 
 Auto Contrast Brightness toolbar button

 Tools > Auto Contrast Brightness

 F9 / Shift + F9  

 The separate adjusters on the Detector module on most 
control pages  

 MUI knobs

5. Adjust to a suitable magnification with any of the following 
ways: 
 Magnification list box on the toolbar

 Magnification slider on the Beam Control page  

 Keyboard + and – keys

 MUI knob

6. Correct the focus and astigmatism.
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Working with Detectors
The detectors installed on your system appear in the Detectors 
menu and Detector Settings list box. The accessibility is dependent 
on the system status.  

When a detector mode is selected, its acronym shows to the right 
of the detector name in the menu. In addition to the standard 
detectors available, there may be optional ones available for your 
system type.

Detector selections are tied to the choice of the active beam. The 
system always reverts to the last detector used for that beam in 
that display, reverting also the contrast and brightness to the 
settings last used.  

The ion beam has one active mode for milling and imaging. The 
electron beam has three modes, selected from the toolbar button or 
Beam > SEM Mode (see further). 
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Infrared CCD Camera 

Imaging obtained with this camera assists in overall sample and 
stage orientation by viewing the inner space of the specimen 
chamber (an optical display). 

It protects the objective pole piece and retractable detectors against 
collision when moving (especially in the Z-direction) or tilting the 
stage. IR LEDs are used to light the specimen chamber interior. 

Retractable Detectors Control 

When any retractable optional detector is installed on the system, 
the Insert/Retract button is added to the Detector Settings module 
to enable the equipment control while working in the optical 
display.  

Table 5-1 Detector Choices by Beam

Detector Ion Beam Electron Beam

ETD yes yes, in Mode 1

TLD-S yes yes, in Mode 1 / 2 / 3

TLD-B, TLD-C, TLD-D no yes, preferably in Mode 2 only, 
with magnifications > 1500×

ICE (optional) yes yes, in Mode 1

MD No Yes, in Mode 1 / 2 / 3 
Mode 2 recommended + Beam Deceleration 
(better signal : noise ratio), WD ? 4 mm 

ICD No Yes, in Mode 1 / 2 / 3 
Mode 2 recommended + Beam Deceleration 
(better signal : noise ratio), WD ? 4 mm 

DBS (ABS / CBS) No Yes, in Mode 1 / 2 / 3

Nav-Cam no no

CCD yes yes

Mix yes yes

STEM (optional) no yes, in Mode 1 / 2 / 3
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Everhart Thornley Detector

The Everhart Thornley Detector (ETD) is a scintillator photo-
multiplier type detector collecting electrons generated by the 
primary beam interaction with the specimen surface. It is 
permanently mounted in the chamber over and to one side of the 
sample.  

It works in Modes: 

 Secondary Electrons (SE) 
 Backscattered Electrons (BSE) 
 The Deceleration Mode is available, when it is on 
 Custom 

ETD Settings 
 For Secondary Electron mode, set the Grid Voltage to +250 V.
 For Backscatter Electron mode, set the Grid Voltage 

to –150 V.
 For a Custom mode, change the Grid Voltage with the adjuster 

in a range from –240 V to + 260 V. When the voltage is 
negative (use a range of –25 V to –240 V), secondary electrons 
are repelled from the ETD detector and only backscattered 
electrons are detected. 
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Through Lens Detector 

The Through Lens Detector (TLD) is primarily designated to high 
resolution imaging in the Mode 2: Immersion (UHR).  

It works in Modes: 

 Secondary Electrons (SE) 
 Backscattered Electrons (BSE) 
 Custom 

TLD Settings

Suction Tube Voltage

The Suction Tube Voltage adjuster modifies electron collection. 

 When the voltage is negative, low energy secondary electrons 
are repelled from the TLD detector and only backscattered 
electrons are detected. 

 When the voltage is positive, low energy secondary electrons 
are collected by the TLD detector. The Suction Tube Voltage 
capability is from –150 V for only backscattered electrons to 
+150 V for secondary electrons collection. 

Mirror

The Mirror adjuster deflects the acceleration path of the secondary 
electrons into the detector in Secondary Electrons mode. It can also 
be used to convert high energy backscattered electrons to 
secondary electrons in Backscatter Electron mode.

N
O

T
E When using the FIB Immersion utility, the Custom Mode Suction Tube 

Voltage for electron imaging is copied to the Custom mode for ion 
imaging. 



175

Getting Started   Working with Detectors

Thermo Fisher Scientific CONFIDENTIAL, Limited Rights Data

ICE Detector

The ICE is a charged particle detector mounted near the end of the 
ion column. It collects secondary ions (SI) or electrons (SE, BSE) to 
form an imaging signal.  

The Electron beam and Ion beam imaging (distinguished by the 
beam icon in the module header) have different Modes. 

Electron beam modes: 

 Secondary Electrons (SE)
 Backscatter Electrons BSE)
 Custom 
 Deceleration Mode – available, when the Deceleration Mode is 

on

Ion beam modes: 

 Secondary Electrons (SE)
 Secondary Ions (SI) 
 Custom 

ICE Detector Settings 
 When changing any of the adjusters, the Custom mode is 

activated for any beam, allowing values to be changed. 
 The Grid continuous adjuster: Positive voltage for SE imaging, 

negative voltage for BSE and SI imaging. 
 The Converter continuous adjuster: 0 for SE and BSE imaging, 

negative for SI imaging.

N
O

T
E Changing the beam current adjusts the detector contrast 

automatically. 
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ICE & ETD Collection Efficiency 

ICE and ETD detectors are both able to collect SE signal. In order to 
prevent the inactive (paused) SE detector from taking the SE 
signal, set the Preferences dialog > General tab > Optimized 
collection efficiency item to Yes. This provides more SE signal to 
the active SE detector. This is advantageous for common imaging 
but it is not recommended to use while patterning, because image 
quality decreases in SPI and iSPI mode. 

Mirror Detector (MD)

The MD collects BSE signal which energy distribution differs from 
the BSE signal of TLD. It can work independently on TLD, so 
simultaneous BSE and SE imaging is possible. With the Beam 
Deceleration mode ON, the detected signal consists of a mixture of 
BSE and SE whose characteristic differs according to the 
microscope settings. 

In general MD has better Signal to Noise ratio with longer 
acquisition time (dwell time > 1 μs) as it is the Solid state detector.  

In-Column Detector (ICD)

The ICD detects BSE, which are scattered close to the electron 
beam axis when the Beam Deceleration mode is off. It provides 
high Z-contrast signal. With the Beam Deceleration mode ON, the 
detected signal consists of a mixture of SE and BSE whose 
characteristic differs according to the microscope settings. 

The ICD has better Signal to Noise ratio at WD ? 4mm with longer 
acquisition time (dwell time > 1μs) as it is the Solid state detector.  

N
O

T
E

Large changes to the custom conditions on biased detectors (such as 
the ETD and the ICE) could cause beam shift, which in turn affects the 
beams coincidence. Therefore it is not advisable to change custom 
conditions while patterning (if beams coincidence is affected, run the 
Beams coincidence setting procedure (see above) before a patterning 
starts).
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Directional Backscattered Detector (DBS) 
Angular Backscattered Detector (ABS) 
Concentric Backscattered Detector (CBS) 

The Directional Backscattered Detector (DBS) uses either 
angular (ABS) or concentric (CBS) segmentation of the detector 
diode. The control and settings of the two variations are the same.

It is mounted on a retractable arm that can be inserted between the 
lens and the sample and it is parked to the pole piece to reduce 
vibration.  

CBS Detector Settings 

The CBS distinguishes between BS electrons scattered close to the 
beam axis – inner segment (preferentially compositional contrast) 
and electrons scattered far from the beam axis – outer segment 
(more topography signal). 

Click one of the radio buttons to select the required mode: All (all 
segments), A, B, C, D, or Custom.  

Figure 5-3 Directional Backscattered Detector

N
O

T
E The DBS is an optional 

detector.
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Custom mode is used to define the segments to be used for detecting. 

 Clicking the + over a segment activates it (yellow color).
 Clicking – over a segment subtracts its signal (blue color).
 Clicking any sign twice disables the segment (gray color).

The Contrast button is accessible only when the CBS detector is 
selected in several displays. Clicking it sets the brightness and 
contrast of each display with CBS detector to the same level. 

Distribution of electrons collected by detector segments changes 
with the setting of working distance, lens mode, and Beam 
Deceleration mode.

It is also possible to set different concentric segments in particular 
displays and then use the Enhanced Image module > Mix 3 or Mix 
4 tab to mix color coded signals to create color images. (see “Mix 3 
and Mix 4 Tabs” on page 128). 

When the detector is retracted, the information text is shown in 
each display that uses it. 

Inserting and Retracting CBS Detector 

The following conditions must be met before inserting the 
retractable detector:

 Chamber is pumped.
 The stage must be moved to a safe position for inserting the 

detector. The Link Z to FWD feature must be done and the 
WD must be more than 2.5 mm. 

 The GISs (if present) must not be inserted. 

If the above conditions are not fulfilled, the Insert button is 
disabled, and a tooltip occurs when the mouse cursor is over a 
disabled Insert button. 

The detector will be inserted after the insertion is confirmed and 
the tilt is locked. The stage X, Y, and R movements have no 
limitations. The Z-axis movement is limited to 2.5 mm. 

Retracting the detector is automatic when the server is stopped or 
started and when venting the specimen chamber. Otherwise you 
can use the Retract button. 

N
O

T
E

Whenever the Quad BSED is selected, the optical display is paused 
(because the CCD camera infra-red LEDs are switched off not to emit 
the photons supersaturating the detector diode). 
The CBS limits the minimum achievable working distance, that is 
disadvantageous for high resolution imaging.
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DBS movement restrictions 

Because of the safety reasons the stage movements are strongly 
restricted when the detector is inserted. For experienced users 
these restrictions can be loosen by ticking the No stage restrictions 
check box. 

This functionality is released on request by the Thermo Fisher 
Scientific personnel.  

STEM Detector 

The STEM 3+ (Scanning Transmission Electron Mode) detector is a 
solid-state design divided into several circular segments. Each 
segment can be independently selected in the software, allowing 
imaging under different collection angles. It works best at a slow 
scan condition. 

There are several versions of the STEM detector, differing in 
geometry and the number of segments. The functionality and 
control is the same for all of these versions, but the contrast and 
information obtained can be different. 

Figure 5-4 STEM III detector  

W
A

R
N

IN
G

!
From this point on there is no limits when moving the stage. There is 
a risk of colliding with any hardware equipment within the chamber! 

N
O

T
E The STEM 3+ detector 

is an option. 
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The STEM 3+ detector is only used with the electron column 
operation in: 

 Mode 1 – used for navigation, with the ETD or TLD.
 Mode 2 – to collect high resolution images once the sample 

location is found. 
 Mode 3 – for collecting XEDS (X-ray Energy Dispersive 

Spectrometry). To get XEDS mapping, use the STEM BF. 

The signals collected by the detector segments are routed through a 
pre-amplifier, which can process several channels (segments) at 
once. 

The STEM 3+ detector controls are within the Detector Settings 
module. 

The STEM 3+ detector is a retractable device and after insertion 
remains stationary during stage moves in all axes. The X, Y, Z, and 
rotation axes of the stage provide sufficient angle of freedom and 
travel range to position the TEM sample grid at an optimal 
working distance along the axis of the electron column.

The signals collected by the detector segments are routed through a 
pre-amplifier mounted on an external wall of the vacuum chamber. 
The pre-amplifier has one channel dedicated to the Bright Field 
segment, one channel dedicated to the Dark Field segment, and one 
channel dedicated to the High Angle Dark Field segments.

Used with a Special Sample Holder

The STEM is mounted on a retractable arm. It must be used only 
with a special sample holder, oriented in an exact position 
monitored by the software.  

Installing the Holder 
1. Run the Home Stage (Shift + F3) procedure. 

2. Remove all sample holders from the stage plate. 

3. Screw the holder arm to the stage plate. 

N
O

T
E When the STEM detector is inserted to the chamber, the stage rotation 

and the tilt are locked automatically for safety. 
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Figure 5-5 STEM Detector Holder Arm HNL G3 UX  

Loading the Sample in a Row Holder
1. Place the row holder on the load base with the load base pin 

beneath the position you want to load in/out). Tighten the 
screw knob. The pin lifts up the spring. 

If the pin does not lift up the spring enough to put the sample 
in, adjust the lifting height by turning the screw. 

2. Insert a sample under the row holder spring. 

3. Release the screw knob and the entire row holder from the 
load base. 

4. Repeat steps from 1 to 4 to load in/out another sample. 

5. Attach the row holder to the arm.

Figure 5-6 Row Holder on Load Base / 
Row Holder Attachment into Arm  
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Inserting and Retracting the STEM Detector

Before inserting the retractable STEM detector, the chamber must 
be pumped, otherwise the Insert button on the Detector Settings 
control is not active (hover the mouse over the button to see a 
tooltip explaining why the button is inactive). 

When clicking Insert, a dialog box appears for the correct sample 
holder selection to enable detector insertion (the dialog appearance 
depends on the actual system configuration). When the stage is not 
in a correct position for insertion, another dialog appears requiring 
a confirmation of moving it to the safe position.  

The STEM is automatically retracted when the server is stopped or 
started or when venting the chamber. Otherwise, click Retract to 
retract it. When the detector is retracted, informational text shows 
in each display in which it is used.

C
A

U
T

IO
N

Do not perform any stage movement that could cause a collision with 
the STEM detector and damage it.
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STEM segmentation 

The STEM preset segmentations are available on the Detector page 
/ Detector Settings module (see “Detectors Page” on page 122).

When a preset is selected, the graphic on the module updates and 
the preset name is appended to STEM on the Detectors menu. 

The STEM 4 detector is user configurable by repetitive clicking on 
any segment, that changes its color with the meaning (for the 
Custom presets):

 Gray = disabled
 Yellow = enabled
 Blue = subtracted (negative) signal: The system takes an image 

of all of the enabled (yellow) segments and then subtracts the 
signal acquired from the blue segments.

Bright Field Imaging 

Bright Field (BF) is a single round segment that collects electrons 
that exit the sample with the lowest angular range of deflection 
from the incident electron beam.  
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Dark Field # imaging 

There are four Dark Field (DF) ring-shaped segments, concentric 
with the Bright Field detector. They collect electrons that exit the 
sample with a higher angular range of deflection from the incident 
beam than the Bright Field detector.  

High Angle Annular Dark Field

High Angle Annular Dark Field (HAADF) has six segments, 
represented in the graphic as a single segment. All six segments 
are turned on and off as a single unit.

This setting may require higher voltage to create a suitable image 
as the angle subtended to the detection diode can be wide. 
Choosing 2× the value used for Bright Field is a good start.  
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Custom Annular # 

Custom Annular # allows you to select any combination of 
segments to determine the best signal from a specific sample or 
region of interest within a sample. 

 Click the + inside a segment on the right side of the circle to 
enable (yellow) it. Click the enabled (yellow) ring again to 
disable (gray) it.

 Click the – inside an enabled segment on the left side of the 
circle to subtract (blue) the signal from the image.  

Some combinations of pre-defined (BF, DF1..DF4, HAADF) and 
Custom modes does not allow simultaneous imaging in all four 
displays.

If using more than one STEM signal in multiple displays, the total 
number of active segments is six. For example, if you are using 
4 active segments in display 1, then for simultaneous imaging in 
the other active displays, you can only select 2 more segments. 
This is due to the limited number of amplifier channels. 
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Custom Angular 

Custom Angular allows you to select any combination of the 
six segments in the outer HAADF ring to determine the best signal 
from a specific sample or region of interest within a sample. 

 Click in a segment to enable / disable / subtract it. 
 Click one of the arrow directional buttons to rotate all 

segments clockwise (CW) or counter clockwise (CCW).  

Using the STEM Detector
1. Optimize an imaging using the ETD or TLD detectors (focus, 

astigmatism correction, an accelerating voltage and a beam 
current selection, run Link Z to FWD, set contrast and 
brightness, etc.).

2. Select one of the STEM preset segmentations from the Detector 
Settings module. See “STEM segmentation” on page 183. 

3. Insert the STEM and respond to the confirmation dialog box 
that appears.

4. Select any SEM preset segmentation or set any custom option. 
Optimize an imaging at low magnification (focus, astigmatism 
correction, contrast and brightness, etc.). 

5. Change the accelerating voltage to suit the contrast necessary 
through the sample. 
After any accelerating voltage or beam current change repeat 
steps from 1 to 4. 

N
O

T
E

Custom Angular was 
previously called 
HAADF Partial 
Imaging.
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Optimizing the Image
Improve the image by changing scan speeds, contrast/brightness, 
focusing, stigmating, adjusting beam current, or adjusting 
magnification.

Scan Speeds and Filtering

To obtain good imaging it is necessary to find a balance between 
scan speed, charge, sample damage, and signal to noise ratio.

A noisy imaging can be improved by decreasing the scan speed. If 
charge or sample damage are the limiting factors, it is better to use 
a faster scan speed in combination with an Average or Integrate 
filter.

When imaging with integration, the image starts immediately with 
full grayscale, so you only see a decreasing amount of noise. An 
acquisition progress bar shows in the active display so you can see 
the number of frames being integrated.  
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Contrast and Brightness

The Detector module contains two logarithmic and two linear 
adjusters that allow you to change contrast and brightness by 
clicking and dragging the middle slider on the large bar, or the 
same on the pointer in the small bar.  

These adjusters always have a label in the upper left and value in 
the right corner as a readout value. You can change the Contrast 
and Brightness by input of the contrast and brightness numbers by 
double-clicking the readout and typing in the new values.

Correcting Contrast and Brightness

The contrast and brightness settings can be set manually either by 
using the MUI or by adjusting the contrast and brightness controls 
in the Detector module found on several pages. The following 
description will work for both methods.

1. Select a medium speed scan in an active display.

2. Reduce the contrast to zero and adjust the brightness to a level 
so that the last graylevel can be seen, by eye, before the screen 
goes black.

3. Increase the contrast so that the signal level shows an image.

4. If necessary, adjust the brightness level to improve the image.

Table 5-1 Contrast and Brightness Operation

Item Function

Middle slider For large or small adjustments, depending where you release it. The 
further from the center that the middle slider is pulled, the larger the 
change. This is logarithmic.

Gray bar For larger adjustments, single step increments.

End arrow For finer adjustments, single step increments.

Small slider For linear adjustment, continuous.
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Auto Contrast and Brightness

When the beam is unpaused, activate Auto Contrast and 
Brightness with the toolbar button, from the Tools menu, or click 
F9 / Shift + F9.  

The system will attempt a correction of the contrast and brightness 
levels to suit the sample so that the majority of graylevels are 
shown. When activated, a dialog box appears to show the progress 
of the function.  

The function can be interrupted by clicking on the Stop Now 
button. This will leave the image at the stage of progress at 
stopping. Clicking Cancel before the function ends will return the 
image back to its original status.

Using Videoscope (F3)

The Videoscope shows the video intensity along the currently 
scanned horizontal line for correcting contrast and brightness. This 
mode could facilitate contrast and brightness optimization to 
obtain full grayscale imaging level range.

Three yellow horizontal lines (placed over the display) indicate the 
following levels:

 White (top line)
 Grey (middle line)
 Black (bottom line)

The oscillogram signal amplitude/central position reflects a 
contrast/brightness of the just scanned line. 
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 If the oscillogram is cut by the bottom line, the signal level is 
clipped in black. 

 If the oscillogram is cut by the top line, the signal level is 
clipped in white. 

This should be avoided because the imaging details are lost in the 
clipped areas.

Tuning the oscillogram exactly between the top and bottom lines 
for a feature of interest (with the use of the reduced area) results in 
the full detailed imaging. The signal clipping may be used to 
obtain harder contrast conditions when more black and white is 
needed. The signal amplitude lowering decreases the contrast, i.e., 
the imaging looks softer.

1. Select a slow scan in an active display.

2. Activate the Videoscope (F3 or Scan > Videoscope).

3. Reduce the contrast to zero and adjust the brightness level to 
the lower dashed line (black).

4. Increase the contrast so that the signal level just touches the 
upper dashed line (white).

5. If necessary, adjust the brightness level once more so that the 
average signal level is roughly in the middle.

6. The high and low peaks should just touch the dashed lines.

To optimize contrast and brightness, also try using:

 Contrast/Brightness
 Auto Contrast Brightness (F9 / Shift + F9)
 Display Saturation (Shift + F11).

Focus

The easiest way to focus is to find a feature of interest on a sample 
with distinct edges. Use a combination of contrast, brightness, and 
magnification adjustments to maximize the image quality.

To avoid scanning too long with the ion beam and milling away 
the sample before you take the final image, move away from the 
feature of interest with the X and Y stage controls, and focus until 
the image is sharp on a adjacent area.

Focusing at 2× to 3× the magnification needed for the final result 
makes the lower magnification sharper. For example, for high 
resolution output, set the magnification level at 2 000× and focus at 
4 000× to 8 000×.
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Focusing with the MUI

You can also use the MUI Coarse and Fine focus knobs to focus the 
image. The image immediately responds to the MUI without a 
cursor onscreen.

Focusing with the Mouse
1. Hold down the right mouse button while the cursor is in the 

active display. The 2-ended arrow focus cursor will appear.

2. Move the focus cursor from side-to-side until the image is 
sharp. When engaged, the focus cursor is active over the whole 
screen but will not interfere with other controls

3. Move the specimen to a desired area with the X and Y stage 
controls and refocus until the image is sharp.

4. If this is the first time focusing the new specimen, click the 
Z to FWD toolbar button to confirm focal distance to the Z 
value on the Navigation page.

Using Reduced Area for Focus

When Reduced Area is chosen, the small green area frame appears 
in the middle of the screen. This can be used as a focus aid as the 
scan speed is faster in the smaller area. It can be activated from the 
Scan menu, the Reduced Area toolbar button, or by F7.  

By default, it will appear in the center of the display or screen.

Moving the Reduced Area 

Click and hold the left mouse button in the selected area. The 
cursor changes to a 4-ended arrow. This will take time, depending 
on the actual scan speed. Now drag the selected area to the desired 
position and release the mouse button.
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Changing the Size of the Reduced Area

Click and hold the left mouse button at the edge of the selected 
area. The cursor changes to a 2-ended arrow, either horizontal or 
vertical. Now drag the selected area out or in to the desired size 
and release the mouse button.

Making a New Reduced Area

Place the cursor outside of the selected area and make sure Get or 
Track moves are not activated. The cursor should be the normal 
arrow symbol. Move the cursor to where you want the left upper 
corner of the selected area to be. Click and drag the cursor until the 
rectangle onscreen includes the area you want to select. Release the 
left mouse button.

When the Reduced area frame is being manipulated it turns yellow 
until released, then it reverts to green.

Auto Focus

When the beam is unpaused, activate Auto Focus with the toolbar 
button, from the Tools menu, or by clicking F11.  

The system will attempt to correct the focus independent of the 
working distance or focus set. When activated, a dialog box 
appears to show the progress of the function.  

The function can be interrupted by clicking Stop Now. This will 
leave the image at the stage of progress at stopping. Clicking 
Cancel before the function ends will return the image back to its 
original status.



193

Getting Started   Optimizing the Image

Thermo Fisher Scientific CONFIDENTIAL, Limited Rights Data

Astigmatism

Astigmatism is an optical aberration is caused by different focal 
lengths for rays of various orientation, resulting in a directional 
imaging blur (X and Y rays are not focused to the same plane on 
the edges).

Correct astigmatism whenever you change the imaging conditions.

Stigmating with the Mouse

It is necessary to correct astigmatism of the image (also known as 
“stigmate”) when you change apertures, samples, or working 
distance. Astigmatism in the image is usually only visible at higher 
magnifications (3000× or more). If astigmatism is present, the 
result is a directional distortion change of 90° between the two out-
of-focus conditions. 

1. Focus the image as well as possible using the mouse.

2. Bring the image just slightly out of focus in one direction to see 
any astigmatic distortion.

3. Defocus in the other direction to observe a different astigmatic 
distortion.

4. Bring the focus to the midpoint between the two distortions.

5. Go to the Stigmator 2D control on the Beam module of the 
Beam Control page. Shift + right-click while in the active 
display. This will result in a 4-ended arrow cursor appearing 
at the center of the screen. Still holding the right mouse button 
down, drag the center of the cross around the screen to achieve 
astigmatism correction (when the image is at its sharpest).

6. When you are satisfied with the image, release the right mouse 
button.

7. If astigmatism is severe and the cross is close to the edge of the 
screen when nearing correction, release the right mouse 
button, and reposition the cross in the center of the screen.

Repeat this procedure to perform further astigmatism correction.

Stigmating with the MUI
1. Using the MUI focus knobs, bring the image just slightly out of 

focus in one direction to see any astigmatic distortion.

2. Defocus in the other direction to observe a different astigmatic 
distortion.

3. Bring the focus to the midpoint between the two distortions.
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4. Adjust image sharpness with the Stigmator X and Y knobs 
until the best image is achieved. The computer beeps when the 
stigmation limits are reached.

5. Repeat steps 1-4 as necessary.

6. If astigmatism is severe and the cross is close to the edge of the 
screen when nearing correction, release the mouse and 
reposition the cross in the center of the screen. Then repeat the 
procedure above to perform further astigmatism correction. 
You can use reduced area advantageously.

7. If astigmatism cannot be corrected, there may be some other 
reason, usually a dirty aperture, the magnification may be too 
high for the beam spot size, or the sample is charging (apply 
conductive layer).

Magnification

Magnification is the ratio of the viewing area on the monitor screen 
to the scanned area on the sample. 

Figure 5-7 Magnification definition  

If the size of the raster on the sample is made smaller while the 
raster on the monitor remains constant in size, the magnification of 
the image increases. 

 At low magnification, you see a large field of view. 
 At medium magnification, you see a portion of the original 

scanned area. 
 At high magnification, you are zoomed in on only a small 

portion of the original total scanned area.
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Changing Magnification

Toolbar List Box

Use the magnification settings from the toolbar dropdown list box 
to select from predefined values. If the current value is in the list, it 
is indicated with a colored background. 

1. Click on the toolbar list box to see the list of available 
magnifications.  

2. Click on the required magnification and it appears in the text 
box, and the dropdown list automatically closes. This can be 
done while the beam for the column is on, in which case the 
change is immediate. 

3. Enter a magnification value in the text box and then click Enter 
on the keyboard to replace the nearest magnification value in 
the list with the new one. It also becomes the current 
magnification value.

Keypad +/- Keys

You can also use the keypad +/- keys to change magnification. 

 Plus (+) increases the magnification 2×,
 Minus (–) button decreases the magnification 0.5×. 

Selecting a different magnification results in a change of 
magnification onscreen during live imaging.

Using the Mouse Wheel

You can also use the mouse wheel for changing magnification. 
Moving the wheel up decreases magnification and moving it down 
increases magnification. Coarse and fine control can be operated 
by the Ctrl or Shift keys. 
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Using Selected Area Zoom In/Out
 Zoom In: Click and drag a selected area from upper left to 

lower right (the cursor changes to a magnifying glass with a + 
sign) to zoom in magnification to fill the imaging area with the 
selection (selectable in Preferences).

 Zoom Out: Click and drag a selected area from lower right to 
upper left (the cursor changes to a magnifying glass with a – 
sign) to zoom out magnification to fill the imaging area with 
the selection (selectable in Preferences).

 Click Escape to cancel the operation at any time.

Magnification Normalized

The asterisk (*) key on the keyboard can be use to round off the 
magnification value before storing the image in case the value is 
odd, e.g., 10 063× would become 10 000×. The condition also takes 
into account the image size by zooming and the micron bar scaling.

Coupling Magnification

The Magnification module gives access to coupling the 
magnification of both beams at a particular magnification. The 
magnification is set with the slider and then locked by ticking the 
Couple Magnifications check box. The active beam icon is shown 
at the right side of the module.  

Direct Adjustments

Use the Direct Adjustments feature for fine-tuning of the beam 
geometry to achieve the best focus and brightness. It is available 
from the Direct adjustments page (see “Direct adjustments page” on 
page 134).

Table 5-1 Mouse Wheel Magnification

Key Function

Wheel up + Ctrl Decreases magnification; coarse control

Wheel up + Shift Decreases magnification; fine control

Wheel down + Ctrl Increases magnification; coarse control

Wheel down + Shift Increases magnification; fine control
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Selecting Beam Conditions

High Voltage and Beam Current

High voltage (HV) and beam current choices are shown for the 
active beam in the editable dropdown list boxes on the toolbar. 

 For the electron beam, high voltage and beam current are 
independent, so any change of voltage will not result in a 
change of beam current. 

 For the ion beam, the beam current available is dependent on 
the high voltage, for example at 30 kV the beam current is 
100 pA, however, the beam current reduces to 13 pA when the 
high voltage is set to 2 kV, even when the aperture position is 
the same.  

Changing High Voltage

Click on the text box to show the list of voltages. Click on the 
required voltage and it will appear in the text box. The dropdown 
list will automatically close. If the beam is on, the change will be 
immediate.

Default values are set within the Preferences dialog / Presets 
section (see “Presets Section” on page 140). Use the High Voltage 
slider on the Beam page to select other values.

Figure 5-8 Beam Current Values

Electron beam: Ion beam: 
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Changing Beam Current

Click on the dropdown arrow to the right of the text box to show 
the list of currents. Click on the required current and it will appear 
in the text box. The dropdown list will automatically close. If the 
beam is on, the change will be immediate.

 For the electron beam, deciding which beam current is correct 
for a particular magnification can be determined when you 
achieve good focus and astigmatism correction easily at the 
chosen magnification. 

 For the ion beam, choosing the correct beam current use is 
determined by the application.

Ion Beam Apertures 

In general, use a smaller aperture for high resolution and a larger 
one for faster milling.

For a complete alignment procedure for ion beam apertures, refer 
to “I-column: Aperture Lifetime” on page 343 and “I-column: 
Alignments” on page 344.

Optimal Ion Beam Currents

Use the following suggestions for choosing optimal ion beam 
currents.  

Table 5-1 General Optimal Ion Beam Currents

Beam Current Best Use

1.5 – 9.7 pA High resolution

28 – 48 pA Standard imaging

>93 pA Milling
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Ion Beam Diameters 

The ion beam diameter depends on its current (for the default 
aperture strip). For more specific applications, see the table below.  

Table 5-2 Specific Optimal Ion Beam Currents

Beam Current Best Use

1.1 pA • Very high-resolution imaging
• High aspect ratio holes
• High-resolution imaging
• Pt via filling

7.7 pA • Quick imaging
• Fast Pt via filling

24 pA, 40 pA • Navigation imaging
• Milling submicron holes
• Final milling on cross sections

80 pA • Milling micron-sized holes
• Intermediate/final milling on cross sections
• Short Pt strap deposition

0.23 nA, 0.43 nA • Milling micron sized holes
• Medium Pt strap deposition
• Intermediate milling on cross sections

0.79 nA • Initial milling for small cross sections
• Long Pt strap deposition

2.5 nA • Initial milling for medium cross sections
• Longer Pt strap deposition

9.3 nA • Initial milling for medium-large cross sections
• Pt probe pad deposition (40 μm × 40 μm)

21 nA • Initial milling for large cross sections
• Pt bond pad deposition (50 μm × 50 μm)
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SEM Imaging Modes
The electron column can be operated in three different final lens 
modes and in the Beam Deceleration mode. 

Final Lens Modes

Use the toolbar buttons or Beam > SEM Mode to switch between 
modes.

Mode 1: Field-Free

This is the default survey mode. This mode is essentially for 
navigating and reviewing sites at lower magnifications. In Mode 1, 
the immersion lens is switched off and the default detector is the 
ETD/TLD in Secondary Electron operation.

For navigation, use the Mode 1 with the TLD detector. Once the 
sample location is found, switch to Mode 2 to collect final results. 

Mode 2: Immersion (UHR) 

In this mode the immersion lens is switched on, and the default 
detector is the TLD in Secondary Electron operation. This mode is 
used to form ultrahigh resolution electron images of the sample. 

Use Mode 2 with the STEM detector in order to obtain high 
resolution images. 

If ion beam imaging is selected in Mode 2, the final lens is switched 
off to allow ion beam imaging to take place with the last selected 
ion beam detector.

Selecting Mode 2 also has its own Beam menu presets.

Lens Mode Switching

You can immediately switch from Mode 1 to Mode 2 if other 
conditions such as stage bias and working distances are within the 
normal operating range. If the system is at a magnification that is 
too small, the system will automatically switch to the lowest 
possible magnification in Mode 2 operation.

Mode 3: EDX

Mode 3 is used for analytical work, such as EDX, where the 
immersion lens is not so powerful as Mode 2 but can act as a 
electron trap for backscattered electrons to improve X-ray 
collection. 
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Mode 3 is used for collecting XEDS (X-ray energy dispersive 
spectrometry). To get XEDS mapping, use the STEM BF with 
Mode 3. 

This mode can be used with the ion or electron beam. Selecting 
Mode 3 also has its own Beam menu presets.  

Electron Source Modes

UC mode is available only for the Helios G4 PFIB UX.

UC On

Select Beam > UC On to turn on this mode.

 When UC On is selected: The UC mode maximum HV is 5 kV 
and maximum beam current is 100 pA. Electrons are supplied 
with the energy spread less than 0.2 eV, which improves 
image quality at low HV and low beam currents.

 When UC On is not selected: The Normal mode full system 
HV and beam current range is available.

UC Auto

Selecting Beam > UC Auto switches UC mode on automatically, 
when HV and beam current values are in the allowed range.

N
O

T
E If the EDX mode is not accessible (greyed), try to change 

a magnification so that the HFW < 600 µm. 
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Beam Deceleration Mode

The Beam Deceleration mode (BDM) is an option for some 
systems.

The Beam Deceleration mode (BDM) is based on a negative voltage 
stage bias applied to a stage (i.e., a sample). An electrical field 
between the sample and the nearest surface over (a column bottom 
or a detector) is formed, acting as the additional electrostatic lens. 

Detection Principles

The Beam Deceleration influences both primary and signal 
electrons. As the sample is at the negative potential according to 
the ground and detectors, the initial SE and BSE energy (when 
leaving the surface) is accelerated by the stage bias before the 
detection. The higher the immersion ratio, the lower the difference 
between SE and BSE energies when detected. Its power is 
described by the immersion ratio (imRatio) parameter: 

imRatio = (HV + bias) / HV

Signal electrons are accelerated upward and deflected toward the 
column axis. The SE have a low initial speed and they are usually 
absorbed into the detector central hole, equally like the BSE 
heading upright. Conversely, the BSE heading nearly parallel to a 
surface (which normally cannot be detected) are driven to a 
detector.

By changing the stage bias, an output angle distribution of 
electrons leaving a surface could be obtained.  

Figure 5-9 Typical Trajectories of Secondary (Red) and 
Backscattered (Green) Electrons
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Detectors most convenient for beam deceleration are BSE types 
placed closely under or directly inside the column. Their efficiency 
depends on their active area: the smaller the active area’s inner 
diameter the better. The standard ETD could also be used, but its 
efficiency is low.

Beam Deceleration Applications
 The BDM enables detection of the BSE when the electron 

energy is under the detection limit of the detector.
 The BDM expands the electron energy range under the 

minimum HV limit.
 The BDM improves the microscope resolution at low 

accelerating voltages. A conventional microscope resolution is 
limited by a chromatic aberration at low electron energies. The 
higher is the immersion ratio, the smaller the aberrations, and 
a loss of resolution at low electron energies is well 
compensated.

 The BDM enables the detection of electrons heading nearly 
parallel to a surface which accentuates a surface roughness.

Application Restrictions

Sample tilt causes an electrical field deformation, which adds 
aberrations (a chromatic aberration and an image distortion) that 
ar not correctable. An acceptable sample tilt is a few degrees, and 
less for higher immersion ratios.  

Figure 5-10 Signal Distortion and Image Aberrations for Tilted and 
Rough Sample (Tin Balls) at High Immersion Ratio
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Beam deceleration and EasyLift
 If Beam deceleration mode is active (Stage bias turned On), 

EasyLift can not be inserted.
 If EasyLift is inserted, Beam deceleration mode (Stage Bias) 

can not be enabled.

Beam deceleration mode imaging procedure
1. Put the sample into the chamber and pump.

In the BDM a sample becomes the electrode. Its position, size, 
tilt, and surface roughness influence an imaging quality. At 
optimal conditions the sample should be symmetrical, planar, 
have a size comparable with the detector size, and placed 
perpendicular to the column axis. In other conditions a 
distortion, an astigmatism and a blurring caused by the 
chromatic aberration appear. This is even worse when the 
immersion ratio is higher. 

2. Select the suitable HV and find an area of interest. Set the 
eucentric position and tune with the Beam menu > Lens 
Alignment and the Beam Control page > Beam 
module/Stigmator 2D control (“Beam Module” on page 107).  

3. In various displays select the SE and BSE to observe different 
imaging simultaneously.

4. Click On in the Beam Deceleration module (“Beam Deceleration 
Module” on page 109) and gradually raise the stage bias, The 
SE/BSE image is getting dark/light.  

C
A

U
T

IO
N

Because of the proximity of the stage and column, electrical 
breakdown can occur, resulting in damage to the system and/or 
the sample.



205

Getting Started   SEM Imaging Modes

Thermo Fisher Scientific CONFIDENTIAL, Limited Rights Data

At low magnifications, an ETD image should become dark 
symmetrically around the window center; in other cases, the 
sample could be tilted. When a dark area is shifted with a 
stage bias change, the sample is possibly not parallel with the 
detector. Use compucentric stage rotation/stage tilt to keep 
the dark are in the center of the screen.   

5. Set the stage bias considering the sample material (charging 
compensation, material contrast) and to optimize the signal. 
Set brightness, contrast, and WD according to the requirement.

6. Tune using the Beam menu > Lens Alignment and the Beam 
Control page > Beam module > Stigmator 2D control (both of 
which remember the HV and Stage Bias last used).

7. Repeat steps 4 and 5 to achieve the best result.

N
O

T
E An image shift when changing the stage bias could be caused by 

imaging near the sample edge or any other edge.

N
O

T
E When the retractable vCD detector is inserted, stage tilt is 

restricted via the UI. Override it by manual control to keep the 
dark rea in the center of the screen.
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Capturing and Handling a Single Image

Good Quality Image Conditions

After obtaining a good quality image, pause or save it using File > 
Save (see “File Menu” on page 53).

Conditions for a good quality image:

 Select a Slow scan speed (longer dwell time) of the beam.
 Select a pixel resolution from the drop down list box to suit the 

detail in the image, i.e., no tearing pixilated edges.
 Increase the magnification at least 2× above the desired value, 

focus and correct the astigmatism (using the reduced area), 
then return the magnification back.

 Use the Videoscope to set the Contrast and Brightness 
accurately, otherwise use the Auto Contrast Brightness 
procedure.

 Use Pause, Snapshot, Photo, Active Preset Snapshot, or 
filtering functions.

Image Types

A computer perceives an image as a two-dimensional array of 
numbers—bitmap. Each array element is called a pixel and is 
represented as an integer value. Frequently, the pixel is 
represented as an unsigned 8-bit integer in the range 0 to 255, with 
0 corresponding to black and 255 corresponding to white and 
shades of gray distributed over the middle values. A 16-bit 
representation produces up to 65,536 different shades of gray (it is 
not possible to distinguish on-screen), which may be crucial for 
obtaining accurate data in analysis.

The raw scanned image is always a grayscale bitmap. You can add 
colors digitally as a result of particular features. The UI is able to 
show and save images with a various bit depth:

 The Grayscale 8 bit image offers 256 levels of gray. Live and 
Integrated images are scanned as 8 bit ones.

 The Grayscale 16 bit image offers 65,536 levels of gray. 
Averaged and Integrated images are scanned as 16 bit ones. 

 For the Mix display images, choose between the 8 or 16 bit 
mode.

 The Color 24 bit image offers 256 levels of each primary color: 
red, green, and blue. 
Digital colors coming from the Display Saturation feature in 
the Image Enhancement module > Color tab, or from the Mix 
display with color mode, set changes and image bit depth so 
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there is no way to save it without them. When you want to 
obtain the image without these color enhancements, you must 
turn off the respective UI functions.

You can save an image with or without colored digital 
overlaid graphics (Measurement and Annotation) (see the 
respective check box in the Save As dialogue). Other types of 
overlaid graphics over an image are never saved (icons, 
controls, etc.).

Digital File Formats

The captured image can be saved in various digital formats, 
depending on the resulting color and bit depth needed. Generally, 
there is no reason to save an image with a higher bit and color 
depth than available in an original one. Saving an image with a 
lower bit and color depth than available leads to the loss of 
information. 

 TIF 8 or 16 bit: Grayscale image type
 TIF Color 24 bit: Color image type TIF file contains active 

processing information that could be utilized for a databar 
setting (see Preferences > Databar section).

 JPG 8 or 24 bit: A compressed file format employing a lossy 
compression algorithm resulting in a small file size with a little 
loss of information, depending on the particular image 
appearance and the compression level (factory preset to 80%). 
The 8 bit depth is automatically selected when saving a 
grayscale image file. The 24 bit depth is automatically selected 
when saving a color image file.

 BMP 8 or 24 bit: An uncompressed file format. The 8 bit depth 
is automatically selected when saving a grayscale image file. 
The 24 bit depth is automatically selected when saving a color 
image file.

Taking Photo / Snapshot 

Click the Photo / Snapshot toolbar icon to take a photo / snapshot. 
The result depends on the selections made in the Scan menu / 
Preferences dialog box / Scanning section, or from the menu 
induced by right-clicking above the Photo / Snapshot toolbar icon 
and selecting the Edit item. 

Slower scan rates are most generally used with the photo image 
capture method.
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Preferences setup
1. Make the destination of the to-be-saved files available to the 

save routine in the File menu by opening a folder and saving a 
test file to it.

2. Select Scan > Preferences > Scanning item. Select the Photo / 
Snapshot scan preset from the dropdown list at the top of the 
property editor (see Chapter 4, Preferences) 

3. Select a suitable dwell time by dragging the Photo / Snapshot 
icon to the required value, or by selecting from the Dwell Time 
property editor of the Scan Presets. If dragging the icon, the 
new values update in the property editor as soon as the mouse 
button is released.

4. Select a pixel resolution from the Resolution property editor. 

5. Enter the number of frames in the Integrate property editor.

6. Select the Action property for either Save, Save As, or None.

Using Photo / Snapshot 

Whenever an image is required, click on Snapshot to activate 
preset scan setting that pauses at the end of the scan time. The 
result can be just for viewing to verify against the patterning 
condition, or for saving. 

1. Select a display to take a snapshot with the beam that is 
selected in that display.

2. Set the required magnification.

3. Increase the magnification at least 2×. 

4. Focus and correct an astigmatism using Reduced Area. 

5. Return the magnification and scan to their original settings.

6. Set contrast and brightness correctly.

7. Click toolbar Photo icon or press F2 to take a preset high 
quality, high resolution image.
or 
Click toolbar Snapshot icon or F4 / Ctrl + F4 for electron / ion 
beam snapshot.

8. Save the image. 

9. Release the scan by clicking once on the Pause toolbar icon (or 
press the F6 key).
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Saving & Opening Single Images

Save

Use the Save function to save and update the original stored 
image. This is a direct command without confirmation if the label 
remains the same. This is usually required for a restored image 
from the archive. Select File > Save and the file is saved 
automatically to its existing label and the original file is 
overwritten. The function also operates by pressing Ctrl + S.

The Save method is also employed by the Snapshot and Photo 
functions under the Action option, but the image capture routine 
increments the label and, therefore, adds to the listed images 
instead of overwriting the last image. The image is given the last 
known label, including a number that is incremental with 
successive images, e.g., Label_001.tif, Label_002.tif, etc.

Save As

Selecting File > Save As opens a dialog for saving an image with a 
new filename and location. The Save As method is also employed 
by Snapshot and Photo under the Action option, but the image 
capture routine prompts the Save As dialog.  

The dialog shows, by default, the location last used to save or open 
files and the name last used in the current display. You can choose 
a different location and/or name, select a different image format, 
and also choose whether to save the image with/without the 
databar and with/without overlaid graphics by ticking 
appropriate check boxes. The settings are remembered per display 
and are used for the subsequent Save actions.
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An image can be saved in TIF (8-, 16-, and 24-bit color depth), JPG, 
or BMP formats. Overlaid graphics can be written into the image 
either in grayscale (8- or 16-bit) or in color (24-bit).

Open

Preselect the display for the image to open in and then select the 
image from the Open function. Selecting File > Open shows a 
dialog box for opening an image to a particular display. The dialog 
box shows, by default, the last used location of saved files 
associated with the imaging function, e.g., the image file location 
used by Snapshot or Photo. After making your image selection, 
click Open to open the image to the display that has been selected. 
Images can be opened in any combination of displays.  

Saving Multiple Photos

Selecting File > Save All opens a dialog box for selecting displays 
and file names for saving multiple photos.  
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Tick the check boxes for the images in the displays that you want 
to save. Browse to a location and choose a name and file format for 
each image. Click OK to save.

Printing an Image 

Select File > Print to open the Print Setup dialog to select a printer 
and set up conditions for printing an image or any other printable 
product from the microscope. Print will only be highlighted when 
the active display is on Pause. 

To print an image:

1. Select a display and optimize the image conditions in that 
display.

2. Photo the image or open an existing image from memory into 
the display.

3. Select File > Print or press Ctrl + P. The Print Setup dialog box 
appears.

4. Verify the print setup and click OK.

Recording Movies (Multiple Image Capture)

Image Capture with Record Movie

You can make digital video files (AVI) for dynamic experiments 
performed within the microscope. All displays can be recorded at 
the same time with synchronized start and the possibility of 
switching between display and full screen while the video is 
recording. Record Movie has the following embedded features:

 Resolution at 512 × 422 or 1024 × 884
 Databar image optionally included in the video
 Average or integration changeable during recording
 Scan speed changeable during recording
 Reduced area pauses display for focus or contrast and 

brightness changes
 Time remaining indicator
 Single frame TIF images recordable during video sequence
 File format compressed AVI (*.avi)
 Start, stop, and pause onscreen indicators
 Preferences setup dialog

N
O

T
E For higher resolutions, 

the printer may need a 
larger memory buffer.
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Display Indicators

A red dot indicates that recording is active in this display. It is 
shown in the top right hand corner below the timer.

A red ball with the Pause symbol indicates that recording is active, 
but the data from this display is not stored. It is shown in the top 
right hand corner below the timer. 

An estimation of the time remaining until the end of the video is 
shown in the upper right corner in the format hh:mm:ss. The time is 
calculated from the average disk space consumption and the free 
space on the disk.

Understanding Start, Stop, and Pause

The red dot is the start command button that starts the recording 
videos, one for each of the image displays at the same moment.

If a display is paused when starting the video, only the first image 
with a time stamp is stored. When the display is paused during the 
video recording, storing of the video frames is interrupted, but the 
video streams keep synchronization for the next unpausing. After 
reaching the maximum file size, the video is paused, saved, and a 
new video is started with the same name and incremented numeric 
seed.

When the red dot, representing Start, is clicked, it turns to a black 
square, representing Stop. When clicked, the black square then 
stops the recording of the video of all three displays and closes the 
files.
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Recording a Movie
1. Select Scan > Preferences. When the Preferences dialog box 

opens, select the Movie tab.  

2. In the Movie Timer section, tick the Save AVI Movie check 
box and select the desired time from the Period dropdown 
menu. Tick the Save TIF images check box, if required, and 
then a desired Period.

3. In the File Settings section, enter the File Name and give the 
Save in directory path and the File Type. Enter the Numeric 
Seed value and the Video File Size. Select the File Type and 
choose whether or not to Record Databar by ticking the check 
box. 

4. Click the Apply button to temporarily change to the new 
values or OK to permanently fix the values entered. (Cancel 
returns to the original values.)

5. Choose which displays will not be active during recording by 
selecting the displays and clicking the toolbar Pause button. 
This applies only to displays 1–3.

6. Set up imaging in the live display and select File > Record 
Movie or click the Record Movie toolbar button (the button 
turns into a black square). The first frame with a time stamp on 
all displays is recorded. The recording then starts; the duration 
is dependant on the setup in the Preferences dialog. 
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7. When the video starts and the scan resolution is higher than 
1024, the following dialog appears:  

8. Choose either of the resolution values and click OK. The 
movie will continue to record at the selected resolution.

9. The movie stops when the black square Record Movie button 
is clicked on the toolbar. The stop command stops recording 
the video on up to all three displays and closes the files.



215

Getting Started   Recording Movies (Multiple Image Capture)

Thermo Fisher Scientific CONFIDENTIAL, Limited Rights Data

Making a Movie with Movie Creator

The Movie Creator is a separate executable software application 
used to create a movie from a sequence of TIF images. 

To activate it, go to C:\Program Files\fei\exe\Moviecreator2.exe. The 
Movie Creator dialog box opens.

File Tab

The File tab contains the setup facilities for creating a movie from a 
captured sequence of TIF images made while using the Movie 
function.   

Table 5-1 Movie Creator—File Tab Overview (1 of 2)

Menu Item Description

Name Prefix Shows the prefix label for the sequence of TIF images. Click on the 
dotted button to the right of the dialog box to browse directories and 
files for the TIF sequence prefix.

Time Period Provides two choices for selecting a time period: the millisecond radio 
button or the TIF Time radio button. To find the best custom timing, 
you may need to create the movie a few times. 

ms When selected, sets a custom time for playback of the movie.

TIF Time When selected, sets real time (acquisition = playback)

From/To Enter the numbers of the starting frame and the ending frame. These 
represent the sequence beginning to end.
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Databar Tab

The Databar tab contains two lists: Available items and Displayed 
items. Items in the Available list can be added individually or as a 
whole to the Displayed list. The Displayed list, when completed, 
contains all items that will be shown in the databar at the base of 
the movie display. The order of the items in the Displayed list can 
be moved up or down due to priority or preference. This, in turn, 
changes the order of the shown items in the databar. Items can be 
removed from the Displayed list singularly or in total back to the 
Available list. This facility does not affect the display and full 
screen databar and is only dedicated to the Movie Creator.   

Save in Enter the path where the AVI file should be saved. Click on the dotted 
button to the right of the dialog box to browse the directories for the 
path needed.

File Name Enter the file name for the AVI file to be saved. If this is not filled in, 
the default prefix (first image) will be used, and is filled automatically.

Databar Preview Shows the databar chosen from settings made in the Preferences 
dialog box, Databar tab. 

Status Shows the progress of movie creation.

Create Movie Starts the creation process of the TIF files to a single AVI file.

Stop Stops the creation process.

Close Closes the dialog.

Table 5-1 Movie Creator—File Tab Overview (2 of 2)

Menu Item Description
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Table 5-2 Movie Creator—Databar Tab Overview

Menu Item Description

Available items Shows all items that can be entered in the databar.

Displayed items Shows the items that will be present in the databar.

> Adds one item from the Available items to the Displayed items list.

< Removes one item from the Displayed list to the Available list.

>> Adds all items from the Available list to the Displayed list.

<< Removes all items from the Displayed list to the Available list.

Top Moves an item to the top of the Displayed list.

Move Up Moves an item up in the Displayed list.

Move Down Moves an item down in the Displayed list.

Bottom Moves an item to the bottom of the Displayed list.

Label Shows the label in the databar.

Micronbar Shows the micron bar in the databar.

Show Beam Icon Shows the beam icon in the databar.

Units Sets the Units of Measure, Pressure, and Temperature used in the 
movie databar.

Databar Preview Shows the databar chosen from settings made in the Preferences dialog 
box, Databar tab. 

Status Shows the progress of movie creation.

Create Movie Starts the creation process of the TIF files to a single AVI file.

Stop Stops the creation process.

Close Closes the dialog.
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Preview Tab

Once the movie is created, the Preview tab automatically shows 
the first image of the movie sequence. By clicking Play, the movie 
starts and the progress slider below the movie proceeds from left 
to right at a speed depending on the play timing of the movie.   

Playing a Movie

The AVI file movie can be played on the Windows Multimedia 
player installed on the system or exported to another Windows PC 
with more advanced movie editing programs. Programs used to 
play the movie need to recognize the *.avi file type.

Table 5-3 Movie Creator—Preview Tab Overview

Menu Item Description

Start/Pause/Stop Starts, pauses, and stops the movie. Use the slider to run forward and 
backward through the movie.

Create Movie Shows the File tab and begins the creation process of the TIF files to a 
single AVI file.

Close Closes the dialog.
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Stage Movement Limits 
The chamber is equipped with the stage that can be oriented with 
reference to five axes: X, Y, Z, Rotation and Tilt. All movements 
are motorized and software controlled for more advanced location 
mapping. This includes Shift, Get, Track and the Stage module 
functionality.  

Figure 5-11 Stage Movement Schema   

N
O

T
E When moving the stage or tilting the specimen, the magnification may 

need to be reduced to keep from moving the feature of interest off the 
screen.

C
A

U
T

IO
N

If the maximum sample size is near to the limit, stage tilt could be 
limited. Beware of hitting the objective pole piece.
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Table 5-1 Stage Features and Limits

Item
UHR 
stage 

150 × 150 
mm stage 

110 × 110 
mm stage Note

X from –50 to +80 –75 +75 –55 +55 [mm]
Y from –50 to +80 –75 +75 –55 +55 [mm]
Z
The positive 
Z-value 
direction 
depends on the 
Link Z to FWD 
status

0 + 20 10 + 20 0 + 66 [mm] holder + stage
• Holder Z movement 

means the possibility to 
manually screw the 
sample holder in or out. 

• Stage movement means 
motorized stage 
movement.

R 360° 360° 360° continuous 
T –10° to +60° –38° to +60° –15° to +90°
Eucentric 
Position

Electron: WD = 4 mm 
Ion: WD = 13 mm

Clamp No
Maximum 
sample weight 

200 g 500 g 2 000 g For all tilt angles 
1 000 g 1 500 g 5 000 g At Tilt = 0° 
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Moving the Stage
The Navigation page contains the essential elements for stage 
navigation to specific areas (see “Navigation Page” on page 110).

Additional software controls for stage movement include three 
techniques. 

Shift moves

The stage can be moved approximately 80% / 40% of the field of 
view in any direction by pressing / Shift + pressing on the 
appropriate Arrow key on the keyboard. 

The maximum range for successive frame shift operations equals 
the range of the stage movement.

Track moves 

The Track moves allows continuous directional movement of the 
stage with variable speed. The speed range is coupled to the 
magnification and is selectable within certain limits (see the 
Preferences / General section / Switch sample tracking on 
mouse wheel click item): 

 Wheel-click & drag mode – the yellow dot appears onscreen in 
an active display at the mouse cursor point. Move the mouse 
to the direction intended for an observation – a yellow arrow 
appears onscreen denoting the direction of the stage motion. 
The motion speed increases with the distance between the 
arrow and the dot. The direction can be changed by moving 
the mouse. When you come to the place of interest, release the 
mouse wheel – the action stops. 

 Wheel-click & move mode – the mouse wheel does not need 
to be held; just click on the desired direction to start the Track 
motion and click again to stop it. 

When a yellow line perpendicular to the moving direction appears, 
the stage approaches the movement limit in that direction; when a 
yellow cross appears, the limit was reached. 

In the optical display, clicking the mouse wheel activates the stage 
Z movement, which can be seen live. 

 Wheel-clicking & dragging the mouse up / down – moves the 
stage up / down (Z-coordinate). 

 Ctrl + Wheel-clicking & dragging the mouse left / right – tilts 
the stage left / right. 

The direction is indicated by a yellow arrow, either pointing up / 
down from the horizontal line or left / right from the vertical line. 



Getting Started    Moving the Stage

222

Thermo Fisher Scientific CONFIDENTIAL, Limited Rights Data 

Get moves 

This function brings an image point of interest to the screen’s 
center. 

Double-click anywhere within the imaging display; this point is 
mechanically centered onscreen by moving the stage, which is 
suitable for lower magnifications. When working at higher 
magnifications, beam shift can be also employed (see the 
Preferences / General section). In this case, the point is 
electronically centered onscreen by moving the electron beam. 
When the beam shift comes to a limit in any direction, its value 
resets, and the necessary stage movement adapts the observed point 
position. 

Electron Beam Shift Reset

When you want to employ the beam shift only (which is suitable 
for higher magnifications), shift + click on an image point. Drag the 
Hand cursor to move the imaging area in any direction. 

When the limit of the beam shift has been reached, either the Stage 
menu / Auto Beam Shift Zero or the Beam Shift Reset function needs 
to be applied. In this case, the beam shift is reset, and the observed 
point position is adapted by the stage movement. 

Releasing the mouse button stops the action. 
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Align Feature

This feature is designed specifically for long features or when there 
is need to navigate along a feature that extends off the screen at the 
magnification required for observation. 

When selecting the Use: Stage Rotation radio button, the 
functionality applies de-skew process across the entire length by 
applying stage moves, bringing the long feature either to the 
chosen Orientation: Horizontal or Vertical axis to make it easier to 
navigate. 

When selecting the Use: Scan Rotation radio button, the 
functionality applies de-skew process across the entire length by 
applying scan rotation. 

This can be performed at any point within the stage field limits and 
takes into account the offset for rotation by computer 
programming of the stage. Point 1 is first located and then point 2. 
When this occurs, point 2 is not fixed but extends point 1 with an 
elastic cord until the left mouse button is clicked in the active 
imaging display. At this position point 2 is located. The longer 
distance involved results in greater accuracy. 

Align Feature is designed to work best at eucentric position. If 
necessary, follow the procedure outlined in “About Eucentric 
Position” on page 164.

Because the stage makes movements by software control, care 
should be taken that there are no significantly higher obstacles on 
the sample plane set at the eucentric position, as these may 
interfere with equipment under the lens.

To set Align Feature:

1. Select a long feature of interest on the sample. 

2. Click on the Stage menu / Align Feature or the toolbar icon.  

3. Choose Use:; choose Orientation: either Horizontal or 
Vertical, which relates to the desired final orientation of the 
feature.

4. Click on the first point along the feature, the Position 1 
coordinates update. 

N
O

T
E For best results, zero 

scan rotation first.

N
O

T
E Align Feature can also 

be used in the Nav-
Cam display.

N
O

T
E

It is recommended that 
you choose your first 
point on the left of the 
image and the second 
point on the right of the 
image. If you set your 
first point on the right, 
the rotation will be 
offset 180°.
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5. Moving the mouse updates Position 2 coordinates 
continuously, by clicking anywhere along the feature they are 
stored. 
The Angle shows value which is used to correct alignment of 
the feature along the Orientation / Horizontal or Vertical 
axis.  

6. Drag any point to change its position, if needed. Right-click on 
the imaging area (anywhere) to delete points, enabling to 
define them again.

7. Click on the OK button to finish the setting. 

Compucentric Rotation

Selecting Stage > Compucentric Rotation (or pressing F12 key) 
places a green circle in the active display.  

N
O

T
E

This can be corrected 
at any time by going to 
the scan rotate 
settings on the Beam 
control page and 
resetting scan rotation 
to zero.
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At a point on the perimeter of the green circle is a green triangle 
that denotes, by its position, the angle orientation of the sample 
relative to its original position when placed on the stage, starting at 
the 12 o’clock position.  

By clicking and holding the mouse button down on the green 
triangle, it can be moved around the circle to chose a new 
orientation of the sample relative to the detection position. On 
release of the left mouse button, the computer software updates 
the position orientation and offset from the mechanical stage 
center to deliver the same object center, but rotated to the angle 
selected. 

This creates a different direction of illumination for the sample 
while keeping the object of interest in the center of the imaging 
area. With the sample at the eucentric position, this can be 
performed at any position on the sample, irrespective of the 
mechanical stage center. 

Clicking on the numbered angles around the perimeter of the circle 
causes the stage to drive to that angle and the green triangle 
updates on screen. Clicking the large / small button with + / – 
sign increases / decreases the rotation value about 1° / 0,1°. 

The read-out positions shown at the bottom of the display provide 
information on the Actual Rotation (original position in degrees), 
the Target Rotation (the selected position in degrees). 
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Defining User Units

Define User Units associates stage points with user-defined points 
to set up a mapping between the stage and user coordinate system. 
After that, the computer uses these sample coordinates rather than 
stage coordinates for positioning. For example, a die of an 
integrated circuit has its own coordinate system. If you choose a 
0,0 position, you can drive the stage relative to that position using 
your own coordinate system. These are expressed in User Unit 
(UU) coordinates, which may be microns, multiples or fractions of 
microns, etc. Coordination of the stage can be anchored to either 1, 
2, or 3 points, depending on the sample management or 
application.

Choose points that are not in a straight line, e.g., at the corners of a 
die or the edges of an area or wafer. You can align up to three 
points for the greatest accuracy.

To set up the 1–3-point alignment for any given sample where 
repeated structures are examined:

1. Click on the sample user point (0,0), its coordinates appear in 
the Details module. Proceed by clicking the Next button. 

2. Select a feature on the sample surface and bring it into the field 
of view at a magnification so that it relates to other structures 
(not too high magnification).

3. Select Stage > Define User Units.  
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4. In the Define User Units - Start dialog box that appears, select 
Define New User Units and click Next.  

Other possibilities are: 

 Redefine User Units – changing or updating User Units 
 Redefine User Units with shift – as above with the use of the 

Beam Shift 
 Reset User Units so that they are equal to the Stage Units 
5. The Alignment Point One (0,0) dialog appears.  
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Follow the instructions in the dialog to move to a point and 
click on it. The coordinates of that point (0,0) appear next to 
the User X and User Y readout positions in the Details section 
of the dialog. 

6. Click Next to continue to two points, or do one of the 
following:
 Click Previous to return to the previous dialog.

 Click Finish to end the alignment at one point.

 Click Cancel to exit the procedure.

7. After clicking Next, the Alignment Point Two (1,0) dialog 
appears. 
Repeat the procedure, selecting and clicking on a new location 
point. The read-out positions will show the coordinates for the 
new Point Two location.

Choose the next step from the bottom line of buttons as in Step 
4. To continue, click Next.

8. After clicking Next, the Alignment Point Three (0,1) dialog 
appears. Repeat the process as in Step 5. 

9. After clicking Next, a confirmation dialog appears. 

Click Finish.

10. Click Details at any time to show the resultant coordinates. 
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User Units

Select Stage > User Units to activate User Units as the basis of the 
stage coordination system.  

A tick mark appears next to the label. The stage coordinate system 
reverts to the last defined user unit configuration for 1-, 2-, or 3-
point alignment. From this point on, the stage can operate in 
Absolute or Relative mode with User Units to perform specific 
movements.

Using 1-, 2-, or 3- Point Alignments  

Table 5-2 Alignment Type Differences

Use 1-Point Alignment 2-Point Alignment 3-Point Alignment

Major use Aligning to a new set of 
coordinates directly offset 
from the existing ones.

Aligning the stage axes 
with the sample X-Y 
orientation to correct for 
any skew and overall 
scale.

Most general alignment. 
Rescaling to nonstandard 
units on CAD dies or 
RAM arrays; correcting 
for any skew.

Change in 
scale

None Scales the axes together. X can be scaled 
differently from Y.

Change in 
orientation

None Rotates both axes with a 
fixed 90° angle between 
axes.

X and Y orientations can 
be non-orthogonal and 
can be mirror-imaged.
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Scan Rotation

Use the Beam Control page > Scan Rotation module or use the 
display overlay control (Scan menu > Scan Rotation (Shift + F12)), 
that behaves identically to the Compucentric Rotation (see above). 

 

When patterning is in progress, the scan rotation overlay control is 
restricted only to the – / + buttons. 
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Sample Navigation / Navigation Montage

This software feature enables to navigate along the sample surface 
when the field of view is smaller than desired (limited by an 
aperture for instance). For this purpose it is possible to use up to 
three images which could be changed dynamically (capture, save, 
or load any time).

For more information, see See “Navigation Montage...” on page 72.

Set the Target HFW (horizontal field width) range, which 
influences the other information fields.

When the Use Actual HFW check box is ticked, the system does 
not automatically use the HFW according to the hardware 
configuration and sets one for the user. This is convenient when 
the image corners are rounded and imaging does not cover an 
entire area.  

The Stage > Sample Navigation mode is then automatically set. 
For the selected display, the upper right corner green icon 
indicates the functionality.

A green rectangle showing the actually selected field of view (in 
the selected display) appears with the size corresponding to the 
magnification. In display(s) using Sample Navigation, the Selected 
Area Zooming and the Get features could be used.  

N
O

T
E

The basic condition for correct functionality is an equal stage rotation 
value for both captured and corresponding live images. In either case, 
the upper right corner red icon indicates no functionality in the 
respective display.
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Nav-Cam (In-Chamber Navigation Camera)
Beside the Sample Navigation and Navigation Montage features, 
this functionality represents a fast method to navigate across a 
large stage movement area. It gives a fine Navigation image 
quickly and easily, which is convenient when investigating large 
area samples or several samples with the use of any multi sample 
holder. It is also possible to run the Stage menu > Align Feature 
selection with the Navigation image. 

Capturing a Navigation Image
1. Vent the chamber, open the chamber door, insert a sample, 

and pump the system. 

In case you do not want to control the entire procedure, select 
Stage > Take Nav-Cam Photo… (Ctrl + Shift + Z) to automatically 
run following steps 2, 3 and 4 at once. Click Cancel at any time to 
stop this procedure – the stage remains in the actual position. 

Or follow the manual procedure: 

2. Select the Stage > Move Stage to Nav-Cam item to move the 
stage to the Nav-Cam position.  

At this moment the beam and the detector changes to Nav-
Cam and a live image of the navigation camera is obtained in 
the last used active display (with the resolution of 768 × 512 
pixels only).  

3. Capture a Navigation image (with high resolution of 3 072 × 
2 207 pixels) using the Snapshot / Photo function. Save or 
adjust the image like any other image acquired from the 
microscope (image enhancement, process, etc.). 

C
A

U
T

IO
N

Retract all retractable detectors to prevent equipment damage.
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4. Select Stage > Move Stage to Nav-Cam again to move the 
stage to the last used stage position. A green rectangle (or just 
a cross) represents an observed area. 

Besides a Navigation image, you can also use the Digital Zoom 
module to navigate the stage. 

When the Preferences > General tab > Show Stage Map in 
Navigation display item is set to Yes, stage saved positions are 
shown in the Nav-Cam photo. 

In case a user logs off and the sample and its stage loading position 
did not change, select Stage > Restore Last Nav-Cam Photo.  

N
O

T
E

Wait several seconds for image capturing to finish. If the 
Navigation image is too dark or faint, set its brightness with the 
Brightness continuous adjuster on the Detectors module when 
the Nav-Cam display is active before capturing the Navigation 
image. 

N
O

T
E

If the Nav-Cam observation takes longer then 10 minutes, 
software protection switches illumination off for 1 minute to cool 
down. To proceed the operation, release the display. Nav-Cam 
usage is not possible to operate (but a navigation is still 
possible) in the SEM Mode 2 (Immersion/UHR). Nav-Cam usage 
is restricted for highly shiny and simultaneously planar 
specimens (Si wafers, mirrors etc.). 
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6 EasyLift NanoManipulator

The EasyLift EX NanoManipulator supports higher yields for TEM 
sample liftout through an intuitive integrated UI.

The EasyLift is an option feature. 

Topics include:

 “EasyLift Software Control” on page 236

 “EasyLift: Needle Exchange/Calibration Alignment” on page 241

 “EasyLift Needle Control ” on page 246

About EasyLift
The EasyLift tool allows sample manipulation during an in-situ 
lift-out process. This process consists of lifting up a piece of 
material from a bulk and transferring it on a standard grid that can 
then be loaded into a TEM. 

Equipment has these modifications: 

 EasyLift EX – full capacity version

 EasyLift – no rotation control

 EasyLift LT – no rotation and lower movement accuracy
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EasyLift Software Control

Stage Menu/Active Display Controls

The EasyLift can be controlled with an overlay that automatically 
pops up when inserted.  

 To turn the overlay on or off: Select Stage > EasyLift or press 
Control + J. The overlay is shown in the active display (SEM or 
FIB).  

To cancel active drawing mode of the Patterning, 
Measurement & Annotation or Text cursor, press the keyboard 
Escape button. 

 To stop the overlay from popping up automatically: go to 
Tools menu > Preferences item > General section > 
Automatic EasyLift Display Control, and select No. See 
“General Section” on page 147.

N
O

T
E This display overlay functionality is not available 

for the EasyLift LT version.
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Figure 6-1 EasyLift Active Display Controls

Jog arrow 
corresponds to 
arrows on 
EasyLift module

X / Y movements controlled in the area to the left of the green vertical line. 
Make Jog and Get moves by clicking and dragging. 
The more the mouse cursor is moved away from the starting point, the quicker the needle moves. 

Rotation arrows (CCW and CW) correspond to arrows on EasyLift module

N
O

T
E When the EasyLift is display controlled and the patterning drawing 

mode cursor is active (creating a pattern / moving a selected pattern), 
be aware it has priority over the EasyLift control. 
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Control Page

The EasyLift is controlled via the EasyLift module on the EasyLift 
page. 

All movement increments are predefined on the Preferences > 
EasyLift section, see “General Section” on page 147.   

Figure 6-2 EasyLift module

N
O

T
E Some controls are not included on the EasyLift module on the 

Patterning and Sample Prep control pages.
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Table 6-1 EasyLift Tab Overview (1 of 2)

Interface Item Description

Initialize When the system is in an unknown state (e.g., after power down), 
places the EasyLift in the retracted position with all axis at home 
position.

Insert / Insert To / Retract Changes its function depending on the state of the EasyLift. Clicking 
the button calls the confirmation window with posibilities:  

• Park position: Clicking it causes the needle to be inserted at the 
defined location. In case a user selects any saved position prior 
clicking the Insert button, the button is labelled Insert To and the 
confirmation window looks slightly different. 

• Insert: Clicking it causes the needle to insert to a position from 
which it was retracted.
When the needle is inserted, the button is labelled Retract: 
Retracting the EasyLift is always possible. 

• Cancel: Cancels the operation. 
Note: It's possible to turn the EasyLift insert needle message On / Off by 
setting the Preferences… / General tab / Show EasyLift insert 
confirmation item. 
Note: Inserting is only possible when the system is linked and at the 
Eucentric position (WD > 3,7 mm).
Note: EasyLift insertion is automatically restricted when 
Beam Deceleration mode is on.
Note: Once EasyLift is inserted, you can not use the keyboard arrow keys 
for stage moves. 

Jog Specifies Jog moves (constant velocity) to be used for EasyLift 
control. 

Step Specifies Step moves (relative step size predefined in Rotation Step 
list box) to be used for EasyLift control. 

Rotation Step 
Enabled when 
Step check box 
is ticked.  

The needle can only be rotated in steps. This control specifies the step 
size in degrees. The rotation is executed when clicking the clockwise 
/ counter-clockwise arrow button. 
Note: The rotation with the manipulator could be performed also in the 
retracted position.
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Arrows Specifies the direction of EasyLift movement.
• In Jog moves, as long as the mouse button is held, the EasyLift 

jogs in the arrow direction. By releasing the mouse button, the 
movement stops. 

• In Step moves, each mouse click moves the EasyLift with the 
predefined step size. 

R = Specifies an compucentric rotation value with the 0.2° accuracy. 

Status Shows the status: 
• Undetermined: Run the Initialize procedure 
• Retracted/Inserted: The EasyLift is not /is ready for use
Note: The Compucentric rotation with the manipulator can also be 
performed in the retracted position. 

Position The needle Park position is defined by the EasyLift: Needle 
Exchange Calibration (see below). 
The Park position is 200 ?m above the Eucentric position. 
(SEM coordinates). Note, that coordinates used are set within the 
Preferences dialog / General / EasyLift coordinates dependent on 
bulk stage tilt setting.
Note: When you Insert to the Park position, the rotation angle of the 
needle is not changed; the current value remains.

Stop Stops any manipulator motion.

Go to Shows when a user-saved position is selected and the needle is 
already inserted. Clicking Go to causes the needle to move to the 
defined location.

Add Adds a stored position to the list.

Update Updates the selected stored value and links the current EasyLift 
position to the stored position.

Remove Removes the selected stored position.

Remove all Removes all stored positions.

Table 6-1 EasyLift Tab Overview (2 of 2)

Interface Item Description
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EasyLift: Needle Exchange/Calibration Alignment
Use this alignment to reach the eucentric point with the needle and 
to compensate for hardware rotational errors of the needle.

Needle Exchange 

Folow the instructions within the alignment window. 

Figure 6-3 EasyLift: Needle Exchange  

1. Step 2: Click the Vent Chamber button and wait for the 
chamber to be vented. 

2. Prepare the needle alignment tool – Base holder.

3. Pull the probe shaft radially outward from the EasyLift 
mechanics with using the removal/insert jig (protecting the 
needle to touch any mechanical part). 

4. Place the probe shaft on the Base holder. Place a little bit of 
Braycote or Fomblin on shaft O-rings. 
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5. Push the probe shaft end against the back end of the jig.  

6. With tweezers, remove old needle by pulling it directly out. 

7. With tweezers, place new needle under the leaf spring. 

8. Check by rotating the Probe shaft using the knob at the end if 
the needle is positioned straight. Reduce the needle tip 
wobbling (should be within 500 µm). 

9. Align the needle to the black/white edge (into /out from the 
leaf spring). Use the magnifying glass to verify the positional 
accuracy.  

Make sure O-ring 
rests on end
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10. Repeat step 3 in the reverse order to put the probe shaft back 
into the chamber. 

11. Step 3: Pump the chamber by clicking the Pump Chamber 
button. 

Needle Calibration 

Folow the instructions for subsequent steps taking care to focus the 
beams and center the needle as precisely as possible. 

Be sure to turn off the jog overlay using Control + J and only use 
the controls given in the Alignments tab. Decrease the step size of 
the needle under the Preferences > EasyLift section and zoom in 
for more accurate centering.

12. Step 4: Click the Wake Up button to restore column settings 
beams and the Move Stage button to position the stage. 

13. Step 5: Align the needle using the procedure described within 
the alignment window. 

C
A

U
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N

Push the manipulator shaft against the manipulator body with 
adequate force to ensure the shaft is inserted firmly. 
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Figure 6-4 EasyLift: Needle Calibration  
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Figure 6-5 EasyLift: Needle Calibration (continuing)  
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EasyLift Needle Control   

1. Press Control + J to turn the motion overlay on and off. The 
motion overlay comes on automatically when the manipulator 
is inserted in SW 5.3 and greater. 

2. Click inside of the electron beam display and drag the 
manipulator until it reaches the desired location in X / Y.  

3. Click and drag inside of the arrow area on the right side of the 
display to move the manipulator in z. Look for Z motion in the 
ion beam. 

C
A

U
T
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N

When you click Insert, the needle will insert to the last place from 
which it was retracted. To prevent collision, either lower the stage or 
select a safe user position and click Insert To.

N
O

T
E The display overlay functionality is not available 

for the EasyLift LT version.
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7 Patterning & Milling

Topics included in this chapter: 

 “Patterning” on page 248

 “Patterning Control module” on page 250

 “Milling Order of Patterns” on page 256

 “Properties Tabbed Module” on page 256

 “Patterns Processing” on page 259

 “Application files” on page 284

 “Milling” on page 288

 “Selective Milling” on page 291

 “Advanced patterning tabbed modules” on page 264

 “Fast iSPI Mode” on page 264

 “End Point Monitor (EPM)” on page 266

 “Real Time Monitor” on page 270
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Patterning
Patterning is the process of milling, depositing, or etching a pattern 
onto the sample surface with either electron or ion beam. During 
patterning, the selected beam unblanks automatically and uses 
digital beam placement to vector scan over a pattern. 

 While patterning can be done with either beam, the electron 
beam is generally used for imaging and sometimes for 
deposition with patterns.

 The ion beam is used to cut cross sections and tracks, drill vias, 
and deposit new material. 

In general, patterns need to be executed as quickly as possible, 
while maintaining sufficient edge resolution and preventing 
potentially damaging charge buildup.

During deposition, the beam is unblanked and a gas injection 
valve is opened to begin deposition. Multiple gas injection systems 
(GIS’s) or MultiChem may be installed on your system. 

Select an application file for a given pattern. A pattern must be 
defined before an application file can be selected. The given 
application file then automatically ticks an appropriate GIS / 
MultiChem check box, calculates the proper dose, and sets the 
dwell time and overlap appropriate to the beam chemistry.

Selected gas can be changed to fit individual use cases but overlap, 
and dwell should be set carefully with particular gasses in mind to 
achieve good results. 

Serial milling or deposition will always begin with the first pattern 
defined in the current image window and continue through 
subsequent patterns.

In Serial mode, a series of patterns could even be a combination of 
some to be milled and some to be deposited, but in general this is 
not recommended (because the GIS / MultiChem remains inserted 
and may result in possibly depositing instead of milling due to 
possible residual gas in the chamber).

Control of the patterning processes is via the Patterning menu (see 
“Patterning Menu” on page 66) and/or via the Patterning page (see 
below). 
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Patterning page

Use the Patterning page for milling, depositing, and etching a 
pattern onto the sample surface with a beam and for controlling 
the gas injection systems (GISs and MultiChem). For operational 
details, see “Patterning & Milling” on page 247.  

Figure 7-1 Patterning Page

See “Gas Injection module” 
on page 303

See “End Point Monitor 
(EPM)” on page 266

See “Properties Tabbed 
Module” on page 256

See “Patterning Control 
module” on page 250
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Patterning Control module 

Tools for creating, moving, sizing, and deleting patterns are 
available at the top of the Patterning Control module.   

Table 7-1 Patterning Tools Overview (1 of 4)

Icon Pattern

Pattern selector  

 

Click the down arrow to access the pattern types dropdown list. The 
selected pattern icon shows to the left of the arrow. It is also possible to 
use the toolbar icons as well. Gray / Orange background represents 
inactive / active (shape can be drawn) tool.  

The pattern is allocated a number relative to that shape and is shown in 
the Pattern List. 
To cancel the drawing mode click the keyboard Escape button. 
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Build Polygon Joins two overlapping patterns into one pattern. 
Draw patterns so they overlap. Select / highlight all patterns to include 
in the polygon, then select Build Polygon.  

Build Array Creates an array of defined patterns. 

• Dimension: The number of pattern repetitions in the X and Y 
directions.

• Pitch: The distance from the left edge of one pattern to the left edge 
of the next pattern

Draw a pattern first, then select Build Array. Enter the size and pitch 
values.

Convert from Annotation It is possible to convert any selected Annotation or Measurement 
graphic to a Bitmap type pattern shape with the use of this item. 

Trash Can (Delete)  Deletes the selected pattern.

Table 7-1 Patterning Tools Overview (2 of 4)

Icon Pattern
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Pattern Enabled / 
Disabled  

Click the down arrow to see the menu  

By default, all patterns when drawn are enabled for patterning.
Button Inoperative = grayed out.
Pattern Enabled = green tick mark.
Pattern Disabled = red circle with slash mark crossed through the green 
tick mark. Disables the currently selected pattern. The pattern color on 
the image turns gray to indicate that the pattern will not be processed.
Exclusion Zone Enabled / Disabled: The overlapping pattern area will 
be excluded from / included in the processed pattern.  

Enabled pattern is yellow, disabled pattern is white.

Hide  Hides all the patterns in the active display.

Serial / Parallel 
patterning  

Selects the patterning sequence:
• Serial: All patterns defined on the screen are milled consecutively; 

milling is completed on one pattern before moving to the next. 
Serial patterning is always used with cleaning cross sections as well 
as regular cross section.

• Parallel: All patterns defined on the screen are milled concurrently. 
For example, if three lines are defined as milling patterns, one pass 
of the beam will be made on one, then the next, then the third, back 
to the first, and so on until all three lines are milled to the depth 
selected for the first line.

With Parallel patterning, the mill time is recalculated to include all 
patterns that are shown on the screen. Parallel patterning is typically 
used to avoid redeposition of material on adjacent areas as well as to 
save milling time.

Table 7-1 Patterning Tools Overview (3 of 4)

Icon Pattern
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Pattern Zoom Brings the drawn pattern in the active display to maximum 
magnification allowed with the image. The button then turns yellow to 
indicate zoom is on. When selected during patterning, it always keeps 
the active pattern digitally zoomed to clearly show the RTM image (see 
“End Point Monitor (EPM)” on page 266). 

Sequence controls Moves the pattern to the beginning, back one, forward one, or to the end 
of the patterns list. 

Pattern list Corresponds to the pattern shown via the Pattern Selector to the pattern 
highlighted in the working display. 

Activation buttons The three buttons below the pattern list are fast activation buttons for:  

• Next Pattern: activated when more than one pattern is present.
• Next / Previous Line: activated when Cleaning or Regular Cross 

Section is operative.
The same functions can be found in the Patterning menu (see 
“Patterning Menu” on page 66.

Select All button Selects all pattern shapes within the active display. 

When Finished Select an action to be done after finishing the patterning process from 
the list:  

Beams Off – stops both the E- / I-beam sources 
Sleep – applies the Beam Control page > System module > Sleep 
command 

Progress area Shows the overall and actual progress (over time) of the active 
patterning.
• Total time – estimated total patterning time 
• Overall progress – related to the total patterning time of all patterns 
• Current progress / CCS line progress – related to the actual pattern 

in progress 

Table 7-1 Patterning Tools Overview (4 of 4)

Icon Pattern
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Pattern Types 

Patterns are automatically assigned to one or more particular 
processes. They are distinguishable by a different cross-hatch. 

 The Rectangle / Line / Circle / Polygon pattern is dedicated to 
both milling and deposition. 

 The Cleaning Cross Section pattern is processed line by line 
(each line with set number of passes).

 The Regular Cross Section pattern has two possibilities 
selectable in the property editor: 
Scan Method: Multipass – processes entire pattern and starts 
again (with set number of passes) 

Scan Method: Stairstep – the pattern is created as a 
compilation of five rectangles with specified overlap between 
them. Each one is processed with the set number of passes. 

Bitmap 

Use the bitmap pattern on the Patterning page to import bitmaps 
as a pattern. A bitmap file must be saved as a 24-bit format, i.e. 
each pixel consists of red, green, and blue components (RGB): 

 The red component is currently not used. 

 The green component determines if the beam is blanked. 
Any value other than 0 unblanks the beam. 

 The blue component determines the dwell time per pixel. 
If the value is 0, the pixel is skipped. 
If the value is 1 (border), the dwell time of a pixel is the lowest 
(approx. 100 ns). 
If the value is 255 (border), the dwell time of a pixel is the same 
as it is set for the pattern. 
The dwell time for the pixels in between the border values is 
linearly interpolated based on the blue component value. 

When drawing a bitmap, it is recommended to use black (0,0,0) for 
no milling points and green together with blue for milling points 
(see the following examples).  

Table 7-2 Bitmap Color Settings examples 

Color Result

RGB 0 / 0 / 0 — black The patterning point is not generated and is skipped. 

RGB 0 / 1 / 0 A patterning point is generated but it is skipped, dwell time is 0. 

RGB 0 / 1 / 1 A patterning point is generated, dwell time is the lowest. 

RBG 255 / 255 / 255 —white A patterning point is generated, dwell time is the same as it is set for the 
pattern.
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To mill a bitmap, see “Milling a Bitmap” on page 291.

Stream File Pattern

Stream files cannot be created directly from UI. Use any suitable 
text processor to create them. There are several stream file types 
that are recognizable by the first header line (s16 / s16,25ns / 
s16,DAC or s16,25ns,DAC). 

A stream file, created as an ASCII text or binary file that addresses 
the patterning DAC directly, produces custom pattern files. The 
advantage of a stream file is that you can make use of the full 
resolution of the DualBeam microscope. The disadvantage is that 
generating these files has to be performed outside of the 
microscope software. Therefore, stream files are for users who 
write their own programs for specific applications. 

Helios DualBeam has a PIA (Patterning-Imaging-Acquisition) with 
a DAC resolution of 16 bit. Therefore, the addressable points for 
PIA in X-direction is 65536 pixels, and 56576 in the Y-direction. 

A stream file contains a short header plus data (dwell time, beam 
position, X, Y). For Helios DualBeam systems, the stream file should 
start with “s16” to indicate that the DAC is 16 bits. The dwell time 
on a pixel is in units of 100 ns; you can also introduce the fourth 
parameter in any addressable point to require beam blanking 
control. The fourth parameter is optional and it can be added at the 
end of any individual mill point parameters. If the beam is blanked 
in the specific point, the fourth parameter in this point is set to 0 and 
beam is unblanked when the parameter is set to 1.

Below is an example in which 26 points are scanned in a 5 by 5 
array, repeating 40 times. The dwell time is 9.6 μs for each point. 
The file must begin with an “s16,” indicating a stream file for DAC 
16 bit. The second line defines the number of passes the pattern 
mills, where one pass has the beam visiting each of the 26 pixels 
(positions) one time. The third line indicates the total number of X, 
Y coordinates, in this case 26. The 96 figure represents dwell time 
in units of 0.1 microseconds. The range of dwell time is 25 ns to 
25 ms. The fourth column is set to 0 in the last point to require the 
beam to stay at the same point and blanked to avoid beam damage 
outside the pattern area.  
s16
40
25
96 1229 2867
96 1639 2867
96 2048 2867
96 2457 2867

96 2867 2867
96 1229 2457
96 1639 2457
96 2048 2457
96 2457 2457
96 2867 2457
96 1229 2048

96 1639 2048
96 2048 2048
96 2457 2048
96 2867 2048
96 1229 1639
96 1639 1639
96 2048 1639

96 2457 1639
96 2867 1639
96 1229 1229
96 1639 1229
96 2048 1229
96 2457 1229
96 2867 1229
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Milling Order of Patterns

Patterns are normally milled in the order in which they are created 
on the screen. Numbers are shown close to / inside the pattern 
shape and in front of its name to indicate the actual milling order. 
The milling order can be changed by clicking on the left / right 
single arrow to move the selected pattern one position up / down 
and by clicking on the left / right double arrow to move it to the 
first / last position.  

Properties Tabbed Module 

A certain pattern can be selected from the list box with many 
associated parameters which can be set via the Properties tabbed 
module. Properties are set on the Basic and Advanced Properties, 
sections, that vary by the selected parameters (pattern type, 
application file, gas type).  

N
O

T
E If you specify a Properties tabbed module > Advanced 

Properties area > Gas Flow %, it will override the value set within 
the MultiChem module. See “MultiChem” on page 307.
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Table 7-3 Patterning Properties

Properties Description

Application Name of the application file. Clicking the value field produces a 
dropdown arrow and list of applications. The parameters for the 
selected application are automatically set for the subsequent properties.

X / Y / Z size The dimension of the pattern.

Scan Direction Direction of movement of scan: Bottom to Top / Top to Bottom / Right 
to Left / Left to Right / Dynamic Top to Bottom / Dynamic Left to 
Right / Dynamic All Directions 

Dwell Time The time the beam spends on a single pixel per pass (rounded to a 
multiple of 25 ns).

Beam The beam (either electron or ion) used for patterning 

Time The time required to process the pattern.

Rotation Pattern rotation angle. Positive direction is clockwise.

Position X / Y Position of the pattern relative to the origin (the display center).

Overlap X / Y Sets the beam diameter overlap. The value of the overlap can be positive 
or negative depending on a particular application. The overlap 
parameter influences the Area Calculation and the Dose. 

Gas Type The name of the gas that must be used to pattern this shape (or None if 
no gas is to be used). 

Pitch X / Y Sets the pitch between two spots.

Area Calculation Area calculation is selected as Pattern or Array for when negative 
overlaps are required. The system will default to Pattern area 
calculation unless the user changes it.

Dose Defines the charge dose per area. Be aware of different values 
depending on the Area Calculation setting.

Volume per dose The volume of material that is removed per charge.

Saturation sputter rate The maximum linear sputter rate for a given gas. Currently not used.

Refresh Time The minimum loop time that must at least elapse before the next pass, 
so that the adsorbed gas can be refreshed.

Loop time Time required for a single pass. 

Area The surface area of the pattern (read only).

Scan Type Scanning strategy used while patterning: 
• Raster: The beam scans from left to right, then the beam is blanked 

and returns to the left starting point
• Serpentine: The beam proceeds from left to right and back from 

right to left

Fill Style For box and circular patterns, choose either to mill a Solid or only the 
Frame.

Passes The number of passes that the beam scans over the pattern.
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Patterns Processing 

You must define a pattern and select it before an application file 
can be selected. Select one of the existing patterns from the 
Patterning module list or draw a new one. 

Importing / Exporting Patterns 

User created patterns may be imported or exported (saved) via the 
File menu / Import or Export / Patterns item. The saved file (.ptf) 
contains all parameters found at the patterning Properties module 
for all patterns drawn in the active display. 

Defocus The defocus of the beam (WD change).  Influences the Total Diameter 
and Area Calculation. It allows focusing above (negative value) or 
below (positive value) the sample surface.

Blur Like Defocus, but specifying the (additional) diameter of the blurred 
spot.

Interaction diameter The interaction diameter for an infinitely small beam. Influences the 
Total diameter.

Total Diameter The combination of the beam diameter and interaction diameter. This 
influences the Overlap X/Y and Pitch X/Y values.

Maximum dose per area This describes the adsorbed gas layer, allowing a certain dose to be 
deposited at a higher rate than the saturation current density, allowing 
a temporary higher rate. (Currently not used).

Saturation current density The current at which 63% of the saturation sputter rate is reached. 
(Currently not used).

Total Volume Sputter rate The speed at which material is removed or deposited. (Currently not 
used).

Selective Milling Enabled Corresponds to Enabled check box on the Selective Mill Tab.

Selective Milling Time 
Interval 

Corresponds to the Interval adjuster on the Selective Mill Tab. 

Min Contrast Threshold Corresponds to the left border of the gray level to be processed for the 
selected pattern on the Selective Mill Tab. 

Max Contrast Threshold Corresponds to the right border of the gray level to be processed for the 
selected pattern on the Selective Mill Tab. 

Endpoint Detection Enabled 

Signal Type

Endpoint Type 

Layer Count 

Table 7-3 Patterning Properties

Properties Description
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Six (for each beam) toolbar Pattern Presets (labeled p#) can be 
individually assigned to any of these .ptf file. This assignment can 
be saved or loaded by the File menu / Export or Import / System 
Parameters item. 

Patterns / Measurements / Annotations Editing 

To create or edit patterns / measurements and/or annotations it is also 
possible to use the Patterning Control / Measurements/Annotations 
module with some added controls (see above).  

A Pattern, Measurement or Annotation can be drawn and 
modified (focusing, moving, or resizing) by the toolbar functions 
in the same way. This gives a user many capabilities to draw 
pattern shapes, to measure distances, angles, diameters and areas 
as well as locating and labelling items that are of significant 
interest on the sample area.  

Each tool shows its description as a tooltip. 

 Patterns – enable to create various pattern objects, which are 
prepared for subsequent processing. 

 Measurements graphics – enable to gain dimension 
information about a specimen feature by overlaying it with a 
measurement object of different shapes. By changing the 
magnification these objects resize accordingly. 

 Annotations graphics – enable to graphically highlight and 
label items of interest with different shapes. 
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Shape Creating 

Selected tool is shown as the toolbar icon. Clicking on it activates 
(drawing mode – orange background) / deactivates (white arrow 
cursor – normal background) the tool. Clicking on the down arrow 
icon opens the list of available tools, the chosen one is activated 
from that time on and the object can be drawn onscreen. 

To deactivate the drawing mode at any time is possible by pressing 
the keyboard Esc button, or click the toolbar Arrow icon. 

When clicking on an image display in Quad Image mode with the 
cursor that creates patterns, a slight mouse movement might 
produce a small unwanted pattern. If you create a small pattern 
accidentally, delete it by clicking Delete while the pattern is active 
or click the Trash button.

1. Choose the suitable Patterns / Measurements / Annotations 
graphic tool. 

2. Draw the graphic over the area of interest. This can be done by: 
– clicking on & dragging the cursor in any direction 
– Shift + clicking on & dragging the cursor to any direction – 
create a shape starting to grow from the point where you have 
clicked as from the center 

To create a text label click the T annotation tool, create a rectangle 
area into which a text should fit and start writing. 

Shape Editing 

Once a Pattern / Measurement / Annotation object has been 
drawn, it can be correctly adjusted in size and position over the 
area of interest by clicking on the Arrow symbol button and 
bringing the cursor back to the onscreen graphic. A number of 
appropriate properties are available in the property editor, which 
can be changed by a selection from a drop down list or by direct 
precise editing of a text or a value. 

Right-clicking above any shape type shows the corresponding 
context menu with additional options. 
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If there are more graphics on screen, use the Arrow cursor to focus 
on one in particular by clicking on the graphic. Selected object is 
denoted by the addition of resizing handles (white rounded or 
square points) to the graphic outline. Moving mouse point cursor 
in the vicinity of these points forces the cursor to change: 

 Moving (by mouse): click on inside the boundary of the object 
and drag it. To move the selected pattern(s) at orthogonal 
directions hold the Shift key when clicking and dragging.

 Moving (by keyboard): to move a pattern by one pixel: 
Ctrl + Alt + left arrow = move to the left 
Ctrl + Alt + right arrow = move to the right
Ctrl + Alt + up arrow = move up
Ctrl + Alt + down arrow = move down

If the keys are being held down, the keystrokes are 
automatically sent from the keyboard until the key is released. 
After the third keystroke, the counter of keystrokes should be 
cleared. 

The greater pattern placement precision may be accomplished by 
using the Digital zoom mode. 

 Rotating: click on the object rotation control (white point in 
the middle above the graphic) and drag it. 

 Resizing: click on & drag the resizing handle until the desired 
size is reached (horizontal / vertical / diagonal resizing 
cursor). Holding the Ctrl key while dragging forces 
dimensions to be changed proportionally. 

 Select all objects (within the selected display): 
click the Select All button or press Ctrl + A. 
All shape editing functionality are available also for multiple 
selected shapes. 

 Select multiple objects (within the selected display): 
Shift + click (while in the Patterning Control module list) to 
enable continuous selection of patterns. 
Ctrl + click (within the Patterning Control module list or the 
selected display) to enable adding/removing of actual pattern 
to/from the selection. 
Press Esc to restore the previous selection.

 Delete selected object(s): press the Delete key. 

 Copy / Cut / Paste: Select a pattern and then use the Edit menu 
or the keyboard shortcuts: Ctrl + C / Ctrl + X / Ctrl + V
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Using the Properties list 

Whether to change a properties of a pattern, measurement or 
annotation, you can enter the Properties module for the graphic or 
text you have selected.

Items such as color, font, line width, measurement type, and text 
position can be defined. Some properties have a dropdown list, so 
a choice can be made that will update onscreen for the selected 
graphic. Numerical values can be entered in text editors, with 
some properties, to affect the outcome of the graphic onscreen. 
These will show a text cursor in the edit area when clicked on.

When there is more than one graphic, use the Arrow cursor to gain 
information from each in turn. The Arrow cursor is only active on 
screen and changes automatically to the command cursor when 
over the UI.

Selective Mill tabbed module 

Shows selective milling information. It is possible to set a given 
grey level range to be processed in the extent of the selected 
pattern area.  

 Enabled check box: When ticked, enables the selective milling.

 Scan button: Enabled for patterns that support selective 
milling. Clicking it causes the histogram to be shown.
Move the horizontal grey bar to set a desired grey level range 
and also move the red rectangle edges to set the grey level 
extent. 

 Interval adjuster: Selects the time [s] after which the histogram 
is actualised. 
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Advanced patterning tabbed modules 

These tabbed modules (iSPI / Monitor / Charge Neutralizer / 
Progress) give visual feedback on the progress of a milling process. 
It shows the specimen current (charge absorbed in the specimen) 
and enables to monitor the specimen current changes as the ion 
beam interacts with different materials in the sample. For example 
the differences encountered when milling through some dielectric 
and striking another one are usually very subtle, but once the 
beam begins milling into metal, a dramatic difference in absorbed 
charge can be observed on the Monitor tab / window. 

Fast iSPI Mode

iSPI is short for “Intermitted Switching between Patterning and 
Imaging.” Fast iSPI mode is a basic usage toolsetting mode that 
keeps the beams more coincident, causing faster performance. In 
the SEM Mode 2 (Immersion/UHR), ion beam shift is used to point 
the two beams at the same place. 

When milling a cross section with the ion beam, users frequently 
switch to the electron beam to capture SEM images so they can 
observe the exact position of the current cross section.   

Table 7-4 Fast iSPI Mode Selection Differences

FIBI (FIB Immersion) Mode Do Not Degauss

Can only be used at < 3 kV (the field is too strong above that, causing 
too much FIB beam shift)

Can be used at all kVs.

No switching time 1 s switching time

Ion Column: FIBI Alignment must be performed before using

True immersion possible

N
O

T
E

During patterning, when you perform a scan and select Enabled, the 
histogram will be updated approximately every second. If you did not 
perform a scan but selected Enabled, adjusted the threshold marker, 
and started the patterning job, the histogram would remain as it is in 
the ‘Before clicking Scan’ example.

N
O

T
E Changing SEM focus 

affects the position of 
the ion beam. 
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1. Define the pattern with the ion beam.
2. Select FIBI (FIB Immersion) mode icon from the toolbar or Do 

Not Degauss to enter fast iSPI mode. 
3. Choose the required Time or CCS Line Interval for the iSPI 

image:
 For a Cleaning Cross Section, select a CCS Line Interval to 

take an electron beam image every “x” number of slices.

 For all other patterns, select a Time Interval to take an 
electron beam image every “x” number of seconds.

4. Unpause electron imaging in display 1. You can unpause other 
electron beam displays with different detectors (e.g., TLD and 
STEM). Simultaneous images are grabbed in such a case.

Reduced area 

Using the Reduced area (F7) functionality during patterning with 
the iSPI mode on within the electron beam display pauses 
patterning and electron imaging takes place in the Reduced area 
only to enable tuning of the imaging. 

Using the iSPI Reduced area (Shift + F7) functionality continues 
with patterning, and SEM images are grabbed from the reduced 
area only. 

C
au

ti
o

n
!

When performing Intermittent Switching (iSPI) between Ion beam 
patterning and SEM Imaging/Snapshot in the SEM Mode 2 
(Immersion/UHR), be aware of using "Do not Degauss" functionality. 
It may cause an ion image shift relative to formerly created pattern 
area (affecting the patterning location!). Allowing of the Degauss 
functionality prevents this behavior, but extend the switching time 
between the beams.

N
O

T
E You can expect to see a shadow mill when running in the SEM 

Mode 2 (Immersion/UHR). The shadow mill will be equal in width 
and height to the original mill. The depth is like a surface burn.
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End Point Monitor (EPM) 

The End Point Monitor gives visual feedback on the progress of a 
milling process. This device can be activated to start when 
patterning starts, stop when patterning is paused, and restart 
when patterning is continued.  

Table 7-5 Advanced Patterning Modules Overview (1 of 2)

Interface Item Description

iSPI 
tab

iSPI (Intermittent Switching between Patterning and Imaging) means 
that pattern progress can be automatically monitored with electron 
beam images at selectable intervals.  

On 
check box 

When ticked it starts the iSPI mode, in which the ion beam is paused 
during electron imaging to minimize the interferences 
If the Paterning menu / Auto-Start/Stop Electron Acquisition for 
iSPI item is ticked the system runs this functionality automatically, 
otherwise a user must release the electron beam display during 
patterning in another one. 
Note: When the On check box is not ticked, system runs in the SPI mode. 

Pause 
check box 

When ticked it pauses the patterning process after each electron image 
acquisition according to the Time Interval / CCS Line Interval slider, 
which sets the interval after which the system acquires an electron 
image. 

Save 
check box 

When ticked it starts storing of all images acquired during the 
patterning process (from all live displays). 
The name, destination and type of stored images are set in the 
Preferences / Movie section / File Settings area. 

Time Interval 
slider

Selects a time interval (x seconds) to take an electron beam image and 
pauses the electron imaging. 
For all patterns except the Cleaning Cross Section. 

CCS Line Interval 
slider

Selects the x number of slices to take an electron beam image 
and pauses the electron imaging. 
For the Cleaning Cross Section only. 
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End Point Monitor Plot Window

Monitor tab module can be enlarged to the End Point Monitor 
Plot window by clicking the black rectangle next to its label. It 
illustrates in live time the cutting depth progress monitored by the 
specimen current. This means the milling progress can be observed 
as a colored graphics showing the specimen current profile over 
the progressively milled area. 

Each time patterning is started a new graph is started 
automatically. Pausing / resuming of a patterning stops / 
continues to plot the graph. When serial patterning mode is set, 

Monitor 
tab

Shows a reduced view of the End Point Monitor Plot window. Click 
the black rectangle next to its label, without regard to be focused on 
any other module, to access full size Monitor window. The black 
rectangle changes, clicking on it again closes the Monitor window. See 
below this table.  

Progress 
tab

Use the Progress tab to monitor the progress of ongoing processes.  

Table 7-5 Advanced Patterning Modules Overview (2 of 2)

Interface Item Description
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there is only one graph, when parallel one is set, there can be more 
of them. 

To configure the window, right-click over the graphical area to 
access a menu and make a selection or use icons within the 
correspondingly labeled section.

 

 Grey Scale axis shows the average gray value for the iRTM 
image of the active pattern.

 X-axis menu (Dose / Depth / Time Elapsed): offers the choice for 
X-axis description. At least and only one can be selected at a 
time. 

 Browse menu (First / Previous / Current / Next / Last): offers 
choices to move from one graph to another. 

 Navigate menu: it is possible to enter Zoom In Mode to enlarge 
an inspected area or to Zoom Out the view. The Pan mode enables 
to scroll around in the enlarged area. The Reset choice returns a 
scale and pan to default. The Cursor is used browse to and to 
explore data points on each plot. 

 The Progress bar provides visual feedback on the progress of 
the patterning process. 

Figure 7-2 End Point Monitor Plot Window
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End Point Monitor Settings dialogue 

Clicking the Settings item opens dialogue to set basic plot 
parameters.  

 Initially the graph Plot Mode is Auto-Scale, meaning that the 
minimum and maximum of both axes are computed 
automatically so that the graph is completely visible. 
As points are added during patterning the graph may rescale 
to achieve this. It is possible to set X Scale % to keep graph 
scale in a fixed level. 

 Dragging a rectangle in the graph when in Zoom In Mode 
zooms in that rectangle and the graph switches to a Auto-Pan. 
In this mode the graph is automatically moved forward 
according to an Auto Pan % value. 

 The SE (Secondary Electrons) check box switches show of 
RTM curve in the Monitor graph. 

 The Stage Current check box switches show of stage 
(specimen) current in the Monitor graph. 

 Switching back to default is possible by clicking the Reset 
button or via the Navigate menu / Reset item. 

 The Apply button propagates new settings. 

Autosaving Images

The Save check box on the iSPI tab is used to save an image at each 
iSPI iteration.

 Once iSPI is started and Save is enabled, the system will save a 
new image at each iSPI iteration.

 You can enable/disable the Save functionality while iSPI is 
running.

Figure 7-3 End Point Monitor Plot Window
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 Once the patterning is started, if the Save check box is ticked, 
the Movie function will start recording and saving the images 
in the folder as defined in the Preferences > Movie menu.

 The AutoSave function will use the same options as set in the 
Preferences > Movie menu with the addition that the save 
only TIF option is selected. The timer is set to 0.2 seconds. This 
option will be set to the previous value once the patterning is 
finished or the Save check box is cleared.

 The naming conventions are the same as for the Movie 
function.

 The limitations are the same as for the Movie function (512 or 
1 k image, 0.5 time interval). If the resolution is outside the 
limits, the same behavior of the Movie function will be used 
and the following popup window will be shown.

 If the Save check box is cleared, the Movie function will be 
stopped and the TIF option of the Movie function will be set to 
the previous value.

 If patterning is stopped or finished, the Movie function will be 
stopped and the TIF option of the Movie function will be set to 
the previous value.

 If the iSPI check box is cleared, the Movie function will be 
stopped and the TIF option of the Movie function will be set to 
the previous value.

 If the Recording toolbar button is deselected manually by the 
user (note the Save check box is then forcibly cleared).

 If recording is already running (started manually by the 
Recording toolbar button), the Save check box is disabled.

Real Time Monitor 

The real time monitor (RTM) provides immediate feedback on the 
patterning process. The patterned area is observed and in case of 
relatively slow scanning, the scan trajectory can be inspected.

RTM is typically used for an end point detection by observing 
brightness differences in the detector signal. These result from 
contrast differences, e.g., when milling through layers of different 
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composition on a stack of multiple materials or releasing a TEM 
foil from the EasyLift tip.

RTM can be used with either beam (SEM and FIB), and with any of 
the pattern types that are available in the UI.

When starting patterning with the RTM activated, the pattern 
shape in the UI will be updated with real time image information. 
The patterned area information is updated based on the detector 
signal which is shown in synchronization with the beam trajectory. 
Because the detector signal is synchronized with the scan of the 
patterning beam (usually FIB), the other beam cannot be used to 
make a live imaging while patterning (iSPI mode: Simultaneous 
Imaging and Patterning cannot be used simultaneously with 
RTM). As an alternative, it is always possible to grab snapshot 
with the SEM during FIB patterning while using RTM. 

Starting and Stopping RTM

The RTM will run if two conditions are met:

 Patterning is active.

 Patterning menu / Autostart Real Time Monitor item is 
activated, or imaging in the ion display with the pattern is 
unpaused.  

These conditions can be realized in two ways:

 Start patterning while the Autostart Real Time Monitor item 
is activated.

 Unpause the imaging in the same display where a patterning 
task is running.

If the SEM image is live at the moment the RTM is activated, it is 
automatically frozen. After patterning (or when the RTM is turned 
off), SEM imaging will not be resumed automatically.

The RTM is automatically stopped:
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 Whenever a pattern is reset or finishes because the total 
patterning has elapsed.

 After a snapshot is taken in the same display where the 
patterning is active. This is to prevent the RTM information 
from instantaneously overwriting the snapshot image.

 When SPI mode is activated during patterning.

To force the RTM to stop while patterning continuous, click Pause 
with the FIB-display active. The same can be done to manually 
start the RTM with the FIB-display active.

RTM and FIB Snapshots

The following procedure assumes that the patterning beam is the 
ion beam, and the pattern is defined and running in display 2. 
Similar behavior is valid for other displays or when the SEM is the 
patterning beam.

In order to have both RTM information and FIB snapshot 
information available, the latter needs to be taken in a different 
display, e.g., display 3.

In the following procedure, the display number can be different.

1. Select Patterning > Autostart Real Time Monitor.
2. Define the pattern in display 2 (FIB display).
3. Set display 3 to FIB.
4. Start patterning in display 2. This will automatically start the 

RTM.
5. Click in display 3 to activate it. 
6. Take snapshots as required.

Following these steps, display 2 will continuously update with 
fresh RTM information as the ion beam is executing the pattern. In 
the mean time, you can take FIB snapshots as often as needed.

As an alternative, the RTM can be restarted manually by clicking 
on the Pause button in the same display, as described above.
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Blackout Pattern Area for RTM

When selected on the Patterning menu, the pattern background 
where the RTM is shown is made black in order to enhance the 
visibility of the RTM information. This is especially important for 
patterns with extremely large pitch or very thin lines.  

The images in the following figure illustrate the difference with 
and without blackout. Note that with the blackout, the visibility of 
the individual patterning pixels is greatly enhanced.  

Figure 7-4 With and Without Blackout

With Blackout Without Blackout
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Rocking Polish 
Rocking polish is a technique used to reduce the effect of 
curtaining caused by differential milling rates from surface 
topography or differences in sample materials. This technique is 
achieved by using two alternating milling angles on the cross-
section face during the final polishing step.

Figure 7-5 Cross section: with curtains / Rocking polished  

Prerequisites 
 Platinum deposition (or your metal of choice) is ready to use. 

 Check that the compucentric rotation inaccuracy is less than 
50 μm; otherwise run the Stage Alignments > Stage Rotation 
Center alignment.

 The I-column: Alignments > Beam Shift Alignment is done for all 
the ion beam currents which are going to be used.

Rocking Mill Holder / Carrier installation 

Tools needed:

 2.5 and 1.5 mm hex keys 

 Alway use the dust-free gloves appropriate for vacuum usage 

Procedure for UXe / CXe models 
1. Click the Vacuum module > Vent button.

2. Set the Sample Exchange > Holder type > Other Accessory. 

3. Set stage rotation to 0°. 

4. Remove any sample holder (if present) from the stage. 

5. The two keyed-pin holes (purple ovals) and the three screw 
holes (purple arrows) serve to mount the Rocking Mill holder; 
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to the stage in only one position (looking from the front): the 
beveled edge slopes to the left and faces the ion column.
Take care to push the Rocking Mill holder down flat before 
tightening the screws!  

6. Use the 2.5 mm hex key to tighten the three screws. Do not 
overtighten. 

Procedure for HXe model 

The sample exchange takes place with use of the Loadlock Rocking 
Mill carrier. 

Sample loading 

Prerequisites 

The maximum sample dimension is
 UXe / CXe: (30 × 30 × 5) mm; the Rocking Mill holder travel 

range is over the central (25 × 25) mm. 

 HXe: (25 × 25) mm; the Rocking Mill carrier can accommodate 
up to the 25 mm (1") diameter stubs on the 30° pre-tilted 
position.

Procedure for UXe / CXe models 
1. Click the Vacuum module > Vent button.

2. Set stage rotation to 90°, so that set screws are accessible.

3. Mount the sample on the stub as flat as possible.

4. Load stub onto pre-tilted Rocking Mill holder. There are one 
horizontal and two tilted positions:

 Level top position can be used for regular applications.

 Upper tilted position for small samples 
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 Lower tilted position for larger samples v
The goal is to get the region of interest as close to the 
alignment line as possible.  

5. Rotate the stub, so that the top of the sample is on the lower 
side of the slope. Try to rotate it to the desired angle of the 
sample. 

6. Tighten the stub with the 1.5 mm hex key; use the alignment 
line as a guide to check the sample position.

7. Set stage rotation to 0°.

8. Click the Vacuum module > Pump button and wake the system.

Procedure for HXe model 
1. Mount the sample on the stub as flat as possible.

2. Load stub onto pre-tilted Rocking Mill carrier. 
The identifying feature of the carrier is an upper hole on the 
30° pre-tilted surface. Check the carrier with the loaded stub 
fits under the height gauge.  

3. Rotate the stub so that the top of the sample is on the lower 
side of the slope. Try to rotate it to the desired angle of the 
sample.

4. Tighten the stub with the 1.5 mm hex key; use the alignment 
line as a guide to check the sample position.

Sample stubs 
securing screws 

Sample stubs 
securing screw 
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5. Load the Rocking Mill Shuttle into the chamber and wake the 
system.

System setup

When the sample is loaded to the system, follow with the beams 
coincidence setup: 

6. Set the Sample Exchange > Holder type > Other Accessory. 

7. Roughly set the Eucentric position (see Chapter 7).

8. Set the Sample Exchange > Holder type > Rocking Mill Holder. 

9. At stage tilt 0°, in the electron imaging, bring a recognizable 
feature in the center of the screen.

10. In the ion imaging, raise or lower the stage until the same 
feature is in the center of the screen.

11. Link Z to FWD.

12. Setting the stage tilt to 22°, sets the 30° pre-tilted surface 
perpendicular to the ion beam. 

Related software features 

When you select Rocking Mill Holder / Carrier along with the ticked 
Stage module > Z-Y Link check box, the software tilts the stage 
allowing the stage to move along multiple axes to keep the 
working distance consistent. 

Within an ion imaging, the working distance is only maintained 
for Get moves (see Chapter 7) or moves in the motion pages. The 
Track moves (such as with the joystick or middle-mouse button) are 
not supported for keeping the working distance.

When you tick the Stage module > Compucentric Rotation check box 
and the rotation changes, the software calculates new X, Y 
coordinates to bring the center feature back to the beam.

Some restrictions are placed on stage motion for sample and 
system safety: Rotation range is limited to ± 90° and only one 
sample can be used at a time if the rotation is more than 90°. 

Rocking Polish module 

The module with controls is accessible on the Rocking Polish page 
(modified Patterning page). Clicking the down / up arrow for the 
Fiducial Parameters and for the Rocking Polish Parameters expands / 
collapse the controls fully. 
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Figure 7-6 Rocking Polish module  

 Ticking the Create Fiducial check box creates Deposition Pad 
used as part of the alignment mark with set Fiducial 
parameters. 

Deposition Pad – fiducial parameters for a deposition pad used as 
part of the alignment mark.

 Application: Choose the application file for the deposition 
material you want to use for the fiducial pad (typically Pt_M).
If you do not want or need a deposition, then set the 
Application file to Si and the Pad Height to 1 nm. 

 Z Size: Thickness of the fiducial pad, which is typically set to 
1 μm. Thicker depositions take more time.

 Pattern Current density: Beam current into the pattern area. For 
Pt, this is typically set to 10 A/m2 for a time-optimized pad. 

Milled Feature – fiducial parameters for a cross-milled section into 
the deposition pad for an alignment mark.
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 Application: Application file for milling the fiducial feature in 
the pad. This is typically set to Si.

 Z Size: Depth of the fiducial feature. This is typically set 
between half and double the pad thickness, but the same as the 
pad height (1 μm). 

 Beam Current used for milling the fiducial feature. This 
depends on the size of the feature, 15 nA works well. 

 Take SEM image after each cycle: tick this check box to take a 
SEM picture after each cycle. This is useful for attended 
milling, but it prolongs the process. 

Basic setup – rocking polish parameters 

 Rocking Tilt: Angle in degrees to rock to the side. It will rock + 
and – this angle. Use 5–12°. 

 Sample Holder Pre-tilt: Use 30°.

 X / Y Size: Width / Height of the rocking polish mill. 
Type the value in the field or drag the yellow border.  

 Y Size: Height of the rocking polish mill. The Type the value by 
typing in the field or by dragging the yellow box (see image on 
the next page).

 Step Advance: Type the value, typically from 50–90% of the 
beam diameter. Higher values are associated with finer 
polishing, but require more time to process. One option is to 
draw a cleaning cross section at the beam current you are 
going to use and refer to the Y pitch size.

Operations 

Perform the following tasks to set up the rocking polish technique.

Rocking polish set up 
1. On the Navigation page, click Compucentric Rotation and 

then click Z-Y Link.
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2. Use the stage X and Y (or active Nav-Cam) to locate your 
feature.

3. Once you locate your feature, double check the height by 
keeping the tilt at 22 degrees while centering your feature in 
the SEM (double-click or joystick). Then while FIB imaging, 
raise or lower the stage until the same feature is centered. It 
should still be centered in the SEM.

4. If needed, use Align Rotate to set the precise rotation of your 
feature within +/- 10 degrees rotation of the stage.

5. Use normal cross-section methods for a bulk cross section 
straight down and deposition if desired. Make it 25-50% wider 
to allow room for the rocking angles.

6. Check the coincidence height by acquiring a SEM and FIB 
image to confirm that the same feature is centered. Do the 
following if you need to adjust the height:
a. Position the feature in the center of the FIB image.

b. Click the Z-Y Link check box to deselect this software 
feature.

c. Start imaging in the SEM. Move Stage Z up or down until 
the feature is centered in the SEM image.

d. Click the Z-Y Link check box to select this software feature.

7. Click the Pattern Start button in the vertical toolbar to open the 
Rocking Polish panel.

8. Click the Create Fiducial check box to select it. You might 
leave this unchecked if there is already a fiducial that you 
want to use instead.

9. Click the Show Shapes button.

10. Insert the MultiChem (or GIS) for deposition.

11. Drag the boxes around to where you want them.

 The red/green box is for the fiducial placement. The 
red/green fiducial box should be at least ~1/8 the size of X 
Size of the cross section.

 The yellow box is where the rocking polish cleaning cross-
section pattern will go.

12. Choose the beam current that you want to use for the FIB 
cross-sectioning. Set the focus, stigmator, and contrast 
brightness.

13. Choose the SEM settings you want for the images: horizontal 
field width (HFW), current, voltage, scan speed, frame size, 
detector, contrast-brightness, and lens mode. 

14. Set the fiducial parameters to the following:
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 Deposition Pad: Application = Pt_M; Z Size = 1 μm; 
Beam Current Density = 10 A/m2

 Milled Feature: Application = Si; Z Size = 1 μm; 
Beam Current = 15 nA

15. Confirm that the SEM scan rotation is at 0° if you want to use 
Dynamic Focus. Set up the scan speed and HFW that you want 
for the images.

16. Click the Start button on the Rocking Polish page. Do not click 
the Pattern Start button on the vertical toolbar.

Rocking polish cycles

The following actions are allowed during the rocking polish cycles.

 Observe the progress time remaining for each pattern (first the 
fiducial deposition, then the fiducial milling, and then the 
cross section) toward the top of the page.

 Change the SEM settings of contrast, brightness, scan speed, 
and frame size. The live imaging settings are used for the 
periodic SEM images.

 If the depth you want is achieved for a slice, then click the next 
pattern. Monitoring the End Point Monitor can help you 
decide since this feature speeds up operation.

 Click Cancel if the process is not working correctly or if you 
are finished. Let the process finish resetting the position before 
you work with the microscope.

 Grab SEM images during milling by choosing them in the SEM 
quad and then click Snapshot from the toolbar.

 Watch live milling by choosing the SEM quad and then 
unpausing the SEM. Secondary electrons from milling will be 
present, so you will need a beam current that is equal or 
greater than the FIB to get a decent SEM image (frame 
averaging helps the image quality). Press F6 to unpause each 
cycle individually.

 Click the Take SEM image after each cycle check box to 
deselect this option if the process is proceeding well and if it 
saves you time. You can select this option later if you want to 
get an update on the progress.

 You can read the Basic Setup parameters between each cycle 
and change them during the process. For example, it can be 
beneficial to start out with a smaller Z size and then increase it 
over time if needed. 
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View the sample with the SEM

Perform the following procedure to view the sample top-down 
with the SEM for locating the region of interest.

1. From the milling view position, click the Add button on the 
Navigation page to save the position if you want to get back to 
it.

2. Confirm that the Compucentric Rotation and Z-Y Link are 
both enabled.

3. Tilt the stage to 0°.

4. Set sample holder to Bulk Holder.

5. Set Rotate Relative to 180°.

6. Set the sample holder to Rocking Mill Holder.

7. Set the Tilt to 30°.

8. Set Scan Rotate to 180°.

9. Start scanning with SEM.

10. Save this position if you want to come back to it later.

11. To go back to milling position, recall your stored location and 
set the scan rotation back to 0°. If you manually reverse the 
steps, then you have to set the sample holder to Bulk Holder to 
rotate the stage. The sample is now ready for you to scan it 
with the FIB.

Note 
In the SEM view, the working distance is maintained by the holder 
selection and Z-Y Link during joystick use and double clicks. Get 
stage moves if the stage is rotated to exactly 180 degrees and is 
closely approximated if the stage is near that rotation value. 

Calculate rocking polish mill width (X size)

You need to know how deep you want to mill, generally around 
10–25% deeper than the feature. This formula will calculate how 
much wider you need to make the cross-section pattern to allow 
the rocked milling to sweep by the bottom of your desired cross 
section at a given rocking tilt.

Wider [μm] = 2× depth [μm] × tan [°] (rocking angle)

Operational tips
 You can use CAD navigation with the pre-tilted holder using 

the SEM settings described above and the stage tilt set at 0°. 
Start with the alignment point that is highest. Do not change 
stage Z, but refocus at each alignment point and the 
navigation locations.
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 Tilt correction for the scan does not work with scan-rotated 
images and the rocking polish process uses scan rotation. You 
can use the annotation measurements. Set the tilt correction for 
the measurement to the type you want (cross section or 
surface), set the tilt to manual, and then enter the combined tilt 
value.

Troubleshoot

Fiducial not found
 If you have set up everything, it has made the fiducial, and 

during the mill setup you get a “Fiducial Not Found” error, 
then the process will return to the milling view to wait for 
your instructions. Check the AutoContrastBrightness, reduce 
the Rocking Tilt angle, and change the field of view (it should 
be 2 to 4 times larger than the X size of the pattern). Check the 
quality of the fiducial mark to confirm that it is clear in the 
image.

 If the sample is charging during the initial viewing and you 
get a “Fiducial Not Found”error, first start imaging and then 
while imaging start the rocking polish process.

 If you get a “Fiducial Not Found” error after the first 
acquisition, then remember to clear the Create Fiducial check 
box before restarting the Rocking Mill. With Show Shapes 
turned on, move the fiducial box to make it red so that it will 
reacquire the mark. Otherwise, it will reuse the existing 
acquisition which may not work as expected.
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Application files
Application files are used with various gas types. With multiple 
GIS’s / MultiChem installed on your system, you can select 
particular types of patterning by selecting an application file for a 
given pattern. Milling on specific materials without gas is also 
more efficiently done with the appropriate scanning conditions 
using the dedicated application file for that material.

Application files are sorted and shown according to the beam, 
pattern shape type, and the gas type available within the system. It 
is possible to set the Application files, that are shown within the UI 
on the Preferences dialog / Pattern Applications section. 

Setting Application File

Select the required Application file from the Properties tab / Basic 
Properties / Application item drop-down menu. This is now the 
active application file for the selected pattern. 

The Gas Type, Gas Flow and Needle Position are predefined 
within the application file and are set automatically. To change any 
of these parameters, click in the editable value field of a particular 
item for editing.  

Application files are sorted and shown according to the beam, 
pattern shape type, and the gas type available within the system. 

It is possible to set the Application files, that are shown within the 
UI on the Preferences dialog / Pattern Applications section. 
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Silicon Application File (Non-Gas-Assisted) 

For the silicon application file, the following patterning properties 
are defined.  

The parameters above are used for non-gas assisted milling. In this 
case and if the overlap is positive, the mill time can be calculated 
based on the volume per dose parameter and beam current.

Therefore:

For example, create a filled box pattern 5 μm × 5 μm × 2 μm as X, Y, 
and Z values (the desired volume of material to be milled: 
50 cubic μm) and choose 500 pA (0.5 nA), which is 0.5 nano-
coulombs per second.

Therefore: 

If you change the Z depth from 2 to 4 microns, the desired volume 
would be twice as large and the milling time would show 
22 min. 13 sec. Doubling the beam current cuts milling time in half.

Table 7-1 Silicon Application File (Non-Gas-Assisted)

Property *.xml Description

Beam type ion

Dwell time 1.0e-6 s The time the beam spends on a single pixel per pass.

Overlap 50% Sets the beam diameter overlap.

Volume per dose 0,27 μm3/nC Describes the amount of volume of material 
removed per charge; previously called sputter rate.

volumneperdose volume
ch earg
-------------------- cubicmicrons

nanocoulombs
---------------------------------------- cubicmicrons

beamcurrent time
-------------------------------------------------------= = =

millt ime cubicmicrons
beamcurrent volumeperdose
--------------------------------------------------------------------------------------=

millt ime 50 cubicmicrons
0,5 nanocoulombsper ondsec 0,15
------------------------------------------------------------------------------------------------ 666,6 ondssec 11 minutes· 6 ondssec= = =
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Tungsten Application File (Gas-Assisted)

For the tungsten application file (as an example), the following 
patterning properties are defined.  

The dwell time, volume per dose, and interaction diameter are 
material- and beam-specific.

Refresh time and blur can be added if required for certain 
applications, i.e., blur for depositing large areas and refresh time 
for filling vias.

The relative interaction diameter induces a pitch between two 
spots. A relative interaction diameter of 0% and 0% overlap results 
in a pitch of 1 time the beam diameter. A relative interaction 
diameter of 100% and 0% overlap results in a pitch of twice the 
beam diameter.

Custom application files

If a patterning use case requires alternative or custom properties 
configuration, a new application file can be created or the current 
one can be edited. Right-clicking above the Application file name 
shows a menu enabling the option to save the changed file as a 
.xml file. 

A list of common volume per dose values (sputter rates) for 
various materials can be found in the following table. These are all 
values for 30 kV. 

Table 7-2 Tungsten Application File (Gas-Assisted)

Property W Dep Description

Beam type ion

Dwell time 250 e-9 s The time the beam spends on a single pixel per pass.

Overlap –50% Sets the beam diameter overlap.

Volume per dose 0.025 μm3/nC Describes the amount of volume of material removed 
per charge; previously called sputter rate.

Refresh time 0 Used to add additional waiting time between each 
pattern pass.

Blur 0 Defocuses the beam to increase deposition for large 
depositions.

Relative interaction diameter 
(RID)

150% Adds additional pitch width to increase deposition 
rate. A 150% RID results in a pitch of 2.5 times the spot 
diameter.
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Table 7-3 Material Volume per Dose Rates at 30 kV

Material Volume per Dose (µm3/nC) Material Volume per Dose (µm3/nC)

C 0.18 Au 1.50

Si 0.27 MgO 0.27

Al 0.30 SiO2 0.24

Ti 0.37 Al2O3 0.08

Cr 0.10 TiO 0.15

Fe 0.29 Si3N4 0.20

Ni 0.14 TiN 0.15

Cu 0.25 Fe2O3 0.25

Mo 0.12 GaAs 0.61

Ta 0.32 Pt 0.23

W 0.12 PMMA 0.40
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Milling 
When the procedure in “Beginning Your Session” on page 162 is 
satisfied, you can begin establishing a pattern to mill on the sample 
material.  

Process Optimizing 

Beam Current / Milling Times

The appropriate beam current value depends on the sample to be 
milled and your experience with the sample material. Lower beam 
currents are less destructive and take longer to mill. The beam 
current and milling times in the following table are guidelines 
only. Specific parameters depend on your sample material and 
objectives.

Magnification and Patterns

If your magnification is too high, milling certain patterns can use 
too much memory. If it is too low, the pattern corners become 
round and the edges are jagged. A good rule of thumb is to pick a 
magnification where your pattern fills 35 – 50% of the screen.

Table 7-4 Beam Current/Milling Times by Application

Application Suggested Time

Typical cross section 
(< 20 µm wide)

Try for a total time of 5 – 15 minutes, using 2.4 to 6.5 nA of current. 
Larger currents cause more damage around the recess and produce 
vertical walls, such as cut face angle. 

Large cross section 
(very wide or deep)

Expect longer milling times (15 – 20 minutes or more), beware of drifts. 

Cleaning cross section Use a value no less than ¼ – ½ of the main current used for cross 
sectioning. 

Drilling vias or cutting tracks A drilling time from 1 – 4 minutes is adequate. The main limitations of 
short drilling times are difficulty in doing endpoint detection and the 
possibility of damaging the sample.

C
au

ti
o

n
!

When performing Intermittent Switching (iSPI) between Ion beam 
patterning and SEM Imaging/Snapshot in the SEM Mode 2 
(Immersion/UHR), be aware of using "Do not Degauss" functionality. 
It may cause an ion image shift relative to formerly created pattern 
area (affecting the patterning location!). The Degauss functionality 
prevents this behavior, but extends the switching time between the 
beams.
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Stopping and Restarting

If at any time during milling or deposition you want to pause, click 
the Pause Patterning icon on the toolbar. When you continue 
patterning, the software continues the patterning process where it 
left off. If patterning is reset and restarted after patterns are 
modified, added, or deleted, it starts from the first pattern, and all 
patterning completed clocks are reset to zero.  

It is possible to acquire an image from the signals generated during 
patterning. All imaging parameters are dictated by the patterning 
requirements. Much better images can be acquired by a Snapshot 
during patterning. In this case patterning is paused, an image is 
grabbed and patterning resumes. 

Fine-Tuning Patterns

Use the MUI Shift X and Y knobs to fine-tune the image. Beam 
shifts are used in many applications, such as the low voltage box 
milling for lamella creation, to give a clean, vertical face to the 
section. Use Shift also to adjust for drift or charge effects. Grab a 
frame to monitor the change in mill position.

Milling procedure 
1. On the Patterning module or on the toolbar, select a pattern 

from the Pattern Selector and draw a pattern in the active 
display. When the selection is made, the blank area shows the 
relative icon, as shown. 

2. Select a beam for patterning from the toolbar.
3. Enter a value in μm as the depth in the property editor.
4. Select the milling aperture.
5. Set the eucentric position and the tool (if aligned) will have the 

best focused beam. 
6. If necessary, use the MUI Shift X and Y knobs or resize the 

pattern to correct positioning.
7. Snapshot a single frame to confirm the pattern position.
8. Select Patterning > Start Patterning or click Start Patterning on 

the toolbar to begin milling. The endpoint monitor 
automatically switches on.

N
O

T
E When patterning is paused in one display it is possible to start 

patterning in another one. Similarly when patterning finishes there 
may still be a paused patterning in another display.
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9. Select Patterning > Pause Patterning or click Pause Patterning 
on the toolbar to pause milling.

10. Select Patterning > Resume Patterning or click Resume 
Patterning on the toolbar to resume milling.

11. Selecting Patterning > Stop Patterning or clicking Stop 
Patterning on the toolbar during patterning or when 
patterning is paused resets milling (the button changes to 
inactive state – gray). 
Using this functionality during an image acquisition (F2 / F4) 
lets an acquisition to finish and subsequently the patterning is 
paused (the button changes to active state – black). It is possible 
to resume or to reset it by clicking an appropriate icon. 

Pressing F2 / F4 (snapshot / photo image acquisition) during 
patterning pauses the patterning and releases it again after 
acquisition finishes. Pressing F2 / F4 again or clicking the 
Resume button during image acquisition resumes the 
patterning immediately. 

Milling in Spot Mode

This procedure is convenient to drill holes with diameter 
depending on the beam size. 

1. Select the Scan menu / Spot mode. In this mode no scanning 
takes place. 
The single spot (green cross) cursor appears directly in the 
center of the screen. If the cursor is not moved the milling 
process will take place here otherwise click anywhere on the 
image to move the spot to another position. 

2. Move the feature to be drilled to the green cross cursor.
3. Start (or select Scan > Beam Blank to unblank) the beam. 
4. To acquire an image, click on the Snapshot button. 
5. Release (unpause) active display to proceed with milling. 
6. To exit spot mode, select the Scan menu / Full Frame item. 
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Milling a Bitmap
1. On the Patterning module, select a Bitmap Pattern from the 

Pattern Selector dropdown menu. 
2. Drag a square on the screen that represents the area of 

patterning. The position of the square can be changed by 
dragging.

3. Select File > Open. Load the bitmap using the Open dialog box. 
The bitmap appears in the imaging display.  

4. On the Patterning page, Advanced tab, modify the aspect ratio 
to Free or Fixed, depending if stretching the bitmap is required.

5. Optimize other properties such as applications file, depth, 
leading edge, etc.

6. Start patterning.

Selective Milling

Selective milling selectively scans an area of the sample based on 
the bright areas in the FIB image. It excludes bright or dark regions 
from the pattern area with user-adjustable histogram and refresh 
intervals.  

Sample Setup
1. Load the sample, ensuring it is well grounded.
2. Set the eucentric point and center the area of interest. Use a low 

beam current to minimize damage to the sample.

Mill Setup
1. Draw a mill box with the dimensions required.
2. Designate this box as a XeF2_Etch. 

3. Select an appropriate sized beam current.
 Start by using one that is approximately 30–40 pA/μm2.

N
O

T
E Make sure the BMP is located on the microscope PC and not on 

the support PC
Make sure the pattern is a 24-bit bitmap and not an 8-bit 
(256 color) bitmap.

N
O

T
E Selective milling works only in Serial mode or with one pattern. 

Patterns are limited to rectangle, circle, line, and polygon.

N
O

T
E Selective milling works with the default Si_Mill as well as with 

other gas enchants. XeF2 is used here for this specific use case.
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 If there is too much flashing or ESD events, select a smaller 
aperture.

4. Go to a sacrificial area on the sample.
5. Insert the GIS nozzles.
6. Start the mill and adjust the brightness and contrast such that 

you can begin to see the pixels milling in the iRTM. This step is 
valuable for selective milling.

7. Retract the nozzles and move to the location where you want to 
remove the oxide.

8. Insert the nozzles once again.
9. Position the mill box correctly over the region of interest.

Selective Mill Parameters 
1. On the Patterning page, select the Selective Mill tab module.  

2. Select Enable and then click Scan. 
The system will now scan the area of the pattern and evaluate 
the grayscale levels of the pixels within the pattern.

A histogram appears below a red bar on the tab. This shows 
the distribution of the number of pixels with grayscale values 
between 0 and 255. In this case, all pixels have low grayscale 
values because it is an oxide.

3. Click and drag the red bar to select the range of grayscale 
values you want to have milled. The red bar can also be moved 
by grabbing the black line “pole” under the red bar.
In this use case, you want only the dark pixels to be milled, so 
place the red bar as desired.  

N
O

T
E If you wanted to mill bright pixels instead of dark pixels, the red 

bar would be over to the right, indicating only high grayscale 
values are to be milled. An example of this would be milling 
through grounded metal to an oxide below.
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4. Select the number of seconds in the Interval slider that you 
want the pattern to be milling before the system rescans the 
pattern area to reassess the grayscale values. 

Start the Mill
1. Enter a high dose value or a long time amount, as this mill 

should stop automatically when there are no more pixels left 
with low grayscale values.

2. Select Patterning > Start Patterning or click Start Patterning on 
the toolbar to begin milling. 

3. As the mill progresses, there will be bright areas (high 
grayscale values) in the mill pattern, indicating the oxide has 
been removed and exposing the metal below. As Selective Mill 
rescans the pattern, it will identify these pixels and omit them 
from the milling. 

Figure 7-7 Selective Milling Progresses  

4. Monitor the bright and dark areas while the pattern is milling 
by adjusting the selected mill pixel range (red bar) either while 
it is milling or when it is paused.

5. After the pattern has completed, check to see if the metal is 
satisfactorily exposed. If not, either repeat this process or 
simply do a regular XeF2 mill for a few seconds.

The same area 
with the pattern 
paused.

Bright pixels 
begin to be 
excluded from 
the mill pattern.
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Verifying the Selective Mill
1. When the mill has stopped automatically, there should be no 

more pixels with low grayscale values left in the mill pattern, 
and the metal should be cleanly exposed.

2. Tilt the sample to approximately 45° and view the quality of 
the exposed surface. It should be flat and even with vertical 
side walls and no holes or spots, as shown below.  

3. If there is any oxide left, redo the Selective Mill.
4. If there are any holes in the metal, you may need to start over.

Creating Cross-Sections 

Cross sections are cut in a multipass fashion to allow the exposed 
layers to be seen when the stage is tilted to 52°.

Mill a typical cross section in two or three stages:

1. The first stage is a regular cross section. 
2. For optional second stage use either filled box or cleaning cross 

section at a reduced current. (If the cross section is large, a 
second cleaning may be required at a lower current.)

3. For the third stage, use cleaning cross section to make the final 
cut.

Following image shows the relationship of these pattern areas and 
their relative size. A typical cross section is 10 – 20 μm wide by 7 –
15 μm tall with the dimensions and depth appropriate to the size 

of the target area of interest. 
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Figure 7-8 Typical Cross Section  

Be attentive to boxes positioning if you are sectioning a specific 
point. Use fine milling to expose the exact area of interest. For 
example, a 2 μm offset should be more than enough at 3 nA of 
current. Calculate the outline as the height of the box relative to the 
depth to be milled. If you intend to view at 52° and see details 3 μm 
from the surface, then the original box should be at least 3 μm tall.

Making the Cross Section

Mill a regular cross section with five superimposed box patterns 
sharing three common edges.

First Stage
1. Select a ion beam display by clicking in it and begin scanning.
2. Move the stage to where you want to mill the cross section.
3. Find the eucentric position.
4. Tilt the stage to 52°.
5. Save this position in the location list in the Stage module. (This 

is as far as the instructions take you in “Beginning Your Session” 
on page 162.

6. Align both beams by correcting the beams coincidence (see 
“Beams coincidence setting procedure” on page 166).

7. Optimize the ion beam image if necessary.
8. Restore the stage position you stored in Step 5.
9. From the toolbar, set the ion beam current between 93 pA and 

6.5 nA, depending on the size of the cross section (sometimes 
using the 21 nA is necessary).

10. Image briefly on the area to set the magnification and position.
11. Click Snapshot to grab an ion beam frame.
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12. Go to the Patterning page and select Regular Cross Section 
from the Pattern Selector menu. 

13. Bring the cursor to the image area and draw a rectangular box 
about 2 μm from the area of interest.

14. While still on the Patterning page, within the property editor 
set the Application to Si and enter the value for Depth as 
needed. Click Enter to update.

15. Click Snapshot to grab an ion beam frame.
16. Click the Start Patterning icon on the toolbar.
17. Use Snapshot to update your image as desired by grabbing a 

frame with the ion beam or electron beam.

Second Stage (Optional)

Use the Cleaning Cross Section from the Patterning page, Pattern 
Selector menu, at a reduced current for this step.

1. From the toolbar, set the ion beam current to approximately ¼ 
of the beam current used for the first cut.

2. Click Snapshot to grab an ion beam frame.
3. Click Cleaning Cross Section. Bring the cursor to the image 

area and draw a rectangular box. Adjust its size so that its 
leading face is approximately 0.2 μm from the target area and 
the trailing edge extends just beyond the rough cut.

4. Snapshot another ion beam frame to verify alignment of the 
pattern to the feature.

5. Click on the Start Patterning icon in the toolbar.
6. Click in a new display, click the Electron Beam toolbar button, 

and begin scanning. 

7. Click Snapshot to grab a frame to view the electron beam 
image.

N
O

T
E Remember to fill in the depth of your cross section in the 

properties editor on the Patterning page.
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Third Stage 

Use the Cleaning Cross Section from the Patterning page, Pattern 
Selector menu, for this final step.

1. If the cut is too rough, change the ion beam current between 
0.28 nA and 0.92 nA. Adjust focus as needed.

2. In the patterning display, click Snapshot to grab an I-Beam 
frame.

3. Click Cleaning Cross Section. Bring the cursor to the image 
area and draw a rectangular box. Adjust its size so that its 
leading face crosses the target area and the trailing edge 
extends just beyond the rough cut.  

4. Click Snapshot to grab an ion beam frame and click the Start 
Patterning toolbar button.

5. Click in a new display, click the Electron Beam toolbar button, 
and begin scanning. 

6. Click Snapshot to grab a frame to view the electron beam 
image.

N
O

T
E Remember to fill in the depth of your cross section in the property 

editor on the Patterning page.
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Multipass

The fastest way to do the rough milling part of a cross section at a 
given beam current is to do the equivalent of two or more cleaning 
cross-section patterns over the pattern area, i.e., a multipass 
pattern where one multipass is a set of line patterns that move 
from bottom to top of the patterned area. Each line mill contains 
the number of passes needed to reach a fraction of the specified 
depth where this fraction is equal to the depth divided by the 
number of multi passes. This is the default mode.

The enhancement in the rate is because the beam is always milling 
on an edge which enhances the sputtering yield. If only one pass is 
made then redeposition effects tend to backfill the section. This 
prevents the SEM from seeing the full section face. By making 
several passes, typically 2 or 3, then a cleaner removal is achieved 
enabling the SEM to view into the cross section at the 52o angle.

AutoTEM already makes use of a similar function, where a series 
of narrow box patterns are used with typically two passes. The use 
of boxes rather than lines is to minimize the overhead of pattern 
creation for AutoTEM.

Two parameters are used:

 Multipass: Number of passes

 Scan ratio: The actual value used is the dose delivered at the 
first line divided by the dose delivered at the last line of the 
pattern.
For example:

A scan ratio of 0.25 means it will deliver 4 times the dose at the 
finishing line as it does at the first line and the lines in between 
are linearly interpolated. 

A scan ratio of 2 means the dose delivered at the first line is 
2 times that of the finishing line.

Multipass Pattern Improvements

The multipass pattern has been reworked from the previous 
version. The scan ratio calculation is now more stable and the 
scanning methodology has been slightly changed to help pattern 
efficiency and speed. The “scar” on the left hand side of the pattern 
and the “bump” at the finishing edge have been eliminated. The 
multipass pattern is now the default instead of stairstep milling.
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Viewing the Cross Section

After cutting the cross section, switch to SEM imaging and acquire 
an overview image of the cross section without the need to move 
the stage. The following figure shows examples of some typical 
milling views of a cross section.

Figure 7-9 Cross Section Views  

Perspective view of the cross 
section milled on the edge of a 
sample

Top view of the cross section

Cross-section view. This view was 
done to show the geometry of the 
cross section. 
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The following image shows the relationship of the columns and 
stage to the face of the cross section during milling and how this is 
viewed onscreen, depending on whether you image with the 
electron or ion beam.

Figure 7-10 Cross Section Viewing During Milling

Ion column
Electron column

St
ag

e

52° stage tilt

Cross-section face

Onscreen views

Viewing with I-Beam Viewing with E-Beam

(Not to Scale)

Cross-section face Cross-section face

Not 
visible

Completely visible
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The following image shows the onscreen view with the stage at 0° 
tilt, with both the electron and ion beam imaging views.

Figure 7-11 Cross Section Viewing at 0° Tilt

Ion column
Electron column

Cross-section face

0° stage tilt

Stage

Shallow end

Viewing with I-Beam Viewing with E-Beam

Cross-section face Cross-section face

Not 
visible

Not 
visibleOnscreen views

(Not to Scale)

Tilted View into shallow 
end of cross section
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The following image shows the onscreen views with the stage still 
at 0° tilt, but with both stage and scan rotation at 180°.

Figure 7-12 Viewing at 0° Tilt Rotated 180°

Ion column Electron column

Stage

Cross-section face

0° stage tilt, 180° rotation
scan rotation 180°

Viewing with I-Beam Viewing with E-Beam

Tilted view into 
cross section

Not 
visible

Completely visible

Cross-section face

Onscreen views

(Not to Scale)
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8 Gas Injection System & MultiChem 

Different gas types are used to deposit on or etch away material 
surfaces. A gas type is allocated to each gas injector, and up to five 
gas injectors can be mounted on the system. 

If the system has an EasyLift, then only gas injection systems 
(GIS’es) mounted to the port No. 4 may be used!  

Gas Injection module
The Gas Injection module on the Patterning page enables to select 
the type of gas deposition or etch material.  

For the MultiChem item controls description within the Gas 
Injection module see below.  

Table 8-1 Gas Injection Module Overview

Interface Item Description

colored circle Shows the assigned color of all installed gasses.

Gas Shows the installed gas name. Hover the mouse over a particular gas 
name to see the tooltip for its Lifetime

Insert check box Shows the insertion status for each gas: 
• Ticked: inserted 
• Cleared: retracted

Heat Shows the heat status for each gas.

Flow Toggles between closed or open. 
Shows the current set point for the pulsed valve for each chemistry. 
Double-click on the Flow to change the set point

W
A

R
N

IN
G

! GIS & MultiChem chemicals are hazardous! Read the User safety 
manual before starting GIS operation! 
In case the Platinum deposition (Pt dep) GIS was used simultaneously 
with the CryoMAT Loader and/or CryoCleanerEC, always run the 
decontamination procedure (see the User safety manual “Pt deposition 
chemical” chapter). 
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Color and Hatching of Pattern shape 

When patterning with the electron / ion beam, the pattern shape is 
hatched / crosshatched. 

When no gas is assigned to a pattern, the shape is in yellow. 
A disabled pattern is in gray. 

When patterning with GIS, entire shape is colored according to gas 
being used. 

When patterning with MultiChem, entire shape is always in 
orange and the colored circle (corresponding to the color of gas 
being used) is shown above the pattern. When a mixture of gasses 
is used, more colored circles are shown.   

Table 8-2   

MultiChem color code GIS color code 

X C Dep Tea green C dep Tea Green

Enhanced Etch Red Del Etch Light Purple

Au dep Melrose Dx Del Light Green

IDEP2 (w/H2O) Aqua Enh Etch Blue

IEE Fuchsia IEE Fuchsia

X Pt dep Lime Ins Dep Yellow

SCE Navy blue Pt Dep Lime

X W dep Green SCE Dark Red

O2 Malibu W Dep Green

CF4 Blush pink

Dx Delayering Yellow

DE Navy blue
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Setting up the GIS 

Set up the GIS to be used before patterning is started. It can be held 
heated and inserted, but not opened, until it is ready to use. 

When not in use, the GIS should be closed, cold, and retracted. 
Leaving it closed, heated, and retracted is also an option if it is to 
be used over several patterns so that reheating is not necessary.

A tool tip info is given about the selected GIS line: 

 Port # – GIS connection position 

 Lifetime – time of GIS employment 

Before the patterning with the GIS starts, the gas reservoir must be 
heated by clicking the Heat column / Cold status button.
The Cold status is replaced by a progress bar, which in turn is 
replaced by the Warm status when the GIS is fully heated. To cool 
down a reservoir, proceed in reverse order. 

To insert the GIS needle manually tick the Insert check box. 
A confirmation dialog appears. Ticking the Insert check box again 
retracts (cleared box) the GIS.  

In the confirmation dialog box that appears, click Yes if you know 
there is nothing obstructing the GIS needle travel. While the GIS 
needle is inserted, the stage can be moved slightly using Get or 
Track moves (see the “Stage Movement Limits ” on page 219).   

C
A
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Beware of stage moves while GIS is inserted! The GIS needle can 
be damaged by incautious stage movements!
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To open / close the GIS valve click on the Flow column / Closed / 
Open status. This will not be possible until the Heat column / 
Warm status is reached.  

In normal operation, the GIS opens automatically when patterning 
is started if an application file with a gas type is selected.

The GIS is now in operation and is either depositing or etching, 
depending on the chosen gas type. 

GIS Alignment  
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MultiChem 
The MultiChem sub-atmospheric gas delivery system is intended 
for use on Thermo Fisher Scientific microscopes as an 
improvement to the standard single Gas Injection System (GIS). It 
is capable of delivering gasses to a sample surface to perform beam 
chemistry processes under vacuum. 

The MultiChem allows up to six chemistries to be installed in a 
single port, mixing of supported combinations of gasses, and fine 
flow control, particularly for etching chemistries such as SCE and 
IEE. 

The gas heaters are turned off when the system is put into Sleep 
mode and restarted when the system is restarted with the Wake 
Up routine (see “System states” on page 27).

Port Installation

MultiChem can only be installed in Port 1 or Port 4 for Helios G4 
PFIB systems. 

Be aware of MultiChem/GiS port configuration: For TEM lamella 
preparation via. Lift-Out technique, Multichem/GiS can only be 
installed in Port 4 to avoid collision with EasyLift! 

Features
 MultiChem will use the standard GIS needle.

 Six Chemicals in One Port

 Two gas ports have water-cooled Peltier heaters/coolers that 
can cool to < 10° C.

 Up to two gas ports can be used for external gasses: O2 is 
currently supported, leaving one for future use.
External gas lines are NOT double contained and MUST 
NOT be used for hazardous gasses.

 Any number of gasses may be mixed in the mixing chamber 
prior to entering the needle. Compatibility is determined at 
setup and only compatible gasses are allowed to flow together.

Pulse Width Modulated Valves for Gas Flow Control
 Fixed frequency of 4 Hz with Flow (duty cycle) variable 

between 0.01% and 100%.

 Each gas port has a pulse width modulated (PWM) valve and 
an on/off delivery valve.
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Motorized Needle Positioning
 15 mm Insert/Retract motion is pneumatic.

 Two radial axes of motion (X-Y) with approximately –1 mm 
range.

 One axial axis of motion (Z) with +0 to –1.5 mm range from the 
eucentric position.

 Two stored positions: 0° /* 0° and 52° / 90° stage tilt. 

Integrated into UI
 Similar look and feel to the existing GIS controls in the same 

space. 

 Same insert / retract behavior as existing GIS.

MultiChem Module

The MultiChem is controlled via the Gas Injection module and the 
Property tab module on the Patterning and Sample Preparation 
control pages. It is used to control the installed gasses. Up to six 
gasses may be installed per MultiChem.   

Table 8-3 MultiChem Module overview (1 of 3)

Interface Item Description

(colored circle) Shows the assigned color for the gas. 

Gas / Multichem Shows the installed gas name. Hover the mouse over a particular gas 
name to see the tooltip for its Lifetime.  
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Insert 
check box

Shows the insertion status for the MultiChem nozzle. 
Ticking the check box has the same functionality as selecting Insert to 
Ion / Electron Default from the menu (right-click above the Gas 
name): inserts the nozzle according to the stage tilt angle – 0° / 52° 
electron / ion default position. 
When inserted, it is possible to Move the nozzle to Ion / Electron 
Default position or to Retract the nozzle by selecting a desired menu 
item. Clearing the check box has the same functionality as Retract item.  

Note: Any custom insert needle positions that were defined in the 
MultiChem Supervisor Alignment - Needle Alignment will also appear 
in the right-click menu.
Retracting the MultiChem nozzle is enabled even while patterning is in 
progress; the valve is immediately closed and the nozzle is retracted at 
the same time. This is desirable for working with etching gas. 

Heat Shows the heat status for each chemistry: 
• Off: The crucible is not heated. Click the Start Heating item from 

the right-click menu.  

The progress bar shows the heating status.  

• Ready: The crucible is heated, the chemistry is ready for injection.  

Table 8-3 MultiChem Module overview (2 of 3)

Interface Item Description
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Flow edit box If the nozzle is inserted, select Inject # item from the right-click menu 
or click the Ready button, the Preparing status appears. It is also 
possible to Stop Heating at this moment or to inject any allowed 
combination of gasses including that gas.  

Injecting is indicated by the Inject status and the highlighted 
background; click & right / left drag inside the box with the % value 
(cursor changes to the horizontal 
2-ended arrow) to increase / decrease a Flow rate or double-click the 
value to enter it.  

The value can be set from 0.01% to 100% with a higher percentage 
corresponding to a higher gas flow. A user can effectively change the 
level of gas Flow during the patterning process. 
The Flow can be limited for particular chemistries if the vapor pressure 
for that chemistry is too high to safely flow into the specimen chamber 
without compromising the vacuum. This limit is configured when 
installing a chemistry. 
If a pattern is started that specifies a Flow [%], then the flow will be set 
to the value defined in the pattern.
To use a custom flow for a pattern, set the Gas Flow in the Advanced 
Patterning tab (see “Starting a Manual Single Gas Flow” on page 312) or 
select a pattern that does not specify a gas and manually start and stop 
the gas injection.
Note: If you specify a Gas Flow % in the Advanced Properties, it will 
override the value set in the MultiChem module.
To Stop Injecting select the appropriate right-click menu item or click 
the Inject button, the Closing status appears.  

Table 8-3 MultiChem Module overview (3 of 3)

Interface Item Description
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Purging 

With the nozzle retracted, the only option is to Purge the gas, 
which will flow the chemistry into the fore line directly, bypassing 
the specimen chamber. The Purge option can be used if there is 
some suspicion that the crucible pressure is too high, but this 
should not be necessary in normal operation.  

The maximum Purge value can reach up to the Maximum allowed 
gas flow value set in the Chemical Maintenance Alignment 
(specific for each gas).

For the older Multichem version (model # 117135-0 – see the 
equipment label) the Purge function is not available for conductive 
material depositions, because its excessive use causes premature 
failure of components in the MultiChem. Use the following 
procedure to manually purge the gas into the specimen chamber: 

1. Insert the MultiChem nozzle.

2. Turn off the SEM and FIB High Voltage (the MultiChem 
nozzle should remain inserted, but the beams will be isolated 
in the event of a pressure burst). 

3. Double-click on the Flow [%] field for the chemistry to be 
purged. 

4. Change the Flow to 0.25%. 

5. Prepare to monitor the Specimen Chamber pressure. 

6. Begin flowing of the chemistry to be purged. 

7. Monitor the Specimen Chamber pressure. 
a) If the Specimen Chamber pressure rises above 8 e-5 mbar, 
then close the valve, decrease the Flow and go back to Step 6.

b) Wait until the Specimen Chamber pressure falls below 
2 e-5 mbar, then double the Flow (up to a maximum of 100%) 
and go back to Step 7.

8. Once the Flow has reached 100%, continue to monitor the 
Specimen Chamber pressure until it has stabilized.

9. Stop the gas Flow. 

10. Retract the MultiChem nozzle. 
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Basic Processes  

1. To insert the nozzle, right-click on the appropriate gas type 
and select Insert from the menu that appears.

2. Collect an image.

3. Place a pattern.

4. On the Basic tab, select an Application file for the defined 
given pattern. It automatically sets the appropriate gas, the 
dwell and overlap, and calculates the proper dose appropriate 
to the beam chemistry.

5. (optional) To set a custom flow (% of mixture), double-click 
Gas Flow and enter a value between 0.01% – 100%.

6. Start patterning (the gas flow will start automatically).

Starting a Manual Single Gas Flow
1. Insert the nozzle.

2. Set the Flow.

3. Double-click Ready.

Starting a Manual Mixed Gas Flow
1. Insert the nozzle.

2. Set the Flow for all gasses.

3. Right-click on one of the gasses in the mixture to access a 
menu and select the desired gas mixture.
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Insert the nozzle only when the sample is at eucentric position. Use 
caution when making stage moves while the nozzle is inserted to 
prevent damage to the nozzle.
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Crucible Exchange 

This procedure is used when empty crucible(s) is/are exchanged.   

Vent MultiChem   

1. Move the Fumex to within 6 feet of the MultiChem and 
connect the AC power cord to a wall socket near the system. 
Do not use system power for the Fumex unit! 

2. Attach the Fumex hose to the top of the double walled 
MultiChem cover. 
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It is possible to change any crucible when it is empty for the new one of 
the same type only. To change for any other gas type crucible it is 
necessary to call the Thermo Fisher Scientific service. 
For any crucible exchange it is necessary to use the external optional 
Fumex, otherwise this procedure is not allowed for users and it is 
necessary to call the Thermo Fisher Scientific service. 

C
A
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N Do not perform any operation without proper safety training. 

Chemical exposure is not expected, but as a precaution use gloves 
when handling MultiChem parts. 
Crucibles are heated and may still be hot when removing. Take caution 
to allow the crucible time to cool before handling.

C
A

U
T

IO
N

Fumex filters must be replaced every 12 months. 
Air velocity meter must be calibrated every 12 months (calibration of 
the air flow meter is the customer’s responsibility via a third party 
vendor). 
If either of these conditions are not met then MultiChem cannot be 
vented for crucible maintenance!
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Fumex must be attached and running at all times when MultiChem 
chamber is open. 
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3. Turn on the Fumex to full fan output.  

4. Using air velocity meter provided, verify the velocity in the 
center of the closed lid is > 3 m/s [600 ft./min]. If air flow does 
not meet specification do not continue with this work 
instruction.  

5. Loosen the MultiChem vent valve cap.  

6. Open MultiChem Supervisor Alignments (see below) and 
select Vacuum Actions (deselect other alignment listings). 

7. Click Run Selection. 

8. From the drop down menu, select the port that matches the 
MultiChem which requires vacuum action. 

9. Click Next. 

10. Switch off E and I beam, so that they are isolated. 

11. Click Vent MChem. 
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Consult Fumex manual for airflow remedy steps to correct airflow 
issue. If unable to resolve airflow issue, Contact Thermo Fisher 
Scientific to schedule a FSE to visit to replace the chemistry. 
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MultiChem Crucible Exchange 

Unpack new crucible  

12. Open the shipping box.

13. Remove the crucible container and open it with a blade 
screwdriver. 

14. Remove the new crucible from the Mylar bag.

15. Remove the crucible shipping screw from the bottom. Keep 
the shipping screw as this is required to be installed in the 
removed crucible. 

16. Place the crucible on a clean cloth or wipe in the upright 
position for 10 minutes before installing in the MultiChem. 
This allows for the chemical to settle inside crucible.  

Remove empty crucible(s) from Multichem 
17. Remove the top / bottom cover: 

Loosen 4 upper securing screws, slide the cover towards the 
back of the MultiChem and pull out.  
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MultiChem crucibles are single-use only and are not to be opened or 
refilled. Do not attempt to open crucibles or intentionally liberate 
contents by defeating safety protections.
Keep all packaging when performing a crucible replacement. The old 
crucible being removed from the MultiChem will be placed in this 
packaging.
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18. Release the Viton band from the chamber door and remove the 
MultiChem chamber cover.  

19. Identify which numbered MultiChem heater slot location will 
be replaced. The heater slots are numbered from 1-6 going 
counter clockwise. Slot numbers are machined on the side of 
the MultiChem. 

20. If the slot is already occupied, use the 7 mm wrench from the 
tool kit to remove the crucible. Turn the crucible 
(counterclockwise) 3 full turns until it is disengaged from the 
threads.  

When using the crucible ratchet to install / remove crucibles, 
place the ratchet end over the hex portion of the crucible and 
tilt the ratchet up. This will wedge the ratchet to the crucible 
and keep the wrench from sliding off. 



317

Gas Injection System & MultiChem   Basic Processes 

Thermo Fisher Scientific CONFIDENTIAL, Limited Rights Data

21. Using the long tweezers, remove the empty crucible from the 
chamber.   

22. Install the crucible shipping screw that was removed from the 
new crucible (see step 15) to the crucible just removed. Set this 
crucible to the side on a clean dry wipe, as it will need to be 
packaged for disposal. 

23. If replacing more crucibles, set each crucible on a clean dry 
wipe. Make note of the slot from which each crucible was 
removed as they will need to be installed in the identical slot of 
the new MultiChem. If the crucibles will not be placed back into 
the MultiChem, then install shipping screws into each crucible. 

Installing new crucible(s) into the MultiChem 
24. Using long tweezers, place crucible in the port from which the 

old crucible was removed (see step 21). 

25. Reach in and thread the crucible in as far as you can by hand.

26. Tighten the crucible using the 7 mm wrench. Do not over 
tighten (see step 20). 

27. Mount the Multichem top cover: 
Push the top cover into the MultiChem slots, slide toward the 
front of the MultiChem and tighten 4 upper securing screws.  
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Use caution when handling the crucibles since they still may be hot.
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Packing the removed crucible(s) 
28. Verify a crucible shipping screw has been installed in the 

crucible bottom (see step 15). 

29. Place the crucible into the Mylar bag, subsequently into the 
chemical container, and into the shipping box, all with 
appropriate chemical labels. It is the customer's responsibility 
to dispose of used chemistry.

Pump MultiChem and disconnect Fumex 

Repeat steps No. 6. / 7. / 8 / 9. 

30. Click Pump MChem to pump down the Multichem. When 
complete, click Finish. 

31. Tighten the vent cap. 

32. Disengage Fumex from MultiChem, turn it off and disconnect 
power. Store it per customer instruction. 
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Precautions 

 Logging off an actual user, closing or restarting the xT 
microscope Server / Microscope Control software does not 
change conditions of the MultiChem. It could be inserted or 
injecting under some circumstances. The system provides 
tooltips relevant to the actual state. 

 When not in use, the injection should be stopped (to save 
lifetime), and the nozzle retracted.

 The safety switch inside the MultiChem disallows valve usage 
at pressure > 0.5 atm. This prevents users from getting 
exposed to high temperatures within the enclosure. Messages 
are shown in the Application Status window.

 If the X or Y axis gets out of the allowed ± 0.5 mm range, the 
needle jog moves will automatically stop, but the other axis 
will continue to move. A message shows in the Application 
status window.  

 Given the advanced capabilities of the MultiChem unit, it is 
possible to operate the unit in a manner whereby one material 
may appear in adjoining layers; this is referred to as cross 
contamination.
This behavior is most commonly seen with platinum gas, as its 
physical composition allows itself to adhere to parts of the 
MultiChem mechanism. If you need advice, contact your local 
Thermo Fisher Scientific office and ask about the applications 
support services that we offer. Applications support is not 
covered by service contracts or warranties.
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Insert the nozzle only when the sample is at eucentric position. Use 
caution when making stage moves while the nozzle is inserted to 
prevent damage to the nozzle.
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MultiChem Gas Names
The MultiChem gas names will be a simplified and shortened 
version of the chemistry name. The individual chemistries may be 
used in more than one gas chemistry application, and that some 
chemistry applications are composed of more than one gas. 

For example, IDEP2 is TEOS and water vapor:

 TEOS by itself is not IDEP2, so it is misleading to name the 
TEOS port IDEP2

 Water vapor is used by itself as SCM, but it is also used in 
IDEP2

MultiChem Pattern Application Files
The Pattern Application File names will be with an “_M” 
appended to the end to denote, that it is a MultiChem application 
file.
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MultiChem Supervisor Alignments
Select one of the four supervisor alignments and click Run 
Selection. 
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Needle Positions Alignment 

Follow the guided instructions.  
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Needle Placement Using a Circle Measurement Tool
1. Define a circle measurement tool with a 100 μm diameter on 

the SEM and FIB images and place the center of the circle at 
the center of the image.

2. Position the nozzle so the edge of the nozzle is within a couple 
microns of the edge of the circle when viewed with either 
beam. This will place the needle at the 50 μm distance from the 
image center, as required for the alignment procedure.  

3. Note the stage Z-axis value at the working height (usually 
eucentric or coincident point). While live imaging, slowly and 
carefully raise the stage until the sample touches the nozzle 
and a touch alarm is generated OR the nozzle deflects. 
If the nozzle begins deflecting immediately upon raising the 
stage, then the nozzle was touching at the working height: in 
this case lower the stage until the nozzle is no longer touching 
and repeat the step 2. 

Determine the distance of the nozzle from the working height 
by subtracting the z-axis value at working height from the 
value at which the sample touched the nozzle. If the nozzle is 
not 150 μm ± 15 μm above the working height, then raise or 
lower the nozzle as necessary and repeat the step 2.

4. Once the nozzle position is correct, update the nozzle position 
prior to retracting the nozzle (retracting prior to saving will 
cause the nozzle position to go back to the previously stored 
position). Re-insert the nozzle and verify that it goes back to 
the correct position.

SEM Image FIB Image
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Creating a Custom User Position
1. Move the nozzle to the desired position.

2. Click Add to create a new User Position entry in the position 
dropdown list.

3. Verify that the newly-created position is selected and click 
Rename.

4. Enter the desired name for the new position and click Finish. 

5. Verify that the name has changed and that the newly-created 
position is selected and then click Update to store the position.  
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New Crucible Evacuation (degassing) 

Follow the guided instructions. This alignment should evacuate all 
selected crucibles one at a time. This will save time when installing 
more crucibles at once.  
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Vacuum Actions 

Follow the guided instructions. 
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9 Alignments

This chapter describes procedures for aligning the electron and ion 
columns for Thermo Fisher Scientific trained users and users. All 
alignment procedures take place on the Alignments page.

Topics include:

 “About Alignments” on page 328

 “General Description and Structure” on page 331

 “Alignment List” on page 333

 “E-column: Emitter Startup” on page 335

 “E-Column: User Alignments” on page 336

 “E-Column: Supervisor Alignments” on page 337

 “E-Column: Auto U-Mode Source Centering” on page 338

 “E-Column: Aperture Map Selection” on page 339

 “E-Column: Magnification Correction” on page 340

 “E-Column: Supervisor tests” on page 341

 “I-column: Aperture Lifetime” on page 343

 “I-column: Alignments” on page 344

 “Stage Alignments” on page 346

 “External Plasma Cleaning / Plasma Cleaning” on page 347

 “Vacuum Actions” on page 349

 “Automatic Alignments” on page 351

C
A

U
T

IO
N Read this entire 

chapter before 
attempting any 
alignment corrections.
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About Alignments
When all necessary alignments are performed properly, the beam 
moves through the column with maximum transmission, with 
minimum beam aberrations, the image will stay in focus, its 
rotation will be corrected, and it will not show a substantial image 
displacement when voltage and/or beam current are changed. 
Further more, the ion beam and electron beam should be in 
coincidence and report the same sample location accurate for 
milling/imaging purposes.

During electronic alignment, image motion is minimized and 
correcting beam astigmatism and focus are adjusted for each of the 
ion beam apertures. Additionally, image shift is corrected as 
necessary.

Ion column alignment procedures for the Phoenix and Tomahawk 
columns consist of mechanical and electronic beam manipulations 
to correct asymmetries. These corrections are made to give the best 
beam performance over a full range of operations.

During alignment procedures, you are allowed to change 
magnification and scanning speed, to use reduced area, and to 
optimize image brightness and contrast. If it is not prohibited for a 
particular alignment, you can also stigmate and focus the image. 
However, you cannot manually change the mode or high voltage 
or use the beam shift during an alignment procedure.

N
O

T
E Ion column electronic alignment is VERY important for the successful 

performance of automatic scripts, e.g., AutoTEM™ and AutoFIB™.

N
O

T
E

Do not use Beam Shift at any time during the adjustment procedures, 
other than where specified, as this may be set to zero value at each 
section, and extra movement can offset the zero condition. All 
movement of the specimen can be made using the stage, either 
mechanical or motor driven, where appropriate.
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Recommendation 

To maintain your system in a good condition it is recommended to 
run specific alignments periodically, as stated in the following 
table:  

The Alignment Monitor (see further) arranges necessary 
alignments to be executed within the set period of time 
automatically. 

Table 9-1 Periodical alignments 

Alignment group Alignment Period [day] Model

E-column: 
Supervisor alignments

Source Centering U-Mode 2 UX 

Source Tilt & Shift N-Mode 7 UX 

Source Tilt & Shift U-Mode 7 UX 

Stigmator HR 14 UX / CX

Source Tilt & Shift 7 CX

Lens Align & Stigmator UHR 7 UX / CX

I-column: Alignments Beam Alignments 7 UX / CX

Beam Shift Alignments 7 UX / CX
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Preliminary Conditions
 It is assumed that the Thermo Fisher Scientific trained service 

engineer’s mechanical alignment of the column is correct 
before the user can properly perform the software user 
alignment.

 Before starting the alignment, the sample should be at 
eucentric position, and the ion beam shift on the Beam Control 
page should be set to zero.

 Before aligning the electron column, be sure that the final lens 
aperture is clean and properly centred.

Common Rules 
 Alignments should be performed in display 1 to ensure the 

correct functionality of the Contrast, Brightness, and Auto 
functions used on the Alignments pages. 

 During adjustment procedures, you can change the 
magnification, the scanning speed, use reduced area, and 
optimize image contrast / brightness. You can also correct 
astigmatism and focus an image (although for a particular 
alignment this is not allowed). 

 During adjustment procedures, do not change a Spot size or a 
High Voltage. Do not use the Beam Shift at any time during 
the adjustment procedures, as this is set to the zero value at 
each alignment section. All specimen movements can be made 
using the stage where appropriate. 

Service Alignments

Only Thermo Fisher Scientific Service engineers with password 
access can enter the Service Alignments page. 
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General Description and Structure

Common Elements

All software alignments (except Aperture) have the same page 
form and common elements:

 An outline of the function

 Alignment commands

 Step-by-step instructions - Follow the instructions given in the 
Instructions module. The Step shows the present control step 
number and the total number of steps. 

Buttons and Control Elements 

The following particular buttons and control elements have the 
same behaviors for all alignment procedures, when available: 

 The Start button starts the procedure and proceeds with 
following dialogues.

 The End button moves a user to the last step (by clicking the 
Next button) to be able to finish the alignment procedure. 

 The Contrast / Brightness adjusters enable to optimize the 
image quality during alignment. 

 The Auto button executes the appropriate alignment action 
automatically for a particular voltage / spot / direction 
(whatever suitable) with the use of the Image Recognition 
software. If this utility does not recognize image features well, 
the procedure is aborted and Warning message appears 
onscreen. In this case change the imaging conditions (better 
focus, slower scanning, or lower magnification) and try again. 

 The Crossover button activates the Crossover mode, where the 
onscreen image shows the electron source tip instead of the 
sample.  
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Alignment Commands  

Click Start and proceed with the next set of instructions. 

Tips for X and Y Corrective Movement

Alignments may require some corrective movements in X anY 
direction at the same time. This is simplified by X and Y being 
represented as a 2D X-Y control (graphical adjuster).  

Click on the 2D box and hold down the left mouse button; a cross-
hair shows onscreen with a small 4-ended arrow cursor located in 
the center. By moving the mouse, the cross-hairs move and affect 
the image as required. Due to the fact that the probe rotation 
correction is switched off automatically in some alignment 
procedures, the X and Y movements may not always appear to be 
in the same directions.

Table 9-2 Alignment Commands

Button Description

Start Starts the alignment procedure.

Next Moves you to the following page after all the necessary settings have 
been selected.

Previous Takes you to the previous page if the previous setting needs to be 
changed.

Finish Completes the procedure and saves the new settings.

Save Saves the actual settings at that point.

Cancel Returns to the start without changing the original settings or the 
settings saved the last time SAVE was clicked.
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Alignment List 
On the Alignments page, open the list box and then choose the 
Alignment needed. 

Figure 9-1 Helios G4 PFIB HXe  

Electron Beam 
 Emitter Startup: Enables IGP’s and electron gun - Emitter 

switching On / Off.

 E-column: User Alignments: Set of User level electron beam 
adjustment procedures 
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 E-column: Supervisor Alignments: Set of electron beam 
adjustment procedures 

 E-column: Auto U-Mode Source Centering UC+: Automatic 
alignment centers the beam through U-mode aperture.

 E-column: Aperture Map Selection: Enables to set a second 
set of final lens apertures in case the image quality deteriorates 
(one or more actually used apertures are worn out). 

 E-column: Magnification Correction: User magnification 
calibration (see Beam menu item). 

 E-column: Supervisor tests: Set of system test procedures 

Ion Beam 
 210 - Ion Column Alignment 

 I-column: Aperture Lifetime 

 I-column: Alignments 

 Source Mechanical Alignment 

Stages 
 Stage Alignments (set of utilities): 

Stage Rotation Center – sets the stage rotation centre for the 
compucentric rotation. 

EasyLift 
 EasyLift: Needle Exchange/Calibration: Option – see 

“EasyLift: Needle Exchange/Calibration Alignment” on page 241. 

MultiChem 
 MultiChem Supervisor Alignments: Option – see “MultiChem 

Supervisor Alignments” on page 321. 

Others 
 External Plasma Cleaning / Plasma Cleaning: Enables the 

chamber plasma cleaning and sets time of specimen plasma 
cleaning 

 Vacuum Actions: Set of vacuum utilities not available from 
the UI.

 GIS Alignment: Option – see “GIS Alignment” on page 306. 

 Quick Loader Alignment: Option – see “Quick Loader 
Alignment” on page 391. 

 Detectors Alignments: Set of MD, ICD and ABS detectors 
calibration.
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E-column: Emitter Startup 
This procedure enables IGP’s (Ion Getter Pumps) and electron 
source switching On/Off in cases of emergency shut down or if the 
microscope mains switches off.   

N
O

T
E If the Emitter On button is disabled and the IGP´s are running, restart 

the xT microscope Server and try again.
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E-Column: User Alignments
 

 Source Tilt And Shift N-Mode: Centers the electron source tilt 
and shift. 

 U-Mode Source Centering: Centers the UC beam through 
U-mode slits.

 U-Mode Source Tilt: Sets up the Source Tilt values to get the 
beam through the EBA (Electron Beam Aperture) for different 
HV and UI probe values, and the source Shift values to direct 
the beam through the center of the HR lens.

 Switch E-Beam off: 
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E-Column: Supervisor Alignments 
 

 Alignment Range Editor 

 Auto Couple Z to WD 

 Source Tilt and Shift N-Mode / U-Mode: Sets up the Source 
Tilt values to get the beam through the EBA (Electron Beam 
Limiting Aperture) for different HV and UI probe values, and 
the source Shift values to direct the beam through the center of 
the HR lens.

 Source Centering U-Mode Supervisor: 

 Stigmator HR: Sets up the table values for different HV of the 
Stigmator balance and astigmatism correction in HR mode.

 Lens Align & Stigmator UHR for Supervisor: Sets up the 
table values for different HV on the Lens Alignment, 
Stigmator balance and astigmatism correction in Mode 2 
(Immersion/UHR). Eliminates image shift during focusing 
and/or normal astigmatism correction in Mode 2.

 Switch E Beam Off 



Alignments    E-Column: Auto U-Mode Source Centering

338

Thermo Fisher Scientific CONFIDENTIAL, Limited Rights Data 

E-Column: Auto U-Mode Source Centering 
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E-Column: Aperture Map Selection 
Try to change the aperture map when imaging is poor or the 
astigmatism can not be corrected.  
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E-Column: Magnification Correction 
This utility is intended to enhance factory calibration accuracy 
under particular, user selectable conditions:

 Lens mode

 Working distance

 High voltage

 Stage bias

 Pole-piece accessory.   
N

O
T

E Select Beam > Magnification Correction only for calibrated 
conditions, otherwise it could worsen magnification accuracy. 
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E-Column: Supervisor tests 
 

 Lens Bottom test 



Alignments    210 - Ion Column Alignment

342

Thermo Fisher Scientific CONFIDENTIAL, Limited Rights Data 

210 - Ion Column Alignment 
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I-column: Aperture Lifetime 
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I-column: Alignments 
 

 Sample Alignment: 

 Aperture Alignment: 

 Beam Alignment: 

 Beam Shift Alignment: 

 Beam Current Verification: 

 Logout: 
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Source Mechanical Alignment 
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Stage Alignments
 

 Stage Rotation Centre: The stage rotation has a mechanical 
center and it can be controlled by changing the Stage module / 
R value. The stage moves around its mechanical center. In 
some cases this is not desired because a rotation around the 
field of view center would be more useful. 
Make sure the stage tilt is zero during alignment. The 
magnification should be from 500× to 2 000× and the sample 
should have a well recognizable feature at least 10 mm from 
the center to improve accuracy.
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External Plasma Cleaning / Plasma Cleaning 
When a repeated Sample Cleaning procedure is not effective (see 
“Sample Cleaning” on page 77), click the Start / Stop Chamber 
Cleaning button, its Duration could be much longer. 

If longer plasma cleaning time is needed it is recommended to use 
several shorter plasma cleaning cycles separated by pumping the 
chamber down to HiVac mode. Residuals created during plasma 
cleaning are pumped away and following plasma cleaning is more 
effective. Adjust the Cycle duration, Clean cycles and Pumping 
time between cycles.  

C
A

U
T

IO
N

Always retract EDS / 
WDS / EBSD detector 
before plasma cleaning 
procedure! 
Do not leave sensitive 
samples (including 
Au-C resolution test 
samples) in the 
chamber during 
Chamber Cleaning 
(it may be damaged). 

N
O

T
E If there is an external Evactron plasma cleaner, follow the External 

Plasma Cleaning alignment instruction and the Evactron user 
manual!
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Vacuum Actions
 Start / Stop IGP’s – enables to start / stop vacuum pumps in 

case of power failure / emergency or service actions

 Pump / Vent Action – enables to pump / vent particular 
vacuum system sections 
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Detectors Alignments 
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Automatic Alignments 
Some of Alignments are not numbered and run in a different 
environment; they are actually the set of alignments. Most of the 
procedures could run automatically by ticking the Automatic 
check box placed next to the red star. 

During the procedure, informational windows can be turned on / 
off by the Show/Hide Window button. Cancel the alignment 
sequence or continue by the Next button.

If you have selected any e-beam alignment procedure and you 
want to select any other one, you must Finish or Cancel an opened 
procedure first. To start alignment procedure or to stop one in 
progress, right-click over the red star and select the required action 
(Start/Stop). A confirmation dialog is shown. 

By clicking the Cancel button, by selecting the Stop item in the 
menu (see below) or by closing the UI, nothing is saved (see 
Restore old results below). 

In all cases, the alignment windows over the displays disappear 
and the Stop Execution dialog appears.

C
A

U
T

IO
N

Read carefully the instructions provided by the system before 
proceeding with any alignment.
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The last page of every alignment offers one or more of the 
following possibilities:  

 Restore old values and finish: Undoes the adjustments, 
nothing will be saved.

 Save new results and finish: Keeps new adjustment values 
and saves them. Also creates a new Restore Point.

Results 

The result of every step is shown by means of an icon in the result 
list when performing alignment steps. 
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 Unavailable: The result has never been obtained, at least not 
by this procedure. This may mean that it has never run, or that 
it failed to do anything meaningful (the difference between 
these two is not important). 

 Reliable: The result is trusted by the automatic procedure OR 
a user has passed the alignment step manually (i.e., we trust 
that a user actually performed the alignment step). 

 Unreliable: The automatic procedure has done meaningful 
work, but could not decide whether the obtained result can be 
trusted. This suggests you should review the result manually.

 Out of range: The automatic procedure trusts that the optimal 
outcome is outside the range of the variable to be aligned. 
A value is set that is near the border of the range. 
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10 Applications 

There are several software applications accessible via the menu bar 
thermoscientific drop down menu: 

 Account Management – allows to organize users and accounts 
(see “Account Manager Application” on page 356). 

 Data BackUp – allows to backup all system settings according 
to the account (see “Data BackUp Application” on page 361). 

 Auto Report – when requiring a service intervention this 
utility enables to send the demand and the Report about the 
microscope system states (see “Diagnostic Auto Report 
Application” on page 362).
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Account Manager Application 
Within this application it is possible to organize microscope user 
accounts: creation and removal of user accounts, setting of user 
account name, description and password as well as copying and 
removal of user data. 

Account administration 

Start the software by clicking the menu bar thermoscientific drop 
down list / Account Manager icon or by clicking the xT 
Microscope Server window / Service tools button / Account 
Manager icon.  

File menu 

To manage accounts it is necessary to Log on at first. Active User 
is indicated in the bottom left corner of the application window 
together with a total Number of Users (accounts). First the 
application starts with just one User account, default credentials 
for the Log On dialog are: 

 User: Supervisor 

 Password: Supervisor 
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To exit the application click the Exit item.

Manage Accounts menu / 
User Actions area / Supervisor Actions area 

Items within this menu have the same functionality as buttons 
within the User and Supervisor Actions areas placed on the right 
side of the main application window. 

 

Table 10-1 Manage Accounts menu Overview (1 of 2)

Menu Selection Description

Change password Changes a password of an active account. For the Supervisor level 
account it is advisable to change the password after the first log on.  

A Supervisor can change the password for any user level account. 
The password has to be confirmed.

Change Description Changes Account Description of an active account. After entering 
new description confirmation dialog appears.  

A Supervisor can change description for any user level account.

Reset User Data Resets user data of an active account to default settings.  

A Supervisor can reset user data for any user level account. 
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Copy Userdata Copies user data from a selected user account to the active user 
account.  

Create Account Adds a new user account.  

Only Supervisor can create new user level account. 

Remove Account Deletes a selected account and its user data.  

Only Supervisor can delete any user level account. 

Table 10-1 Manage Accounts menu Overview (2 of 2)

Menu Selection Description
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User Accounts area 

Any user can export accounts settings to the .reg file by clicking the 
Export… button. 

Only a Supervisor can Import… user accounts exported to the .reg 
file by ticking the appropriate check box(es).  

User Logins and Account Settings

Each user login account stores a variety of preference and 
configuration data in the registry. These values are then restored 
when that user logs back into the system.

Two main sets of data that are stored:

 Overall Layout and Settings for the UI, 

 Preference Dialog Settings. 

When a new user account is created the system database 
(Windows registry) is not populated with every possible setting. 
Rather what happens is that some values are only stored as the 
user changes them. For example, the MUI sensitivity settings are 
saved to the registry only once a user makes a change to one or 
more of the settings. Before that point the values the user will see 
when logging in are inherited from the Supervisor user account. 
This has the benefit of allowing all new user accounts to default to 
the same values that the Supervisor has already been using.

If the Supervisor makes a change to a parameter which other users 
have never adjusted, other users will inherit the change from the 
Supervisor user when they log in (as they have no settings of their 
own). 

As soon as the user makes any preference setting, then they will be 
creating registry entries and will see their own adjusted settings 
each time they log in, independent of what the Supervisor does. 
This issue mainly applies to some setting in the preference dialog 
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(e.g., MUI, scan settings) and to some other specific UI items like 
end-point detection settings.

The Account Manager application software also allows the 
administrator to copy settings between user accounts. For 
example, if the Supervisor settings were applied to other accounts 
then the next time these other accounts login they will have the 
same preference settings as the Supervisor. In this case subsequent 
changes of the Supervisor's MUI values (for example) would not 
be inherited by the other user accounts even if they do not make 
any MUI changes themselves as they now have their own registry 
values for these parameters.

Overall Layout and Settings for the UI 

Overall stored settings:

 Electron and ion beam settings (HV, current, HFW)

 Dwell, resolution, position for each beam in full frame, 
reduced area, line, and spot modes 

 Detector settings (bias voltages, etc.)

Stored settings for each display:

 Active beam (electron, ion, optical)

 Image save file path

 Image save settings (databar or overlays included)

Stored settings for each beam in each display:

 Active detector 

 Detector subsettings for all detectors (is CDEM in SE or SI 
mode)

 Detector mixing settings

 Digital brightness/contrast/gamma settings

 Databar text

 Zoom and pan (shift) values for digital zoom mode

Other parameters, such as the end point detection area settings are 
also stored per user.
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Data BackUp Application 
This application allows to store / restore all system and user data.  
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Diagnostic Auto Report Application 
This application enables to create the report when requiring the 
service intervention.  
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11 Maintenance

This section describes necessary microscope maintenance 
procedures that can be carried out by the user. Topics include:

 “Cleaning Procedures Overview” on page 364

 “Stage Maintenance” on page 366  

User maintenance is at a minimum due to gun and column design 
providing a long uptime. Therefore, a complicated maintenance is 
normally a part of a service contract to be performed by a qualified 
service engineer.

At the user level, the first approach to clean the system is to use the 
Tools menu / Sample cleaning… (see “Sample Cleaning” on 
page 77). When this is not satisfactory, try to clean polluted column 
parts (see bellow).   

C
A

U
T

IO
N Before any maintenance action, check the vacuum interlock status in 

the Sample exchange window / Vacuum tab / Sensor States area. 
The circle in the Chamber Pressure HiVac and Chamber Pressure 
LoVac lines must be red! 

C
A

U
T

IO
N

Parts that operate in vacuum should be handled carefully using clean 
powder-free gloves. Parts not in use should be stored in suitable 
containers or packed in aluminium foil.
The EDX window (option) is very fragile and must be protected from 
large pressure oscillations. It is also recommended to remove the 
detector before major cleaning activities.
Be aware of removing the chamber door locking screw(s), used during 
an instrument transportation (labeled REMOVE)! If these are installed, 
an overpressure over 20 kPa (150 Torr, 0.2 bar) can arise inside the 
chamber during the vent procedure (N2), which is harmful to the EDX 
window, if installed.

N
O

T
E

Gas back fill (N2) should be maintained while the specimen chamber 
is at ambient pressure. However, to avoid gas waste it is 
recommended the chamber should be left vented no longer than 
necessary.
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Cleaning Procedures Overview
Frequency of cleaning is, in most cases, determined by necessity 
due to poor image quality or gross astigmatism level. 
Recommended cleaning procedures are given below for parts 
which operate in vacuum and are subject to possible 
contamination.

List Of Applied Cleaners
 De-ionized or distilled water – H2O

 Ethanol – C2H5OH

 Ethanol p/a (Pro Analysis: 99.8% pure) – C2H5OH

 Isopropanol

 Neutral pH cleaning fluid (soap solution)

 CIF* or SOFT SCRUB (fine abrasive household cleaner) or 
0.05 ìm aluminous powder   

Table 11-1 Household Cleaners

Country Name

Austria CIF

Australia CIF

Finland CIF

France CIF

Germany CIF

Italy CIF

Japan CIF

Netherlands CIF

Switzerland CIF

UK CIF

USA Soft Scrub

W
A

R
N

IN
G

!

The cleaning solvents ethanol and isopropanol are highly flammable! 
Do not use open flames and do not smoke while cleaning. Ventilate 
the room properly.
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Cleaning Column Parts

All column parts are polished before the instrument is delivered. 
For this reason only occasional light polishing is required to 
remove contamination that may build up on components in the 
specimen chamber as part of normal operation. Any part that is 
exposed to the electron beam should be highly polished, and free 
of contamination and/or scratches that can charge and thus 
degrade the image.  

Materials and Technique

To polish components, place a lint-free cloth on a flat surface (a 
glass block is ideal) and apply a small amount of Soft Scrub or CIF 
and distilled water to the cloth.

Place the part to be cleaned on the polish and rub with a circular 
motion until all contamination has been removed. For inner 
surfaces, use a cotton swab or wooden dowel as an applicator. A 
toothpick can be used for small holes.

Lint-free nylon (not cotton) or latex surgical gloves should be worn 
while handling parts to avoid contaminating just-cleaned surfaces. 
Tweezers should be used to hold small parts.

After the part has been polished, remove the Soft Scrub/CIF 
cleaner by washing in hot water. Inspect the part under a stereo 
microscope at 20× magnification to ensure that there is no 
remaining contamination or polish residue. Wash the part in de-
ionized or distilled water in a beaker with an ultrasonic cleaner for 
several minutes. Transfer the part to a clean beaker with alcohol or 
isopropanol and clean ultrasonically again for several minutes.

When the components are dry (a compressed air ‘duster’ can speed 
drying), reassemble and return to the column. If a part is stained, 
heat it with hot water and immediately rinse with alcohol and dry 
using compressed air.
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Gold plated parts should not be polished with abrasive.
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Cleaning Tips

Parts exposed to the electron beam require periodic polishing. This 
will ensure maximum performance of the instrument for many 
years.

Do not use metal polishes such as POL or WENOL to clean parts as 
these can leave outgassing material. Be aware that threaded 
surfaces should not be polished as these do not have contact to the 
beam and are a source of outgassing if polish is trapped. Wash 
threads with alcohol or isopropanol, if absolutely necessary.

After cleaning, inspect all parts for residue and stains using a light 
microscope.

Stage Maintenance

Stage Mechanics

Checking the condition of the stage should be a weekly exercise as 
many different samples may be exchanged in this time period. 
Some samples may be powders or composite materials that 
inadvertently drop particles on or in the stage. If a silicon wafer 
breaks in the chamber it can shatter into hundreds of pieces. In this 
case the stage should be thoroughly cleaned before attempting 
movement again.

Cleaning Stage Parts

Abrasive and solvents must not be used on the moving stage parts. 
Cleaning by a suction is the ideal method. If not available, cleaning 
should be done by using dry nitrogen gas bursts around the stage 
mechanics to blow out any foreign materials. Make sure the final 
lens and detectors are protected from the turbulence. Do not use 
sharp metal objects to scrape away debris. A fine pair of plastic 
tweezers can be used to pick up difficult particles. Spillage on the 
stage should be wiped up using a lint-free cloth, followed by 
suction or blowing with clean gaseous nitrogen.
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Specimen Holders

Recommended cleaning procedures are given below for parts that 
operate in vacuum and are subject to possible contamination. 
Frequency of cleaning is, in most cases, determined by necessity 
(image quality or astigmatism level).

Cleaning
1. Clean these parts using a lint free cloth and a mild abrasive 

domestic cleaner.

2. Rinse in tap water.

3. Clean in an ultrasonic cleaner for 5 minutes using distilled 
water.

4. Clean in an ultrasonic cleaner for 5 minutes using alcohol p/a 
or isopropanol.

5. Rinse in alcohol p/a.

6. First blow dry with a compressed air canister, then dry 
thoroughly under an infra-red lamp (15 min to 1 hr) at a 
temperature of between 80 °C and 100 °C. Do not bake in an 
oven!
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Do not place parts together in the beakers. Wash separately as 
damage can occur to the metal surfaces. 
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12 System Options

This chapter covers hardware and software that is an option either 
integrated in, or accessory to the system.

Topics include:

 “External Current Measurement (Keithley Picoamper Meter)” on 
page 375

 “Fast Beam Blanker” on page 376

 “Multi Stub Holder” on page 376

 “I-Beam Charge Neutralizer” on page 377

 “CryoCleanerEC” on page 380

 “Quick Loader” on page 386

Contact your Thermo Fisher Scientific sales representative for more up-
to-date information on system options.

For information on other options, see:

 “Nav-Cam (In-Chamber Navigation Camera)” on page 232

 “Directional Backscattered Detector (DBS) Angular Backscattered 
Detector (ABS) Concentric Backscattered Detector (CBS)” on 
page 177

 “STEM Detector” on page 179

 “MultiChem” on page 307
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Manual User Interface
The manual user interface (MUI) provides an ergonomic interface 
with rotary knobs to perform functions that can also be performed 
with the software.  

 Imaging: contrast and brightness control

 Stigmator: X and Y control

 Magnification: continuous magnification control up / down

 Shift: X and Y image shift control

 Focus: coarse and fine control

MUI Software Equivalents  

Customization 

Sensitivity can be adjusted for all controls except Magnification by 
presetting the various sliders via the Preferences dialog / 
Sensitivity section (see “Sensitivity Section” on page 143). 

Table 12-1 MUI Software Control Equivalents

MUI Software Equivalent

Image Contrast Brightness Contrast and brightness adjusters on pages or Auto Contrast and 
Brightness buttons on the toolbar.

Stigmator Shift + right mouse button

Magnification +/- keys on numeric keypad. Shift + mouse wheel-click for fine 
control. Ctrl + mouse wheel-click for coarse control.
Additional operation combinations:
Ctrl + Magnification wheel for increase/decrease digital zoom.

Beam Shift Shift + click 
Additional operation combinations:
Ctrl + beam shift: clockwise moves viewport to left (shift X) and down 
(shift Y). Sensitivity depends on sensitivity set in Preferences.

Focus Right-click mouse button
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Manual User Interface GC 
The extended manual user interface (MUI GC) provides an 
ergonomic interface with rotary knobs and 6 programmable 
shortcut buttons to control Thermo Fisher Scientific Dual and 
Single beam scope.  

Customization 

The MUI GC Knobs sensitivity (1) can be adjusted for all controls 
except Magnification. It can be set separately for the electron and 
ion beams: 

1. Click on the display that has the desired beam and change the 
slider in the MUI customization tab to the desired value. 

2. Click the OK button to save changes. 

3. Programmable Buttons (2) functionality can be set by clicking 
any … button and selection of a desired command.  

1 – Rotary controls (Knobs) 

2 – Programmable buttons for 
shortcuts with displays

3 – Keyboard 

4 – E-beam Snapshot 
(in display 1)
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Joystick 
The Joystick provides controls to perform stage functions that can 
also be performed by the software. It is connected to a USB 
connector located on the Microscope computer.  

 Button 1 – not used 

 Lever (3) operating: 
– Up / Down moves the stage in the Y axis direction 
– Left / Right moves the stage in the X axis direction 
– Clockwise / Counterclockwise rotates the stage clockwise / 
counterclockwise 

 Button 2 pressed while operating the Lever: 
– Up / Down moves the stage up / down 
(regardless of the Link Z to FWD status) 
– Left / Right tilts the stage 

 Button 3 speeds up the stage motion: 
– 10× in X / Y axis 
– 5× in Z axis 
– 2× in R / T axis  

1

2

3
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Your joystick may 
look slightly different 
than the one shown in 
the figure.

N
O

T
E The joystick is automatically disabled during milling when the axes 

are locked.
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Uninterruptible Power Supply (UPS) 
If the power failures occur occasionally it is recommended to use 
the microscope UPS, which maintains the vacuum in the electron 
source section. 

In case the microscope system is powered by the UPS and a mains 
power failure happens, the system starts 10 minutes countdown to 
switch to the safe mode. User is informed about the countdown 
progress in the application status window. If the mains power is 
recovered within this time, the countdown is cancelled and 
nothing happens.  

After 10 minutes of continuous power off a shutdown to the safe 
mode with following actions is activated: 

 FEG emission is gently switched off

 Ion emission is gently switched off

 Chamber is vented

 UI is stopped

 xT microscope Server is stopped

 Microscope console is switched to the Standby mode 

 Microscope controller and the support computer (if present) 
are switched off 
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Because the Emitter IGP’s are supported by the UPS, some parts of 
the microscope are still under power.
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To return the system to an operation follow the startup procedure 
(see Chapter 2). When the xT microscope Server is launched the 
first time from the safe mode, a dialog is shown to inform a user.  

N
O

T
E A Thermo Fisher Scientific trained user must restart the system after a 

longer power failure. If the Startup procedure fails, contact an Thermo 
Fisher Scientific service engineer.
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External Current Measurement 
(Keithley Picoamper Meter)

When Stage > External Current Measurement is selected, it is 
expected to have a Keithley picoamper meter connected to the 
External Connectors panel / Specimen Current connector, located 
on the back side of the microscope console. 

Figure 12-1 External Connectors Panel  

In this case, the Status bar / Specimen current value is Ext and the 
meter readout shows actual specimen current.   

N
O

T
E When the Stage menu / External Current Measurement is not selected, 

switch the picoamper meter off or disconnect it.
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Fast Beam Blanker
This equipment is used to protect sensitive samples from the 
electron beam. The beam is blanked while moving the beam to the 
starting point of a new line, frame, or pattern.

Multi Stub Holder
This is an option for some systems.

The Multi-stub Holder with 7-stub holding disc is provided with 
the microscope as an option.

It has a spring clip fitting and the threaded shaft which screws into 
the stage rotation head center and can be securely attached to the 
stage by means of the conical locking piece.

Torx Drivers

Within the kit are two Torx drivers to complete the fitting of the 
interfacing parts. All screws for interfacing connections are Torx. 
All screws for clamping sample stubs are of the Hex-key type. The 
appropriate Hex-key tool is standard with the system and not 
found in this kit.
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When the Fast Beam Blanker is used, electron current measurement 
may be lower than actual value. This inaccuracy is higher at fast 
scanning times. To obtain an exact electron current value use the Spot 
mode at a sample area, which is not sensitive or important. 
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I-Beam Charge Neutralizer
The I-Beam Charge Neutralizer uses a low energy electron beam to 
control charging induced by the ion beam. This allows imaging 
and patterning of nonconductive materials and reduces 
electrostatic discharge-related sample damage (by spreading 
electrons on the sample).

All controls are available from the Charge Neutralizer tabbed 
module on the Patterning page. 

Values could be adjusted even while the beam is off in the ranges:

 Filament current: from 0 to 1.43 [A]

 Grid voltage: from –5 to +5 [V]

 Beam energy: from 28 to 200 [eV] 

1. Verify whether the correct detector mode is selected to enable 
the Charge Neutralizer usage:
 The ETD is recommended to use with negative Grid 

Voltage values (Custom mode). Positive Grid Voltage 
values are enabled, but detector can be saturated. 

 The TLD can be used only with negative Suction Tube 
Voltage values in Custom mode.

 The ICE detector is recommended to use in Secondary Ion 
mode / with negative Grid Voltage values (Custom mode). 
Positive Grid Voltage values are enabled, but detector can 
be saturated.

2. Click the Beam On button to switch on the Filament current 
(the filament starts to generate electrons and is heated).

3. Start the charge neutralizer by clicking the Unblank button. 
The Grid voltage (as indicated on the slider) is now applied to 
the grid and (in case of a positive voltage), electrons will be 
spread via the grid on to the sample.

4. Optimize imaging by adjusting the values.

5. Click the Beam off button to turn off the Charge Neutralizer.

The software waits for the filament to cool before the chamber 
can be vented (the progress bar shows the cooling progress, 
which takes about 7 minutes).
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Finding the Optimal Operation Range
 Before adjusting the filament current or beam energy settings, 

adjust the Grid voltage until the sample is no longer charging 
(no drift or flash):
Start with the grid voltage at –5 V, then slowly increase the 
value until the image stabilizes.

 The Initial value of beam energy should be about –100 eV.

 The Initial value of filament current should be about 1.15 A.

If neutralization cannot be reached at these values, first increase 
the beam energy, then adjust the filament current if necessary.

It is advisable to adjust settings after changing:

 Samples

 System magnification

 Scan conditions

 Ion beam current

Otherwise, if conditions and sample types remain constant, you 
should only have to fine-tune your initial successful settings.

The last settings are stored and can be recalled when switching the 
Charge Neutralization off / on and also after exiting UI software.

Balancing Electron and Ion Beam Currents

If your image is still too white and lacking details after you have 
started the charge neutralizer and slightly reduced the contrast, 
you probably have too much electron beam current compared to 
ion beam current. The electron beam is desorbing ions from the 
surface, which masks the gallium ion-induced signal (the electron-
stimulated desorption). To rectify the problem, try the following 
suggestions:

 Reduce the grid voltage to reduce the beam current. The 
details should become visible as you achieve the balance 
between ion and electron currents.

 Fine-tune the grid voltage settings to a level appropriate for 
your application; the exact value is sample-dependent.

N
O

T
E Filament adjustment should be kept to a minimum as this will decrease 

the lifetime of the electron gun.
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 If you continue to reduce the grid voltage you will reach a 
switch point where there are just not enough electrons to 
compensate the charging anymore. If you have gone below 
this point, slightly increase the grid voltage again until the 
charging disappears. Now you have reached the optimum 
working condition with the best possible contrast of your 
charge compensated secondary ion imaging.

If you are still unsatisfied with the image, adjust the beam energy 
(50 V, for example) and check the results.

In case the filament does not start slowly, increase the filament 
current.

Remarks
 Verify that the Charge Neutralizer is functioning by using a 

glass sample (Thermo Fisher Scientific company part number 
22805 Rev A).

 When patterning is paused, the Charge Neutralizer stays on.

 When a Snapshot or Photo is taken with the ion-beam while 
patterning with the ion-beam is active, the Charge Neutralizer 
should stay unblanked.

 When a Snapshot or Photo is taken with the E-beam while the 
ion-beam patterning and Charge Neutralizer are active, the 
Charge Neutralizer is automatically blanked and unblanked. 
This will enable the use of E-beam grab frame during 
patterning.

 When an E-beam grab frame is performed during ion beam 
imaging, the Charge Neutralizer will blank and automatically 
unblank when switching back to ion beam imaging.

 The Charge Neutralizer can not be used in iSPI mode. When 
working in iSPI mode, the detector interlock is not OK because 
the electron beam is imaging.
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CryoCleanerEC
Use the CryoCleanerEC to decrease the contamination level in the 
system. It can be efficient to approximately 24 hours.

The kit consists of:

 Vacuum vessel, including o-rings, screws

 Vacuum vessel lid

 Nitrogen vessel (Dewar) with cap, including proper warning 
labels

 Nitrogen vessel stand

 Nitrogen vessel safety pliers

 Manual

Parts and Accessories

The CryoCleanerEC consists of a nitrogen vessel that is 
surrounded by an outer container—the Vacuum vessel, which is 
connected to one of the specimen chamber ports by a vacuum seal. 
The space between is then pumped by the microscope vacuum 
system.  

When the specimen chamber (together with the CryoCleaner) is 
pumped, liquid nitrogen is introduced to the nitrogen vessel. Its 
outside cold surface absorbs contaminating products from the 

Figure 12-2 Nitrogen and Vacuum Vessels with Accessories
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! This option uses liquid nitrogen (LN2), which may cause serious cold 
burns.
In case the Platinum deposition (Pt dep) GIS was used 
simultaneously with the CryoCleanerEC, always run the 
decontamination procedure (see the User safety manual “Pt 
deposition chemical” chapter).
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specimen chamber. The vacuum in the specimen chamber 
improves over a short period and contamination is now reduced.

When LN2 runs out, a pressure burst inside the chamber could 
cause the system to vent and to be at atmosphere for long periods 
of time if unattended. In this case, the system switches the beams 
off, but it is protected from venting (about 30 min). After this 
period, an automatic vacuum recovery procedure tries to pump to 
HiVac. The system is vented if only if it is not successful.

Flanges

The Vacuum vessel has special flanges enabling it to mount to 
different chamber ports with the use of interlink with a desired 
shape (depending on the port to be used and the vicinity).  

The interlink flanges can be mounted on by means of the 3 screw-
hole fittings on the perimeter of the vacuum flange. Care must be 
taken that the 'O' ring held in the end of the flange is secure, free of 
dirt, and is not crimped when mounting.

Figure 12-3 CryoCleaner Flanges
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Liquid nitrogen probe

A probe is immersed in the Cryocleaner to monitor the level of 
liquid nitrogen.  

Information about the liquid nitrogen level shows in the 
Application status window if that feature is enabled on the General 
tab in the Preferences dialog box. See “General Section” on page 147.

Cryocleaner Operation

Once mounted, the nitrogen vessel can be placed in the Vacuum 
vessel. Secure the two components by fixing the clips to the top of 
the nitrogen vessel and locking the clips down. Take care that the 
'O' ring seal on the Vacuum vessel is secure when joining the two 
components together.

Dewar Vessel Refilling  

1. Pump the specimen chamber; the Vacuum vessel is pumped 
along with it.

2. When the specimen chamber vacuum is ready (Pumped 
status), partially fill the Dewar with the use of a funnel (the 
plastic cap upside down), and wait until boiling stops.

3. Then fill the Dewar and place the plastic cap on top of the 
CryoCleaner. The volume of liquid nitrogen needed is 
approximately 500 ml. 

Figure 12-4 Liquid nitrogen probe
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! The handling of LN2 should be performed wearing face and hand 
protection in the form of a face visor and a pair of thermal protective 
gloves. 
Users must not touch the cold surfaces of the Dewar as this could 
result in burns. Use the Safety Pliers provided, when handling the 
nitrogen Vessel.
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Removing the nitrogen vessel  

Removing the nitrogen vessel depends on the level of 
contamination found in the specimen chamber. If the level is 
unusually high, then the CryoCleaner could work continuously 
until improvement is seen, otherwise the nitrogen vessel can 
normally be removed after approximately 2 to 3 hours. 

Figure 12-5 Plastic Cap Refilling Position
N
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E The LN2 stops boiling very quickly so that no vibration is seen from 
this device. If the CryoCleaner needs to be used for longer periods, it 
can be refilled with LN2.
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E Before re-filling, perform the Baking procedure on “Baking the nitrogen 

vessel” on page 384.
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!

Use the Safety pliers provided when handling the nitrogen vessel.
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1. Vent the specimen chamber (the excess LN2 starts to boil).

2. Unclip the nitrogen vessel from the Vacuum vessel. Lift the 
nitrogen vessel out of the Vacuum vessel by the Safety pliers 
placed under the ring on the neck of the Dewar cylinder.  

3. Place the Lid over the Vacuum vessel to seal it from the 
atmosphere (fix the clips). Pump the specimen chamber again, 
however the microscope vacuum remains cleaner than before 
and sample contamination is still reduced.

4. Remove the cap from the nitrogen vessel and pour out the 
excess LN2 into a suitable container.  

5. Place the nitrogen vessel onto the Stand ready for baking.

Baking the nitrogen vessel
1. Place the nitrogen vessel Stand on a suitable heat resistant 

surface.

2. Place the nitrogen vessel onto the stand and use an Infra-red 
lamp to bake the base of the bottle. Baking should take place 
for approximately 2 hours.

Alternatively, the nitrogen vessel can be baked in an oven at 
90° C for 2 hours.

N
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E It is not recommended to leave it inside the vacuum vessel after all 

nitrogen evaporates, because contamination evaporates back to the 
chamber. 
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When the LN2 is removed from the nitrogen vessel, the bottle still 
remains at a very low temperature.
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Regenerating the Dewar by heat allows removal of condensed 
contamination and subsequent reuse of the vessel.  

Replacing the nitrogen vessel
1. Vent the specimen chamber. Allow the nitrogen vessel to cool 

down before handling.

2. Unlock the two clips holding the Vacuum vessel Lid. Remove 
the Lid from the Vacuum vessel.

3. Place the nitrogen vessel in the Vacuum vessel, taking care 
that the 'O' ring seal on the Vacuum vessel is secure when 
joining the two components together. Secure the two 
components by fixing the clips to the top of the nitrogen vessel 
and locking the clips down.

4. Pump the specimen chamber. The Vacuum vessel is pumped 
along with the specimen chamber.

Maintenance
 Keep the 'O' rings clean of dust and fibre particles by 

inspecting the Vacuum vessel main 'O' ring on a regular basis. 
If the Vacuum vessel is removed frequently from the specimen 
chamber, inspect the specimen chamber 'O' ring seal each time.

 Keep the sealing surfaces of the nitrogen vessel and the 
Vacuum vessel Lid clean and free of dust and fibre particles.

 Do not use any kind of vacuum grease on the 'O' rings.

 Wipe the outsides of the stainless steel parts with a lint free 
cloth dampened with pH neutral soap solution to remove 
finger stains.

Spare Vessel

You can obtain a secondary nitrogen vessel kit, which contains:

 Nitrogen vessel

 Vessel stand

 Vessel plug

N
O

T
E The oven that is used must have a venting system to extract any 

harmful fumes. Alternatively it should be baked in a fume cupboard 
using an infra-red lamp.
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Quick Loader 
The Quick Loader is only available for the Helios HXe PFIB model. 
It was designed for: 

 Easy Sample transfer 

 Faster sample through-put

 Contamination free chamber environment

 Materials applications  

General description

The loader can manually load and unload small samples into the 
SDB / SEM. The loader is connected to the specimen chamber of 
the SDB / SEM and also integrated into the main vacuum system 
hardware and software.  

The loader consists of a loading rod with set slide and parking 
position, a vacuum chamber for loading and unloading the sample 
carrier (with sample) onto a bayonet fitting located at the end of 
the rod. A gate valve seals the vacuum of the SDB / SEM specimen 

C
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! Minimize a Quick Loader usage with the CryoCleaner (see below) 

filled with LN2! This is because each Load cycle adds small layer of 
gas and ice onto the nitrogen vessel surface, thus decreasing the 
CryoCleaner efficiency and increasing the amount of gas released 
into the specimen chamber in case the LN2 dries out.
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chamber and can only be opened when the vacuum of the loader 
chamber is correct, this being indicated by a 'OK' labeled LED 
prompted by an electrical and mechanical interlock. 

The sample carrier can be entered into the main SDB / SEM 
specimen chamber by way of the rod and released by the rotating 
motion of the rod at a predetermined position on the stage adapter. 

Loading rod

The loading rod has a pre-machined slot to move in to load or 
unload a sample. At each end there is a side slot. There are 2 side 
slots at the further end from the vacuum chamber. One is for 
loading and unloading the sample carrier in the loader chamber 
and the other is a parking position (prevents the rod to be sucked 
in by the vacuum).  

At the end of the rod closest to the loader chamber is a large slot 
for coupling and de-coupling the bayonet into or out of the sample 
carrier when positioned on the carrier adapter.

The bayonet is designed to make a positive and secure connection 
to the sample carrier so that it remains horizontal and in a straight 
line to connect with the carrier adapter within the specimen 
chamber.

Gate valve

The Gate Valve has positions that are defined by the following 
status:

 rotated position of the Gate Valve Lever: LOCK / UNLOCK 
The position has to be turned from LOCK to UNLOCK to be 
able to move the loading rod IN and OUT 

 colored strips on the side of the exposed barrel axis: 
one / two when IN / OUT 
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!

Do not unload the sample carrier with gate valve opened! The sample 
carrier could drop down from the rod.
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 Position 1 - IN and LOCK

 Position 2 - IN and UNLOCK

 Position 3 - OUT 

The Gate Valve has a two safety movements. 

 it can be placed over the entry hole on the slide 

 it can be locked in place by a turn of the connecting knob 
(securing the closure of the valve) 

A system interlock takes care of correct conditions (system 
vacuum, accelerating voltage) for loading and unloading cycles 
(movement of the gate valve).

Controls 

There are 2 buttons (while in operation) and 1 indicator lamp: 

 The P (pump) labeled button is pressed to pump the loader 
chamber to the required vacuum, the stage moves to a loading 
position at the same time. If the system reaches appropriate 
vacuum level, the lever interlock is released and the gate valve 
can be opened. The pump cycle is automatically terminated 
when the required vacuum is reached.

 The V (vent) labeled button is pressed once to vent the loader 
chamber. The vent cycle continues till the P button is pressed 
or it is terminated by time-out. If the microscope chamber as 
well as loader is vented then pressing the V button release 
lever interlock and gate valve can be opened.

 The indicator lamp labeled OK lights up when vacuum is 
reached after pumping. When it goes out this means the wait 
time has been exceeded and the appropriate vacuum for a 



389

System Options   Quick Loader

Thermo Fisher Scientific CONFIDENTIAL, Limited Rights Data

transfer has been lost. Pressing the P button again will bring 
the system to vacuum OK status.

Control buttons are not shining when the system is recovering 
from vacuum status transition (e.g. immediately after the 
load/unload sample, during venting the system...). After finishing 
the state transition the control buttons will be in operation again.

Sample Carrier, Sample Gauge and Stage Adapter 

A sample carriers (2 pcs.) are used to hold and transport the 
sample from the loader to the specimen stage of the SDB / SEM. 
The carrier sits in the stage adapter with a dovetail joint. It is fixed 
to the loading rod via a bayonet coupling. The loading rod is de-
coupled at the bayonet coupling when the sample carrier is located 
in the adapter and withdrawn leaving the sample carrier ready for 
sample observation.  

The Stage Adapter is connected to the rotation base of the stage by 
3 hexagonal headed screws. The base of the adapter has 3 high 
points for a firm 3-point contact to the rotation base to prevent 
vibration transmission.

The height of the stage adapter is distinct to the SDB /SEM system 
it is used with. The top of the adapter has a dovetail slot for the 
acceptance of the sample carrier from the rod loading mechanism. 

Sample Height 

Before mounting the Stage Adapter the stage must be homed with 
the chamber door opened. 

Only samples that fit the Sample Gauge can be loaded. One sample 
stub of diameter up to 32 mm (1 1/4 ") can be used, although 
standard sizes of 25 mm and 12.5 mm can also be used. Height can 
be no greater than 9 mm.

The shuttle clamps with a spring in the dovetail shaped slot of the 
adapter. It is fixed to the loader arm via a bayonet coupling. The 
maximum pin length of the stubs that can be used is 11 mm (most 
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common commercial Thermo Fisher Scientific type stubs have a 
pin length no greater than 8 mm).

The sample transfer position Ztr is not 0, but in practice from 0.5 to 
1.0 mm. The achievable Working Distance could be calculated: 

 WDmax = 11.9 mm - H (sample height) + Ztr 

 WDmin = 1.9 mm - H (sample height) + Ztr 

Consequently the minimum working distance in case of a sample 
with minimum thickness could be as much as WDmin = 2.9 mm. 
This is too much for proper HiRes imaging. However by simply 
mounting the stub into the shuttle in an elevated position, as in the 
drawing, the sample can be brought up to a minimum working 
distance of zero. 

Installation 

The Quick loader is pre-installed in the factory. No special 
adjustment is needed only the loading rod was removed for 
transport.

1. Unpack the lead glass lid. 

2. Remove four screws holding the cover of the loading rod feed-
through. 

3. Use the same screws to attach the loading rod to the loader 
chamber. 
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Quick Loader Alignment 

The load / unload position is preset from factory. If a calibration is 
needed, run the Quick Loader Alignment at first.  
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Operations 

Loading a sample 
1. Mount the sample with fast drying adhesive medium onto the 

stub. Allow to dry. 

2. Check the sample satisfies the sample limits imposed by 
placing the top of the mounting tool over the base mount.  

3. If the sample satisfies the limits, the sample loaded carrier can 
be loaded into the loader chamber. A user can either remove 
from or place a mounted carrier in the loader chamber by 
using tweezers for stubs which will fit around the stub rim. 

Rod Loading Sequence
1. While holding the sample carrier on the loading table in the 

loader chamber move the rod out of the Parking position to 
the far left, to the back of the slot and forward to engage the 
bayonet into the sample carrier. Place the rod back into the 
Parking position after coupling to prevent the rod slowly 
creeping forwards.

2. Switch OFF the electron and ion beam accelerating voltage. 
Retract the GIS or STEM modules (if present) to a safe state 
(can not be used in combination with loader).

3. Close the loader chamber lid. After the lid is properly closed 
the P button starts to shine.

4. Press the P button, the button stops to shine and the pumping 
cycle starts, the stage moves to the loading position at the 
same time. When the vacuum in the loader chamber is correct 
the pump light starts to shine and the OK button lights up 
indicating operation can continue. The gate valve lever 
interlock is released. 

5. Turn the Gate Valve knob lever from LOCK to UNLOCK 
position. Then carefully pull the knob bar fully out from the 
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If the sample proves to be too large this has to be addressed before 
the sample and carrier should be allowed into the loader chamber.

N
O

T
E Loading samples this way is an easier and safer than trying to mount 

the sample directly into the sample carrier while in the loader chamber.
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first mark on the knob drum to the second mark. Turn the 
knob bar to (counterclockwise) to the LOCK position.

6. Move the loading rod from the Parking position into the 
chamber while still holding the rod bar. The Sample Carrier 
will engage with the Stage Adapter at the end of the rod travel.

7. Turn the rod bar to the left (counterclockwise) to the base of 
the slot; pull back on the rod bar so it travels along the base of 
the slot, then turn to the right (clockwise) so that the rod bar is 
vertical and withdraw it back to the PARK slot at the far end of 
the rod guide. 

8. Close the Gate Valve by turning the knob bar to the UNLOCK 
position and press the knob in to engage the valve over the 
opening, this can be seen through the lead glass lid, then turn 
the knob bar to the LOCK position to secure the valve. Good 
practice is to leave the loader chamber under vacuum.

Unloading a sample
1. If there is a sample carrier in the loader chamber attached to 

the bayonet, remove it (the chamber needs to be vented and 
the carrier removed). 

2. Switch OFF the electron and ion beam accelerating voltage. 
Retract the GIS or STEM modules (if present) to a safe state 
(can not be used in combination with loader).

3. Close the loader chamber lid. After the lid is properly closed 
the P button starts to shine.

4. Press the P button, the button stop to shine and the pumping 
cycle starts, the stage moves to the loading position at the 
same time. When the vacuum in the loader chamber is correct 
the pump light starts to shine and the OK button lights up 
indicating operation can continue. The gate valve lever 
interlock is released. 

5. Turn the Gate Valve knob lever from LOCK to UNLOCK 
position. Then carefully pull the knob bar fully out from the 
first mark on the knob drum to the second mark. Turn the 
knob bar to (counterclockwise) to the LOCK position.

6. Move the unloading rod from the Parking position into the 
chamber while still holding the rod bar. When resistance is 
found turn the rod bar to the left (counterclockwise) to enter 
the bayonet. Push forward and turn the rod to the right 
(clockwise) and the bayonet will engage with the Sample 
Carrier on the Stage Adapter close to the end of the rod travel.

7. Withdraw the rod back to the far end of the rod guide and 
place in the Parking position. The rod, bayonet and sample 
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carrier are now out of the chamber and sit in the Loader 
chamber.

8. Close the Gate Valve by turning the knob bar to the UNLOCK 
position and press the knob in to engage the valve over the 
opening. This can be seen through the lead glass lid, then turn 
the knob bar to the LOCK position to secure the valve.

9. Press V button once. The chamber will be vented and the lid 
can be opened. The sample carrier can be released by turning 
the rod bar to the far left and pulled back then returned to the 
parking position. Remove the sample carrier.

10. Close the loader chamber lid.

11. Press P button to evacuate the loader chamber. 

Loading/Unloading 
– vented microscope chamber

If the microscope chamber is vented and Loader chamber is 
evacuated, press V to vent the loader chamber. After the chamber 
is vented, you can: 

 press P button to pump the chamber again if needed (store 
sample under vacuum condition)

 press V button to release the mechanical interlock of the gate 
valve lever. Then you can open gate valve.

Close the gate valve before microscope chamber pumping.

N
O

T
E In case the sample carrier falls from the loading rod, vent the chamber 

with gate valve opened, put the carrier back to a correct position and 
close the gate valve. Proceed from the step No. 1. 
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CryoMAT Loader 
The CryoMAT Loader is in fact the Quick Loader (see above) with 
the addition of the Cryo option, which technically can be added 
after Quick Loader installation. It is therefore important to become 
familiar with the Quick Loader operation prior to using the 
CryoMAT option.

The CryoMAT Loader is designed for dehydrated sample transfer, 
cryogenic cooling, and temperature control within a SEM or 
DualBeam instrument. It has single stage transfer, a preset sample 
temperature control, and is integrated into the existing SEM or DB 
vacuum system. The result is a simpler system to use for less 
experienced and experienced Cryo users alike. It is also designed 
to be used for more demanding delicate IC sample TEM prep 
where ambient temperature or beam conditions cause problems.

Figure 12-6 CryoMAT Loader Block Diagram  

 1. The Gas flow controller (on a trolley mount) controls the N2 
pressure and flow through the cryo components. 

 2. The Heat exchanger cools down the flowing N2 to cryogenic 
temperatures. A water trap captures water from the N2. 

 3. The Gas and electrical interface flange introduces the gas 
pipes and electrical cables through the chamber wall. 
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 4. The Cold trap creates the coldest position in the chamber to 
trap condensing water vapor molecules. 

 5. The Cryo stage Holds the sample at cryogenic temperature. 

 6. The Cryo heater & sensor controller allows temperature 
changes to the sample, gives temperature feedback to a visual 
show for the cold trap and cryo stage.

1. Gas Flow Controller 

The gas flow console panel is housed on the top part of the heat 
exchanger trolley to control the N2 flowing through the LN2 heat 
exchanger for cooling the cold trap and the cryo-stage. 

Primary function of this unit is to regulate the gas flow 
independently to the cryo-stage and cold trap via the heat 
exchanger. The N2 pressure is regulated from the original supply 
to this unit at 1.5 bar (21.75 PSI) and 5 liters / minute flow rate. 

Figure 12-7 Gas Flow Control Panel  

2. Heat Exchanger and LN2 Dewar 

The Dewar volume is 12 liters and will be filled with LN2. It 
accommodates a central pipe core of four pipes (two in and two 
out). Gas flows from the gas flow control to the two incoming 
pipes and further into the heat exchanger. At the end of the central 
core the pipes end as two coils which sit at the base of the Dewar to 
create cooling transferred by conduction from the LN2 to the N2 
gas flowing in the pipes.

Trolley panel components 
• 2× pressure valves for regulation of the 

incoming gas pressure
• 2× gas flow regulators 10 l/m scale
• 2× back pressure end valves with 

nonclosing action
• 7× gas connections with interconnective 

piping
• Water trap heater temperature read out 

display with preset controls
• Power supply to drive the temperature 

control, display and N2 water heater
• Output socket to N2 water heater + cable
• Temperature controller connection + cable
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Figure 12-8 Heat Exchanger and Dewar  

The insulated pipes coming out of the central core then proceed to 
the gas flow and electrical interface flange situated on a chamber 
port.

The cooled gas feeds the cold trap and cryo stage independently 
before returning to the interface flange. The return pipes with gas 
flowing back from the cryo stage and the cold trap also enter the 
insulation (neoprene) so that ice does not form at the port. These 
continue to the trolley entering gas connections through the two 
back pressure valves and then to atmosphere. 

Water Trap

To prevent water entering the cooling system via the N2 gas, a 
water trap is designed into the top of the central core of the heat 
exchanger. The water trap chamber volume is heated to evaporate 
the unwanted water condensing into the trap. An independent 
power supply house in the trolley panel drives the heater. 

  

Heat Exchanger components 

• Stainless steel or aluminium 
vacuum container (Dewar)

• Water trap with heater and cable
• Central pipe core with heat 

exchange coils at base
• Insulated cold N2 pipes out of the 

central core
• Non-insulated warm N2 pipes in 

to the central core
• Power supply (housed in trolley)
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Whenever handling LN2 (the 12 liter nitrogen Dewar and the Heat 
Exchanger), wear face and hand protection (face visor and a pair of 
thermal protective gloves). Do not touch cold surfaces as this could 
result in burns! 
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Lowering the Heat Exchanger into the Dewar
1. Allow the LN2 to stabilize from boiling after filling before 

transporting the Dewar and before lowering the heat 
exchanger into the Dewar.

2. Lower the heat exchanger into the Dewar slowly and with 
caution as the LN2 will boil due to the warm heat exchanger 
components.

Removing the Heat Exchanger from the Dewar   

1. Place the cold heat exchanger core at the side of the Dewar to 
warm up. Do not touch the heat exchanger until the ice 
condensation on it has completely thawed.

2. Close the lid to the 12 liter Dewar.

4. Cold Trap 

The cold trap protects the sample from water vapor condensing on 
its surface while at low temperature. It is suspended by a bracket 
from the back of the chamber to one side of the lens cone. 

The extension plate can be used (in addition) for even more 
effective anti-contamination of the sample. This encircles some of 
the lens diameter but is above the GIS needle input level. 

Cold Trap components
 Cold trap plate

 Mounting rod and insulator

 Sensor element

 Ground connector

 Swivel bracket

 Extension Plate 
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Remove the heat exchanger from the Dewar slowly and with caution 
as the core components remains at cold LN2 temperature for some 
time.
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Figure 12-9 Cold Trap  

5. Cryo Stage  

The cryo stage is a complex construction allowing samples to be 
cooled down to cryogenic temperatures. The supporting 
components are insulated from the low temperature by a double 
ceramic minimized contact method. The cold part of the stage can 
be heated so temperature can be regulated with feedback via a 
thermal sensor. This allows the cold temperature of the sample to 
be carefully chosen.

The sample can be tilted with the cryo stage to 52° tilt for milling in 
a Small Dual Beam instrument. 

The thermal insulation is constructed to prevent temperature 
exchange from the main stage to the sample and so that constant 
temperature can be maintained.

C
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The cryo stage can be rotated (because of the connections of pipes 
and wires) maximum ± 20°! 
With the cryo stage installed do not use the Home Stage procedure!
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The base plate is constructed in two parts so that the cryo stage can 
be removed quickly and conveniently without having to break 
connections or cut pipes.

The base has three point contact onto the Thermo Fisher Scientific 
stage to eliminate vibration and a location pin that connects into 
the stage table. In this way, the load position alignment remains 
valid when remounting the cryo stage.

The X, Y and Z axes movements are not limited. Tilt is able to go to 
maximum but will only be restricted by the presence of the cold 
trap at approximately 56° tilt.  

The cryo stage can be removed easily and quickly. 

Figure 12-10Cryo Stage Construction  

Cryo stage components
 Mounting base plate

 Thermally insulated stage mount

 Heater element to 100°C

 Sensor element

 Ground connector

N
O

T
E Moving the sample away from the protection of the cold trap (above 

the sample) can cause ice to condense on the sample by water 
molecules released from warmer surfaces.
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Cryo Sample Carrier and Cryo Stubs

The cryo sample carrier connects to the loading rod bayonet with 
the same mechanism as the ambient sample carrier. Release and re-
connection to the rod is also using the same mechanism as the 
Quick Loader.

The cryo sample carrier connects onto the cryo stage within the 
SEM/SDB with a “dovetail” device that is spring loaded on the 
cryo stage.

The sample stub hole is further along the carrier to a depth of 
5.0 mm and of a diameter to accept with close fit a 10.0 mm 
diameter stub. The stub hole is terminated before penetration to 
the lower side of the sample carrier. A further 3.0 mm hole is 
drilled into the center of the base of the 10.0 mm stub hole for 
vacuum pumping purposes.

A small hex screw secures the stub through a threaded hole at the 
far end of the sample carrier.

Standard Cryo Stubs

A plain stub type (10.0 mm length × 10.0 mm diameter) is supplied 
with the cryo option as this can then be simply engineered with 
holes or slots when necessary. It is commercially available as a 
consumable product from many SEM accessory suppliers.

Samples are secured by conductive paint on/in: 

 a plain stub for mounting regular or irregular samples, 

 a slot in the stub can facilitate thin samples or sheet material, 

 a drilled hole in the stub can accept viscous liquids, pastes or 
strips of material. 

Figure 12-11Cryo Sample Carrier with Standard Stub  
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6. Cryo Heater & Sensor Controller

Temperature Controller

The controller shows actual (red numbers) Cold Trap / Cryo Stage 
Temperature. Required (green number) Set Temperature of the 
cryo stage could be set by buttons under the display. 

The 3 way Temperature Switch position determines a function: 

 at Up position the high temperature is preset (SET 2 Warm) 
for sample exchange or removing (up to +50° C, default 
+20° C), 

 at Down position the low temperature is preset (SET 1 Cold) 
for sample cooling, 

 at Center position a temperature control is not in operation.

The cold trap temperature relies on the N2 flow and should be 
adjusted from the gas flow controller (–150° C to –190° C). It must 
always be at a lower temperature to the sample, approximately 
10° C to 30° C difference.

Figure 12-12Temperature Controller Display  
Temperature controller 
components 
• Free standing box.
• Temperature readout from 

Cold Trap.
• Temperature 

controller/readout from Cryo 
stage.

• 3 way temperature switch 
(High/Neutral/Low) for Cryo 
stage.

• Control interface cable
• Power cable
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Operating the CryoMAT Loader   

Mounting the Sample
1. Mount a stub into the sample carrier and secure it by 

tightening the hex screw.

2. Mount the sample with strong adhesive medium such as 
Carbon or Silver paint onto the stub. Do not use carbon 
adhesive pads (Tabs) because their adhesive can become 
ineffective at low temperature and may cause the sample to 
fall off the stub.

Cooling Down the Sample 
(First Time Operation in Session)
3. With the Heat exchanger removed from the Dewar, fill the 

12 liter Dewar with LN2.

4. Switch on the water heater at the back of the Gas flow 
controller trolley. Open the pressure regulators and flow 
meters fully. The back pressure regulators should always be 
open and are only used to create temporary extreme low 
temperatures not normally in use. They have built-in safe none 
closing valves to prevent a closed circuit.

5. Turn on the dry N2 gas at its source and regulate the pressure 
to 1.5 Bar pressure to the Gas flow controller trolley.

6. Allow 10 minutes to flush the system of any condensed water. 
Adjust the pressure regulators to show 5 L/M on the flow 
meters. Make sure that the heat exchanger rod is completely 
dry and void of trapped water. Carefully immerse the heat 
exchanger rod into the 12 liter Dewar. Watch the temperature 
controller read-outs for the lowering of temperature.
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In case the Platinum deposition (Pt dep) GIS was used simultaneously 
with the CryoMAT Loader always run the decontamination procedure 
(see the User safety manual “Pt deposition chemical” chapter). 

N
O

T
E Follow the sample loading / unloading instructions for the Quick 

Loader (see above) and become familiar with the process before 
operating the CryoMAT Loader.
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Balancing the Flow Rate Versus Temperature

This is a procedure using the default temperature settings. Other 
temperatures can be used but the cold trap should always be at a 
lower temperature (at least 20°C but no greater than 40°C).

7. Wait for the boiling effect to subside before adjusting, this will 
be seen as bouncing balls in the flow meter tubes.

8. The Cold trap will reach a lower temperature first because it is 
a shorter circuit, the cryo stage will follow. Therefore first 
regulate the flow meter to slow down and stop the cold trap at 
approximately -160°C. This will probably be between 4 and 
5 l/min.

9. Immediately regulate the cryo stage gas flow so that it just 
over shoots -130°C. This will probably be between 3 and 
4.5 l/min.

10. Switch the 3 Way Temperature switch down to SET 1 Cold 
preset temperature and wait for the system to reach the 
required temperature (-130° C, usually after 10 minutes). The 
cold trap flow rate may need a small final adjustment and can 
now be set so that it stabilizes at a temperature of ~-160° C).

11. The read-outs on the controller box will indicate the 
temperature stability at the cryo stage and cold trap. Do not 
switch on the beams till the sample is at the necessary low 
temperature. Once this is stable viewing or milling can begin 
on the sample.

Sample Exchange / Removing 
12. When the sample needs to be warmed up to ambient 

temperature before being exchanged or removed, bring the 
stage to a non-tilt condition and switch off the HV.

13. Switch the 3 Way Temperature switch up to SET 2 Warm 
preset temperature and wait for the system to reach the 
require temperature (usually after 20 minutes). 

14. During sample exchange keep the cryo stage at the SET 2 
Warm temperature.

15. Follow from the step No. 10 on to proceed with observation. 
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Finishing CryoMAT Loader Operation 

Daytime Use

This operation should only take approximately 15 minutes. 

1. Bring the stage to a zero tilt condition and switch off the HV.

2. Switch the 3 Way Temperature switch up to SET 2 Warm 
preset temperature and wait for the system to reach the 
require temperature (usually after 20 minutes). 

3. Switch the 3 Way Temperature switch to center position (Off). 

4. Remove the sample carrier from the SEM/SDB, vent the 
loader chamber and remove it from the loader with tweezers.

5. Turn off the N2 gas supply to the 12 liter Dewar unit and wait 
for the supply pipes to the chamber interface to become 
flexible (approximately 15 minutes).

6. Carefully remove the heat exchanger from the 12 liter Dewar 
and cap off the 12 liter Dewar to save LN2. 

7. Turn on the N2 gas supply to the 12 liter Dewar unit and 
warm the coils at the end of the core with a hair dryer of at 
least 1000 Watt. 

8. When the temperatures on the controller box show ambient 
temperatures, stop heating the coils and turn off the N2 gas 
supply. Switch off the water trap heater on the trolley panel.

Overnight 

Follow the procedure for Daytime Use and skip steps No. 7. and 8. 

9. Allow the system to warm up over night.
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Mirror Detector Protective Shutter 
This device protects MD from ion residues, that gradually degrade 
detector functionality: contrast, calibration etc. 

Ion residues (pollutions) accumulated dose is dependent on ion 
current used, exposure time and gas chemical type (Pt and W). To 
maintain good detector functionality we recommend to use the 
Protective shutter. 

UI Control 

The device can be controlled manually via the toolbar icon, that 
has several variations: 

 Icon is not accessible when: 
– Retractable DBS is inserted 
– Link Z to FWD procedure has not been done 
– Z-axis coordinate is too close to final lens pole and the stage
is tilted more than 2° (each direction) 
– patterning is in progress  

 Shutter is retracted and not needed 

 Shutter is retracted but needed 
icon blinks between the retracted / inserted states 

 Shutter is inserted and needed 
normal shutter functionality 

 Shutter is inserted but not needed 
there is no danger of pollutions, it is possible to retract the 
shutter 

According to actual state each icon variation and has its 
corresponding tooltip. 

When patterning parameters are set, calculation takes place and 
recommendation appears (blinking toolbar icon) to insert the 
shutter before patterning starts if the calculated ion residues dose 
is exceeded. 

Short time period before estimated loss of detector functionality 
the Application status message appears with recommendation to 
insert the Shutter. 

N
O

T
E Consequently when the Shutter is inserted, some devices cannot be 

inserted / used.
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When the shutter is going to be inserted and any GIS, Multichem 
and/or EasyLift is inserted, system retracts the appropriate device 
automatically to enable shutter insertion, and returns the device to 
the original position.  

Stage Move Limitation

When Shutter is inserted: 

 The stage cannot move to Z-axis < 2 mm. 

 When the stage Z-axis < (Eucentric position – 300 μm), the 
stage can be tilted in the ±2° range. When the stage is tilted 
more, it cannot be moved to Z-axis < (Eucentric position - 300 
μm). 

 When Link Z to FWD is lost, the Application status warning 
message appears: Z is not linked to FWD, when moving the 
stage beware of hitting MD Protective Shutter! 

N
O

T
E When the EasyLift is going to be automatically retracted, the 

confirmation dialog appears in order not to destroy possible sample 
attached to its needle.
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